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Introduction

Microsoft Office is the most popular collection of application software ever, and 
for good reason. The programs in the Office family allow you to perform just 
about any task that involves words, numbers, charts and graphs, slide decks, 

email, and more.

With Office 2013, Microsoft has polished the entire collection and introduced tight connec-
tions to cloud-based services, which allow you to sync settings between multiple devices 
just by signing in with an Office account and using the SkyDrive and SkyDrive Pro services 
from Microsoft.

Office 2013 introduces one new wrinkle that might confuse some longtime Office veter-
ans. In addition to the conventional one-copy-per-PC license, Office 2013 is available as a 
subscription product, which includes the rights to install and use the full suite of Office soft-
ware on multiple devices. We encourage you to read Chapter 1 carefully for a full overview 
of what’s new and changed in this version.

Who this book is for
We wrote this book with a broad audience in mind: students, small business owners, pro-
fessionals, information workers, and anyone else who’s interested in maximizing their 
productivity at home or at work. Our goal is to help you become productive with the core 
applications in Office 2013—Word, Excel, Outlook, PowerPoint, and OneNote. In addition, 
we provide thorough introductions to three additional Office programs—Access, Publisher, 
and Lync.

Assumptions about you
We assume that most of our readers have already used at least one previous version of 
Office and are proficient (or at least comfortable) in one or two Office programs. For each 
program, we provide a quick overview that helps you understand its core concepts, and we 
concentrate on explaining the similarities between the products so that you can transfer 
skills you learn in one Office program to another.

This book does not cover advanced topics of interest to IT professionals and developers, so 
you won’t find detailed discussions of deployment and macros.
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How this book is organized
This book gives you a comprehensive look at features that are common to all the Office 
programs and then moves through each of the individual programs for a more detailed 
examination. 

Part 1, “Office fundamentals,” describes the various Office editions and explains how to 
install the program. After that, we explain features and procedures that are common to all 
Office programs: the ribbon and other user interface components, working with text, and 
working with pictures and other graphics.

Part 2, “Office on the desktop and in the cloud,” shows you how to manage your Office 
files, whether you store them on a local hard drive, on a network drive, or in the cloud. We 
then show how Office integrates with SkyDrive and other online services, and how to get 
the most out of an Office 365 subscription.

Part 3, “Word,” begins our detailed looks at individual Office programs. In this part, we 
cover essential Word information and then dive deeper into topics such as working with 
long documents, using templates and themes, using tables, tracking changes and review 
comments, creating blog posts, and combining documents and data with mail merge.

Part 4, “Excel,” shows how to navigate around a worksheet and how to perform calculations. 
But it’s not just numbers on a grid: we explain how to create compelling charts and how to 
use tables, PivotTables, slicers, and the new Quick Analysis tool to view numeric data in new 
and useful ways.

Part 5, “Outlook,” describes the program that some people spend most of their day using. 
Outlook sends and receives email, manages your contacts database, maintains a calendar of 
meetings and other activities, and keeps track of your tasks and other to-do list items. We 
explain how to use each of these features to the fullest.

Part 6, “PowerPoint,” explains how to create captivating slide presentations. We describe the 
various views in PowerPoint and explain how to use slides to show pictures, videos, anima-
tions, transitions, and other objects as well as tried-and-true bulleted lists. We show how to 
present a slide show on a single computer, with a second monitor or projector, or over the 
Internet.

Part 7, “OneNote,” describes the underappreciated program for collecting all manner of 
notes in a freeform (yet easily searchable and retrievable) style. We show how to fill a note-
book with information, tag it, and search for it. We explain how to integrate OneNote and 
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Outlook for managing messages, contacts, meetings, and tasks. We also show how to use 
shared notebooks stored in the cloud, an incredibly useful capability whether you’re sharing 
with others or with your various devices.

Part 8, “Other Office programs,” introduces three other programs included with Office 2013. 
First up is Publisher, a desktop publishing program for creating brochures, catalogs, and 
other printed materials. Then we take a look at Lync, a unified communications program 
with which you can connect to others via instant messages, audio and video messaging, 
and shared desktops. We wrap up with an overview of Access, the database program that 
now creates Access web apps.
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Support and feedback
The following sections provide information on errata, book support, feedback, and contact 
information.

Errata & support
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. Any errors that have been reported since this book was published are listed on our 
Microsoft Press site: 

http://aka.ms/Office2013InsideOut/errata

If you find an error that is not already listed, you can report it to us through the same 
page.

If you need additional support, email Microsoft Press Book Support at  
mspinput@microsoft.com.

Please note that product support for Microsoft software is not offered through the 
addresses above.

We want to hear from you
At Microsoft Press, your satisfaction is our top priority and your feedback our most valuable 
asset. Please tell us what you think of this book at

http://www.aka.ms/tellpress

The survey is short, and we read every one of your comments and ideas. Thanks in advance 
for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter: http://twitter.com/MicrosoftPress
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Inside Office 2013 

Microsoft Office is, without question, the single most widely used piece of 
productivity software in the world today. More than 1 billion (that’s billion 
with a b) people actively use one of the many versions of Office that Microsoft 

has released in the past two decades. 

If you’re one of those longtime Office users, you’ll find that Office 2013 feels new and 
greatly improved but without feeling dramatically different. That’s both reassuring and 
somewhat puzzling.

At first glance, Office 2013 looks slightly different, with a flatter user interface than in 
previous editions. Also, most actions in individual programs are accompanied by subtle 
animations. Beyond that, you’ll find little that’s obviously new. There are no new desktop 
programs or web apps—Word, Excel, PowerPoint, Outlook, OneNote, and the rest of the 
Office family are still around. File formats have changed in only minor ways between Office 
2010 and 2013. A few rarely used utilities have been retired and will not be missed.

The most important new feature, which seamlessly connects you to online file stor-
age, builds on the familiar SkyDrive and SharePoint products. The utility that syncs local 
and cloud-based files is a retooled version of the venerable Groove utility, rebranded as 
SkyDrive Pro. Microsoft’s well-established App-V and Click-to-Run technologies power the 
web-based installer that is at the heart of the new subscription-based Office.

And yet…

With Office 2013, Microsoft has taken its cloud services, desktop programs, and browser-
based apps and fused them into a product that feels unified and natural. Small but signifi-
cant improvements are scattered through the individual Office programs. Collectively, they 
add up to a greatly improved experience, all without altering the fundamental character of 
Office.

What’s new? What’s changed?. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  4
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The basic challenge of Office 2013 remains, however. Depending on which edition you pur-
chase, you have at your fingertips as many as eight full-featured programs with a sweeping 
range of capabilities. You have to use both sides of your brain (the analytical and the artis-
tic), sometimes in the same program at the same time. And you’re expected to remember 
the ins and outs of a program you might use only once every few weeks or months.

It’s little wonder that most of us are comfortable with one or two Office programs and flail 
around in frustration when we need to use one of the others. When you’re using a pro-
gram that’s less familiar to you, you’re so busy trying to figure out how to accomplish basic 
tasks that you don’t even think about time-saving strategies and advanced features and 
capabilities.

That’s where we come in. Our goal in this book is to deliver exactly what you need to 
become productive with the core applications in Office 2013—Word, Excel, Outlook, 
PowerPoint, and OneNote. We provide a cram course in each program, covering the 
essential features and technologies and suggesting productivity-enhancing expert tips to 
help you work smarter. We cover three additional Office programs—Publisher, Lync, and 
Access—in fewer pages, but with enough detail, we hope, to propel you firmly ahead on 
the road to productivity. 

We’re confident that most of our readers have at least a passing familiarity with Office, so 
we won’t waste your time with trivial details. In this introductory chapter, we offer a whirl-
wind tour of what’s new and what’s changed from your previous Office edition, along with 
a basic road map to this book.

What’s new? What’s changed?
The single biggest change in Office 2013 involves the decision you must make when you 
upgrade: will you opt for a traditional perpetual license, which allows you to pay a single 
price and install the software on a single device? Or will you choose a more flexible Office 
365 annual subscription, which allows you to use the same Office 2013 programs on up to 
five devices and includes additional cloud-based services?

The economics and logistics of that decision are not obvious, which is why we break the deci-
sion down in as much detail as possible in “Choosing an Office edition” in Chapter 2, “Install-
ing and updating Office 2013.”

Although the installation and update processes are different in the subscription and 
installer-based Office 2013 versions, the programs themselves are functionally identical.
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In this release, the Office ribbon continues its evolution. This interface element was intro-
duced in Office 2007 (for every program except Outlook). It was refined (and added to 
Outlook) in Office 2010 and is now a part of every program in the Office family, with the 
exception of the difficult-to-categorize Lync communications suite.

The ribbon replaces the drop-down menus and icon-laden toolbars in earlier Office edi-
tions with tabs that stretch horizontally across the top of the program window. Each tab 
contains commands that are organized into groups. Figure 1-1, for example, shows the 
Home tab in Word 2013. 

Figure 1-1  The ribbon interface combines menus and toolbars into a single horizontal 
arrangement.

Two other elements in Figure 1-1 are worth calling out. The Quick Access Toolbar, above 
the ribbon at the left, is a row of shortcuts that you can customize easily. At the right of the 
tab headings is the name of the currently signed-in user, which lets you know at a glance 
which SkyDrive accounts and other Office-connected services you’ll see when you click File 
to open or save a document.

Other additions to the Office interface allow you to choose formatting options from a gal-
lery and preview their effect on your live data before committing to a change. 

In all Office programs, paste options allow you to adjust formatting on the fly rather than 
using Undo in a series of trial-and-error attempts.
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If you skipped Office 2010, you’ll notice significant improvements in the ribbon. For start-
ers, it’s customizable. Using the dialog box shown in Figure 1-2, you can remove command 
groups from the ribbon, create your own custom command groups and tabs, rename exist-
ing groups and tabs, and export your custom settings for reuse on a different Office 2013 
installation.

Figure 1-2  If you don’t like the default ribbon in an Office program, change it by adding, 
removing, and rearranging tabs and individual commands.

With one exception, clicking a heading on the ribbon displays the tab of the same name, a 
horizontal strip of commands and options related to that task. The exception is File, which 
always appears in the first position on the left side and is distinguished by a color back-
ground that matches the color of the program’s icon.

In Office 2013, clicking File opens the Office Backstage view, which occupies the entire pro-
gram window and consolidates multiple tasks into a single location without forcing you to 
open multiple dialog boxes. This feature was introduced in Office 2010 and is significantly 
enhanced in Office 2013.

Click any of the options that appear, menu-style, along the left side of the window to fill 
Backstage view with the details for that task. Figure 1-3, for example, shows the Share tab 
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in PowerPoint 2013, with options to share a slide show by attaching it to an email message, 
by creating a link to a SkyDrive folder, or by posting it to a social network that you’ve con-
nected to your Office account (Facebook, in this example).

Figure 1-3  Clicking the File heading opens Backstage view, which consolidates common options 
and previews in a single location using the entire Office window.

For a detailed look at the Office 2013 ribbon, Backstage view, Live Preview, and other inter-
face elements, see Chapter 3, “Using and customizing the Office interface.”

All of the Office programs we cover in this edition (with the exception of OneNote) include 
significant improvements for inserting and editing graphics and online videos. The picture-
editing tools are noteworthy, especially for anyone who skipped over Office 2010. You can 
use them to crop a photo, remove distracting background elements, and add artistic effects 
without having to leave the document window. Figure 1-4 shows an original photograph 
transformed by applying the Light Screen effect.
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Figure 1-4  Image-editing tools available throughout Office 2013 allow you to crop and 
transform pictures without leaving the document window.

You’ll find comprehensive instructions on how to insert and edit photos, screen shots, Smart-
Art graphics, and other visual elements in Chapter 5, “Working with graphics and pictures.”

Using Office Web Apps
Some (but not all) of the programs in Office 2013 have corresponding online versions that 
allow you to create, save, view, share, and collaborate on documents, workbooks, presenta-
tions, and notebooks.

You don’t need to own Office 2013 or have an Office 365 subscription to use these Office 
Web Apps; all you have to do is sign in with a free SkyDrive account. You can create, view, 
and edit files in the default formats associated with document-centric programs in Office 
2013—Word, Excel, PowerPoint, and OneNote. You can do simple edits using the web app 
associated with a document format; the option to open the file in the full program works 
easily if Office 2013 is already installed; you can “stream” the program to run on any com-
puter running Windows 7 or Windows 8 without permanently installing it. Figure 1-5 shows 
the two editing options for a PowerPoint presentation stored in a SkyDrive folder.
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Figure 1-5  Documents stored in a SkyDrive folder can be opened for editing directly in the 
browser or in the associated Office program, if it’s installed.

Two or more users can edit documents simultaneously when those files are stored on Sky-
Drive or a SharePoint server; this capability is also available with SkyDrive Pro when used 
with an Office 365 Small Business Premium subscription.

You’ll find more details about these tools and techniques in Chapters 7 and 8, which docu-
ment the SkyDrive and SkyDrive Pro/SharePoint options, respectively.

A field guide to Office 2013 editions
If you want to install Office on a new PC or upgrade an earlier Office version on an existing 
PC, you have an impressive—and potentially confusing—array of options. The prices, licens-
ing terms, and features for each edition vary significantly. Making the right choice is more 
complicated than simply selecting a retail box.

Subscription editions
Subscribing to Office 365 provides access to the following Office 2013 desktop applications: 
Word, Excel, PowerPoint, OneNote, Outlook, Access, and Publisher, as well as Lync in busi-
ness editions. These programs, which are available in their desktop versions on Windows 7 
and Windows 8, are installed and updated online but run from your local hard disk, with or 
without an Internet connection, exactly like the Office desktop programs you use today.
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The biggest difference between Office 365 and the traditional installer-based versions of 
Office 2013 is that the subscription-based Office programs are licensed on a per-user basis 
rather than on a per-device basis. That’s an important distinction in a world where you 
are likely to use multiple computing devices: a desktop PC, a notebook, a tablet, and a 
smartphone.

Office 365 is available in two new editions intended for consumers and small businesses:

●● Office 365 Home Premium is intended for use by families. A single annual subscrip-
tion payment covers all family members. The primary user manages the subscription 
and can assign Office 2013 rights to up to five devices (Windows PCs or Macs). Those 
devices can then be used by any family member who signs in with his or her indi-
vidual Microsoft account to install and run Office 2013 programs. The primary user 
also gets an additional 20 GB of SkyDrive storage and 60 minutes of worldwide Skype 
calling.

●● Office 365 Small Business Premium is intended for use by businesses with up to 
10 employees (although it actually supports up to 25 users). The annual subscription 
payment covers a single user, who in turn is allowed to install and run Office 2013 
programs on up to five PCs or Macs. The subscription also includes a 25 GB mailbox 
(on a Microsoft-hosted server running Microsoft Exchange), shared file storage of 10 
GB (plus 500 MB per user), and online communications using Lync.

Businesses with more than 10 employees can acquire Office 2013 Professional Plus as part 
of enterprise-class Office 365 subscriptions. Students, faculty, and staff at universities can 
get Office 365 University, which is identical to Home Premium but allows installation on 
only two devices.

For a full list of features and pricing for all available Office 365 plans, see http://bit.ly/
Office365plans.

Retail editions
Through traditional retail distribution channels (in brick-and-mortar stores or online), you 
can choose from three editions:

●● Office Home and Student 2013 includes Word, Excel, OneNote, and PowerPoint. 
The license agreement allows you to install and activate a retail copy of this edition 
on a single PC. (That’s a significant change from this edition of Office 2010, which 
included the right to install the software on up to three PCs.) The license agreement 

http://bit.ly/Office365plans
http://bit.ly/Office365plans
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specifically prohibits using this edition “for commercial, nonprofit or revenue-
generating activities.”

●● Office Home and Business 2013 includes all the programs from the Home and 
Student edition and adds Outlook. Here, too, licensing options allow installation on a 
single PC.

●● Office Professional 2013 is the top-of-the-line retail Office edition, intended for 
consumers and small businesses. It includes the programs in the Home and Business 
edition and adds Publisher and Access.

For instructions on how to install and activate a retail copy of Office 2013, see Chapter 2.

Any of the preceding editions may also be sold by a PC manufacturer and preinstalled on a 
new computer.

What’s happened to Office Starter Edition?
With Office 2010, Microsoft experimented with a free Starter Edition, available only 
with new PCs. This edition was considerably more limited than any retail Office edi-
tion and included only two ad-supported, limited-feature programs, Word Starter 
and Excel Starter. This edition was unceremoniously dumped with the introduction of 
Office 2013.

Volume-license editions
Businesses that have volume-license agreements with Microsoft can choose from two avail-
able Office editions:

●● Office Standard includes Word, Excel, OneNote, PowerPoint, Outlook, and Publisher.

●● Office Professional Plus is the high-end enterprise offering, containing the same set 
of programs as Office Standard and adding Access and Lync.
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INSIDE OUT � How to check which Office edition is installed on a 
Windows PC

If you’re not certain which Office edition is installed on your PC, here’s how to check.

Open any Office program (this example uses Microsoft Word, but the steps are identi-
cal for other programs). Click File, and then click Account. At the right side of the win-
dow you’ll see a block of information like the one shown here.

In addition to information about your edition and the programs in it, this display 
also allows you to see whether your installation has been activated. Click the About 
Program Name button to see more detailed information about the program you’re cur-
rently using, including the full version number and whether you’re running a 32-bit or 
64-bit copy. This dialog box also includes links to support resources and allows you to 
read the license agreement associated with your edition.

Note
In this book we do not cover stand-alone programs such as Microsoft Project and 
Microsoft Visio, which are part of the Office family but aren’t included in any packaged 
Office edition. We also do not cover the enterprise-only InfoPath program.
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Word 2013
Word is arguably misnamed. Yes, after all these years it still processes words with alacrity, 
allowing you to enter and edit blocks of text and check your spelling and grammar as you 
go. But modern versions of Word include design and page-layout tools that make it suit-
able for medium-strength desktop publishing and web design jobs. We cover the full range 
of Word features in the three chapters devoted to Word in this book.

The Navigation pane, an optional interface element that appears at the left side of the 
Word editing window when enabled, continues to evolve. As in previous versions, you can 
use headings in your document to quickly move between sections. The search box at the 
top of the Navigation pane allows you to find words and phrases easily, especially in long 
documents. Figure 1-6 shows search results using the page browser; an alternate view 
allows you to see the same results organized as snippets of text so that you can see them in 
context.

Figure 1-6  When you use the Navigation pane to search for a word or phrase, you can view the 
results as thumbnail pages (shown here) or as text snippets.
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The most significant change in Word 2013 is the new Design tab on the ribbon, which con-
solidates colors, fonts, and document formatting options in a single location. The most wel-
come addition, shown in Figure 1-7, is the Set As Default button, which allows you to save a 
group of options for use with all new documents you create. 

Figure 1-7  The Design tab, new in Word 2013, consolidates an assortment of document 
formatting options and allows to save them for reuse.

Like its Office-mates, Word also includes an assortment of document recovery features that 
allow you to roll back to one of five previous AutoSaved versions or recover from an unex-
pected crash.

You can also restore a draft version of a document even if you close Word without saving it.

Excel 2013
Shockingly, many Office users have no idea that Excel can be used for many things other 
than budgets and simple lists. If your only exposure to Excel is the monthly ritual of adding 
your department’s numbers to the corporate budget template, we have some surprises for 
you. In the three chapters we devote to Excel, we cover the fundamentals of formulas, for-
matting, and filtering data; we also help you unlock the magic of PivotTables, which sound 
intimidating but are easy to master and incredibly useful once you learn how they work.
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The most obvious improvement in Excel 2013 is a Quick Analysis tool that allows you to 
quickly choose data analysis and presentation options for a selection. You can apply condi-
tional formatting, create charts, or use visualizations to add a graphic dimension to an oth-
erwise impenetrable mass of raw numbers. Figure 1-8 shows this tool in action.

Figure 1-8  Clicking the Quick Analysis icon in the lower-right corner of a selection allows you to 
instantly preview and apply any of these analytical options.

For cutting large data sets into manageable workloads, Excel 2013 offers several useful 
tools: use PivotTables, for example, to quickly and easily create crosstabs and summaries 
of even very large data sets with just a few clicks. In traditional lists or PivotTables, you can 
create search filters to help find relevant items.

Outlook 2013
For many Office users (especially those in corporations that live and die by email), Outlook 
is the first program they open in the morning and the last one they shut down at night. 
In between, Outlook helps you juggle email, meetings, appointments, tasks, and contact 
information for friends, family, clients, coworkers, and anyone else. In this release, Outlook 
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is significantly less cluttered than its predecessors. The comparison is especially striking if 
you’ve skipped over Outlook 2010.

First and foremost, Outlook is an email client program that helps you compose, send, 
receive, and manage messages using most standard email protocols. You can combine mul-
tiple accounts into a single set of folders. As with its predecessor, Outlook 2013 supports up 
to 15 Microsoft Exchange accounts in a profile; in Outlook 2007 and earlier, each Exchange 
account required a separate profile.

Beneath the typographically refreshed navigation pane on the left are four large labels rep-
resenting the most common Outlook views: Mail, Calendar, People, Tasks. Clicking any of 
those targets changes the view to display the selected type of information.

But those targets also have a second function. Allow the mouse pointer to hover over Cal-
endar, for example, to display what Microsoft’s designers call a “peek” at your upcoming 
appointments. Figure 1-9 shows an example.

Figure 1-9  Allowing the mouse pointer to hover over Calendar displays this “peek,” where you 
can scroll through upcoming appointments without leaving Mail.
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You can scroll through the calendar, looking at events for individual days, and open any 
event for editing without leaving your email window. The People peek lets you pin favorite 
contacts to the peek list, so you can look up an address or compose an email with a click or 
two. The peek goes away shortly after you move the mouse away, although you can dock 
any or all of the three panes to the right of the Outlook window.

Outlook 2013 includes some refinement on the conversation view that debuted in Outlook 
2010, most notably the animations that create a sliding effect when threaded conversations 
open and close. Use the Ignore button to automatically delete conversations (including 
future responses) in which you’re an uninterested bystander trapped on the Cc line.

To manage the deluge of email, you can create rules that fire automatically when a new 
incoming message meets certain conditions. We’ll also explain how to create Quick Steps, 
which automate repetitive message-handling tasks. These “macros” appear by default as 
buttons on the Message tab and can also be assigned to keyboard shortcuts, as shown in 
Figure 1-10.

Figure 1-10  Quick Steps are an effective way of taking the drudgery out of routine message-
management tasks.

Outlook 2013 also recognizes the increasing importance of keeping track of interactions 
with friends, family, and coworkers over time. The People pane at the bottom of every 
email message and contact displays a complete message history for the message sender or 
contact, along with connections to social networking sites, RSS feeds, status updates, meet-
ings, and so on.



Chapter 1

18	 Chapter 1  Inside Office 2013 

PowerPoint 2013
Most audiences groan when they realize you’re about to launch into a PowerPoint presen-
tation. But slide shows don’t have to be deadly or dull—in fact, as we demonstrate, they 
don’t even have to be slide shows, in the traditional sense. Using PowerPoint 2013, you can 
create photo albums and web-based presentations that don’t include a single bullet point.

PowerPoint 2013 contains a new set of tools that allow you to find video clips online or 
in your SkyDrive account and embed them into a slide. Figure 1-11 shows these tools in 
action.

Figure 1-11  New video-editing tools in PowerPoint 2013 allow you to embed clips from online 
storage, including your SkyDrive account.

If you already have a solid background in building presentations with PowerPoint, we’ll 
show you the subtle (and, in some cases, dramatic) changes in familiar tools. You can now 
open multiple presentations in separate windows, for example, making it easier to copy 
slides in one presentation for use in another. You can also divide complex presentations into 
sections for easier management. We’ll also demonstrate how to use animations and slide 
transitions to best effect.
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OneNote 2013
Although OneNote has been a part of Office since the 2003 release, many experienced 
Office users are unlikely to have spent even a minute with it. That’s because for its first 
seven years, OneNote was included only with the Home and Student and Ultimate editions 
of Office. Beginning with Office 2010, OneNote was reassigned as one of the core programs 
installed with every retail and enterprise Office edition.

If you’ve never seen OneNote, we strongly recommend that you spend some time with this 
incredibly useful and versatile free-form note-taking program. If you’re already familiar with 
OneNote, you’ll want to pay special attention to its connections with SkyDrive. When you 
open a notebook from SkyDrive, OneNote syncs its contents automatically to your PC so 
that changes you make on one device are available on every other device you use.

Figure 1-12 shows a group of notebooks open from SkyDrive with the option to share a 
notebook readily available.

Figure 1-12  Storing a notebook on SkyDrive gives you fail-safe backups as well as the ability to 
share a notebook with others.

And yes, to use a bit of Microsoft jargon, we eat our own dog food. The authors and editors 
who worked on this book kept notes, ideas, links to outside websites, reference information, 
formatting instructions, and more in a shared notebook stored on SkyDrive.
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Your familiarity with Word pays off in OneNote as well: you can apply formatting for head-
ings and body text in OneNote by using the same keyboard shortcuts that work in Word. 
OneNote also offers excellent tools for searching and organizing information in your note-
books. That capability is invaluable when your collection of notebooks becomes too big for 
you to find random bits of information simply by flipping through pages.

In this book, we devote three chapters to OneNote. If you’re new to the program, we rec-
ommend that you start at the beginning and read all the way through to learn some of the 
subtleties of this unusual but powerful program.

Other Office 2013 programs
Planning this book involves some trade-offs. Our emphasis is on the four core applications 
that are common to all Office editions, as well as Outlook, which is in all of the business 
editions.

That leaves three “lesser” applications fighting for attention. Our solution is to devote a 
chapter to each of these three programs, with enough information to help you get started 
with each one:

●● Publisher 2013 is a design tool that’s specialized for creating things that don’t fit 
neatly into Word’s page-based model: invitations, brochures, flyers, cards, and so on.

●● Lync 2013 allows you to communicate with coworkers using voice, video, and mes-
saging, with the option to share screens and collaborate on projects in real time.

●● Access 2013 manages data, big and small, in applications that keep simple lists as 
well as front ends to large Microsoft SQL Server databases on server farms.
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CHAPTER 13

Analyzing data with tables and charts

Excel is no one-trick pony. Yes, the program works wonders with number-crunching 
tasks, but its rows and columns are also tailor-made for managing data that goes 
beyond basic bean counting. With minimal effort, you can keep address lists and 

membership rosters, track temperatures and rainfall, monitor stock prices, and record your 
performance in whatever sport or hobby you happen to fancy.

In this chapter, we look at the many options you have for entering, storing, sorting, filtering, 
cross-tabulating, and summarizing that data.

We also explain how to highlight trends and patterns in a sea of gray data to make it more 
interesting. You can use conditional formatting to add colors and custom text treatments, 
and you can make at-a-glance analysis easier by inserting tiny trend lines and markers 
called sparklines.

When that’s not enough to tell a story, you can turn a collection of data into an elegant, 
information-based graphic and let it do the talking. In this chapter, we look at Excel’s 
extraordinarily versatile charting engine and explain how to communicate a situation or a 
series of events in a single visual impression, with only a few well-chosen words required.

Building a visually compelling, information-rich chart from a series of numbers and dates is 
part science, part art. The science involves recognizing which series of data on a worksheet 
represent the patterns you’re trying to describe. The art is in arranging and fine-tuning 
the colors, shading, shapes, labels, and other pieces of your chart so that they tell the story 
most effectively.

Sorting out your data analysis options. .  .  .  .  .  .  .  .  .  .  .  .  .  . 408
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Sorting out your data analysis options
The single most important new feature of Excel 2013 is the Quick Analysis tool, which puts 
formatting, charting, tables, and other options in an easy-to-access place. You can still cre-
ate charts, insert tables, and add totals manually, but this tool dramatically simplifies the 
process.

To get started, select a range (at least two cells containing data) and click the Quick Analy-
sis tool that appears in the lower-right corner of the selection. (You can also press Ctrl+Q, 
or right-click and click Quick Analysis on the shortcut menu. If you choose the latter option, 
you can select a single cell and Excel will expand the selection to include the current 
region.)

Figure 13-1 shows the Quick Analysis tool in action. Each of the five headings at the top of 
the box leads to a selection of options that vary slightly depending on the selection.

Figure 13-1  The Quick Analysis tool consolidates five common options in one place and offers 
live previews of their effects.

To use the Quick Analysis tool, choose a category and then move your mouse pointer over 
any of the options available beneath the headings. When you let the pointer hover over an 
option, the selection changes to preview the effect of that option. If you like what you see, 
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click to apply the selected option; otherwise, move the mouse pointer to another option (or 
click a different category).

The following list briefly describes each of your options and what you should and shouldn’t 
expect from each one using Quick Analysis. We provide in-depth details about these ana-
lytical options in the remainder of this chapter.

●● Formatting  The options available here depend on whether your selection contains 
only text or whether it also includes numbers. For all-text ranges, the options allow 
you to identify duplicates, unique values, or entries that include a specific text string. 
If you’ve included even a single number, you’ll see the choices shown earlier in Fig
ure 13-1, which allow you to add data bars, color scales, and icons or highlight spe-
cific values.

●● Charts  Excel offers a selection of one-click charts based on the type of selection 
you make. The list of available chart types is determined by whether you’ve chosen 
a single column of values or multiple columns with labels. The preview chart appears 
above the Quick Analysis tool, as shown in this example, based on a selection that 
includes a column of labels and a column of data.

●● Totals  Assuming you’ve selected a range that includes numbers, you can add auto-
matically calculated totals in the row beneath your selection, or in the column to its 
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right. For numbers, the list of options scrolls to the right, with row-wise choices listed 
first, followed by their column-wise equivalents.

●● Tables  This category is a bit of a catch-all; it includes regular tables and PivotTables 
(we cover the former in much more detail shortly, and the latter in Chapter 14, “Excel 
inside out”). What you see beneath the Tables heading will always include the Table 
option and, depending on the arrangement of data, one or more buttons allowing 
you to preview various PivotTable layouts. Note that in this example, because the 
Excel window extends to the bottom of the screen, the Quick Analysis tool appears 
above its launcher.
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●● Sparklines  These clever little analytical elements are mini-graphs that appear in 
a single cell to summarize the trend in a row of data. They’re most useful when you 
want an at-a-glance comparison of a series of numbers in multiple dimensions. We’ll 
discuss sparklines in more detail shortly.

The Quick Analysis tool offers a useful starting point, but it’s far from perfect. For anything 
but the simplest tasks, you’ll need to fine-tune the settings and formatting for tables and 
charts.

Using tables to organize and analyze data
You can create a simple database just by entering data into rows, with or without headings 
to indicate what’s in each column. For example, you can enter a list of names in column A 
and then, in column B, enter a phone number alongside each name. As long as that list 
remains short and simple enough to scan quickly, you don’t need to do anything more.

But lists have a way of growing, and even moderately long lists can benefit from sorting, 
searching, filtering, outlining, and summarizing. When you turn a range into a table, Excel 
provides several tools that simplify the way you work with even long, detail-rich collections 
of data.

Microsoft introduced the concept of tables (not to be confused with data tables, which are 
a rarely used relic of Excel’s distant past) in Excel 2007. Tables are roughly equivalent to the 
feature known as lists in Excel 2003, but with more sophisticated formatting options. If you 
open a worksheet originally created in Excel 2003 that contains one or more lists, you’ll 
need to manually convert those lists to tables.

The quickest way to turn a range into a table is to click Table in the Tables group on the 
Quick Analysis tool, which applies the default table format to the current selection or 
region immediately. If you want more control over the process, select the range (or select 
any cell within the range if the list is in a self-contained region), and then click Table in the 
Tables group on the Insert tab. (You can also use the keyboard shortcut Ctrl+T or Ctrl+L.) 
You’ll see the Create Table dialog box shown in Figure 13-2.

Had we instead clicked Format As Table, in the Styles group on the Home tab, we would 
have been required to select a table style before seeing the Format As Table dialog box 
(which is identical to the Create Table dialog box shown in Figure 13-2). Using either key-
board shortcut applies the default table style. (We discuss table styles in much greater 
detail in the next section, “Formatting tables with table styles.”)
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Figure 13-2  Even though we selected only a single cell, Excel expands the selection to include 
the entire data-containing region, as defined by blank rows and columns.

If the selected range contains a header row with labels for each column, you should select 
the My Table Has Headers check box. (For the most part, Excel correctly detects the pres-
ence of headers, but it can be confused by some configurations, so check this setting 
before you proceed.) Clicking OK applies the default table style to the range and makes a 
few other changes. The end result looks like this:
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Defining a range as a table makes the following changes, some of which are not immedi-
ately apparent. (We explain these changes in more detail shortly.)

●● Column widths expand as needed to display header text in full. If column headers are 
not included, Excel adds generic headers—Column1, Column2, and so on.

●● A down arrow appears to the right of each column heading, allowing quick sort and 
filter operations.

●● When any cell or range within the table is selected, a Design tab with customization 
options appears on the ribbon, under the Table Tools heading.

●● A default name is assigned to the table; you can change the name to a more descrip-
tive one by using the Table Name box in the Properties group on the Table Tools 
Design tab.

●● Any cell addresses used in formulas you add within the table are automatically con-
verted to structured references. (For an explanation of how structured references 
work, see “Adding formulas and totals to a table,” later in this chapter.)

●● A triangular handle in the lower-right corner of the table allows you to quickly 
add rows or columns to the table, preserving formatting and copying formulas 
automatically.

Tables offer a tremendously versatile way to work with large and small amounts of data. In 
fact, as we explain in Chapter 14, a table can serve as the source of data for a PivotTable 
report. You can also export a table to a SharePoint list or to a PivotDiagram in Visio (a 
member of the Office family we don’t discuss in this book), using the Export command in 
the External Table Data group on the Table Tools Design tab.

After you convert a range into a table, you can fine-tune its appearance with custom for-
matting, expand its size in either direction, and add totals.

What if you change your mind and want to remove the table features, turning the data 
back into a plain ol’ range? Easily done: Click to select any cell within the table and then 
click Convert To Range, in the Tools group on the Table Tools Design tab. Or right-click any 
cell in the table and then click Table, Convert To Range on the shortcut menu. This option 
removes the special treatment of header rows and converts formulas back to ordinary cell 
references. Any special formatting (such as banded rows) remains in place and must be 
changed manually unless you remove the formatting first, using the Clear option at the 
bottom of the Table Styles gallery on the Design tab.
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INSIDE OUT �  Don’t lose track of headings when you scroll

One of the hidden advantages of creating a table from a range is a small but signifi-
cant improvement in scrolling. If your list is long enough that scrolling through the 
list causes the Header row to scroll up and off the screen, Excel has an elegant fix. The 
headings from the table replace the column headings in the worksheet frame, com-
plete with the arrow that allows you to sort and filter, as shown here.

The effect is similar to what happens if you freeze the top row of the table, but it 
requires no effort from you beyond creating the table in the first place.

Formatting tables with table styles
Table styles apply formatting—colors, fonts, borders, and shading—to the region that 
makes up a table. Excel offers a selection of 60 options in the Table Styles gallery (plus a 
None option that removes table formatting). These options are divided into Light, Medium, 
and Dark groups that correspond to the intensity of the colors used. You can choose from 
the entire list in either of two ways:

●● Click Format As Table in the Styles group on the Home tab. If the current range or 
region has not already been defined as a table, this option displays the Format As 
Table dialog box after you make a selection.

●● Click the arrow to the right of the Table Styles gallery (or below the Quick Styles but-
ton) in the Table Styles group on the Table Tools Design tab.

Figure 13-3 shows the Table Styles gallery in operation. As with other Office galleries, allow-
ing the mouse pointer to rest over an option in the gallery previews the formatting in the 
table. (It also shows the name of the style in a ScreenTip.)
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Figure 13-3  Colors and fonts associated with each of these built-in table styles adjust to match 
the current theme.

The colors and fonts associated with a style vary depending on the theme used for the cur-
rent worksheet. If you change the theme, any existing table formats change to pick up the 
color schemes and fonts from the new theme.

For more on how themes allow you to apply consistent formatting, even in different Office 
programs, see “Using Office themes” in Chapter 5, “Working with graphics and pictures.”

If you’ve applied manual formatting to fonts, font colors, cell shading, and so on within a 
table region, your formatting is preserved when you apply a table style. To clear any man-
ual formatting and use only the formatting specified in the table style, right-click the style 
in the Table Styles gallery, and then click Apply And Clear Formatting.
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Many of the built-in table styles include formatting that adds shading to alternate rows, 
which makes reading across wide tables easier. The seven check boxes in the Table Style 
Options group on the Design tab allow you to fine-tune the following format settings:

●● Header Row  Clear this check box to hide all column headings. Doing so also hides 
the down arrow used to access sort and filter options for each column. Note that 
Excel remembers the name assigned to any column and continues to use it in struc-
tured references within formulas.

●● Total Row  Select this check box to add a row beneath the table, with options to 
automatically subtotal the contents of one or more columns. If the table contains 
more than one column, the word Total appears in the first column. If you expand the 
table, this row remains at the bottom of the new range. You can customize the for-
mulas beneath each column by using a drop-down list, as we explain shortly.

●● Banded Rows  Apply different background colors to alternating rows to make read-
ing across a wide table easier.

●● First Column  Click to apply special formatting to the first column in the table. Use 
this option to highlight labels that identify each row.

●● Last Column  Click to apply special formatting to the last column in the table. This 
option is especially useful if the last column contains totals for each row.

●● Banded Columns  Apply different background colors to alternating columns.

●● Filter Button  Remove the arrow to the right of a column heading that allows you 
to filter, sort, or search using the contents of that column.

In effect, these check boxes allow you to provide very specific customizations to the current 
table style. When you combine these options with the 60 entries in the built-in Table Styles 
gallery, each of whose color palette and font can in turn be reset using any of 21 built-in 
themes, you have literally thousands of possible looks to choose from. That’s not enough? 
Then build your own table style by clicking the New Table Style link at the bottom of the 
Table Styles gallery. Doing so brings up the New Table Style dialog box, where you can set 
the properties for each part of the table individually.

Starting from scratch to create a custom table style is difficult and potentially confusing. 
In our experience, you’ll find it much simpler to duplicate an existing table style and then 
modify the style you copied. In the Table Styles gallery, right-click the style you want to use 
as your starting point, and then click Duplicate. That opens the Modify Table Style dialog 
box shown next.
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In the Name box, replace the default name with a descriptive name. Then select individual 
table elements from the list in the center of the dialog box and adjust their definition as 
needed. Click the Format button to change font style (bold, italic, and so on), cell borders, 
and shading. The four stripe options allow you to set how many rows are in each stripe that 
makes up a band. The default is 1, which means that shading alternates from one row to 
the next. If you choose 2 for First Row Stripe and Second Row Stripe, each band of shading 
is applied to two rows at a time.

Custom styles appear at the top of the Table Styles gallery. If you right-click on a saved cus-
tom table style, you’ll notice that Modify and Delete options are available on the menu; you 
can’t modify or delete any of the predefined table styles.

TROUBLESHOOTING
Fonts and colors in custom table styles behave unexpectedly in Excel
Although the Format Cells dialog box for each table element includes a Font tab, most 
of the options on that tab are unavailable. You can change the font style and color, but 
the actual font and font size are determined by the current theme. To apply a table 
font that is not part of the current theme, you must select the entire table and apply 
the font formatting manually. In addition, if you choose a background or fill color from 
the selections on the Fill tab, these colors change when you change the theme. To 
apply a specific color to part of the table and ensure that the color remains unchanged 
when the theme changes, you must use the More Colors option and define that color 
manually.
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Expanding (or shrinking) a table
Although you can define a table by selecting a range of any size, the most common and 
useful scenario defines a table using the current region, which is demarcated by blank cells 
(or the worksheet’s edge) on the top, bottom, and sides. To add a row to the table, click in 
the cell in the lower-right corner of the table range (if your table has a Total row, use the 
row above it), and then press Tab. Excel adds a new row using the colors, fonts, and shad-
ing from the current table style and moves the active cell to the first column in the newly 
created row. If your table includes a Total row, it shifts down to accommodate the new row 
as well.

To expand a table manually, look in the lower-right corner of the table for a small triangu-
lar handle. Make sure that that cell is not selected, and then aim the mouse pointer at the 
handle until the pointer turns into a two-sided diagonal arrow. Drag down to add rows to 
the table, shifting the Total row down if necessary. Drag the handle to the right to add one 
or more columns (each new column gets a generic heading that you can change later when 
you’re ready to enter data).

You can also drag the table sizing handle up or to the left to remove rows or columns from 
the defined table range. Any data currently contained in those cells remains, but loses its 
table formatting.

CAUTION!
If your table contains a Total row and you move the sizing handle up to remove rows 
that currently contain data, you create a circular reference. To avoid this, first delete (or 
move) the contents of any cells that you plan to remove from the table range.

You can add a reference to any table by using its name, as defined in the Table Name box 
in the Properties group on the Design tab. The range defined by this name automatically 
expands when you add rows or columns to the table. (It does not, however, include the 
Header and Total rows.) If you use the current table as the basis for a PivotTable, any new 
rows or columns you create are automatically available for use in the PivotTable. Likewise, 
when you use data from rows or columns in a table to define data series, labels, or other 
elements in a chart, those elements are automatically updated when you expand the table.

Adding totals and formulas to a table
When you create a table, Excel allows you to perform a few tricks with formulas that aren’t 
available within a normal range. The most obvious is the Total row, which you can use 
to quickly add summaries of table data. As we explained earlier in this chapter, you can 
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manually enable the Total row by selecting its check box in the Table Styles Options group 
on the Design tab.

Figure 13-4 shows the Total row for a table containing a month’s worth of stock prices. 
Note that Excel automatically added a formula that totals the rightmost column in the 
table.

Figure 13-4  Excel uses its own internal logic to decide which columns are summarized in the 
Total row. You can add or change these formulas with a few clicks.

Although the result is functionally the same as if you had clicked the AutoSum button, 
the formula itself uses the SUBTOTAL function. You can change the results for an existing 
formula by selecting the cell and clicking the arrow just to its right. In this example, we’re 
about to change the current formula, which shows the total share volume for the month, to 
one that shows the average volume per day:
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In a Total row, you can add a summary formula to any cell. Click that cell to reveal an arrow 
that you can click to display a drop-down list of available formulas.

What if you want to create a calculated column that displays totals, averages, or other sum-
maries on a per-row basis? Excel can do that automatically. In the previous example, click 
any cell in any column to the right of the table range and begin entering a formula. In this 
worksheet, the Open price for each day is in column B and the Close price is in column C, 
with Volume in column D. So we can click in E2, type an equal sign, click C2, type a minus 
sign (-), and click B2. As soon as we press Enter, Excel creates a new column using the cur-
rent table format and copies the formula we just typed to every cell in that column.

INSIDE OUT �  Take control of calculated columns

If you create a formula to the right of the current table and you don’t want it to be 
copied to other cells in the column, use the options on the AutoCorrect menu to 
immediately undo the calculated column. To prevent Excel from automatically copy-
ing calculated formulas to the rest of a column, click File, click Options, and then click 
AutoCorrect Options on the Proofing tab. On the AutoFormat As You Type tab, under 
the Automatically As You Work heading, clear Fill Formulas In Tables To Create Calcu-
lated Columns.

The new column includes a generic heading that you’ll probably want to replace with a 
descriptive heading, and you might also want to insert a formula in the Total row, but Excel 
does all the work of creating the calculated column, as shown in Figure 13-5.

Figure 13-5  If you add a calculated cell to the right of an existing table, Excel copies the formula 
to the entire column using structured references.

If you look carefully at the formula bar in Figure 13-5, you’ll see that the formula Excel cre-
ates includes some unusual cell references. These are called structured references, which 
are designed to make it easy to automatically copy formulas as you add new rows. They’re 
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created automatically when you click to select cell references for use in a formula; you can 
choose to use standard references instead by simply typing the cell address. Brackets indi-
cate a column heading name and an @ sign indicates the current row. The # sign is used 
with one of four keywords to refer to specific parts of the table: #All, #Data, #Headers, or 
#Totals.

Sorting and filtering data
In this section we discuss how to create order out of even the most chaotic worksheet data. 
You can enter or import that data in any order or even at random. Once it’s arranged in 
rows and columns, you can rearrange it as needed. You can sort by numbers, text, or dates. 
You can also reduce clutter by filtering a list to show only data that matches conditions you 
define. These options work on simple data ranges and on tables.

Sorting a range, region, or table
You can sort a range, region, or table by using values from one or more columns. That’s 
true regardless of the data type. In a membership roster, for example, you can sort the list 
in alphabetical order using the Last Name column, or by date, oldest to youngest, using the 
Birthday column, or by number if you’re using the Donations column to track progress in a 
fundraising drive.

To sort the current region, click a single cell in the column you want to sort by and then 
click Sort & Filter in the Editing group on the Home tab. The choices at the top of the list 
vary to reflect the data type. For text, Sort A To Z and Sort Z To A are available, as shown 
here. For dates, the choice is Sort Oldest To Newest and Sort Newest To Oldest. For num-
bers, the choices are Sort Smallest To Largest and Sort Largest To Smallest.

If you prefer to sort the current column with a single click, use the commands in the Sort 
& Filter group on the Data tab, or pin the Sort A To Z and Sort Z To A buttons to the Quick 
Access Toolbar.
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To sort by multiple columns, click Sort on the Data tab; or click Sort & Filter on the Home 
Tab and then click Custom Sort; or right-click a cell in the table or range, click Sort, and 
then click Custom Sort.

Any of those roads take you to the Sort dialog box, shown in Figure 13-6. In operation, it’s 
pretty straightforward and easy to figure out. You build a list of sort levels, each based on a 
column, and then define the sort order for each level.

Figure 13-6  Create as many custom Sort By conditions as you need to arrange your list. Use the 
up and down arrow buttons to change their order.

INSIDE OUT �  Create a custom column to preserve original sort order

Is the original order of your data important? If so, then make sure you can return to 
that order easily. For off-the-cuff tasks, you can simply copy a range to a new work-
sheet, sort and filter as needed, and then delete the copy when you’re done. To ensure 
that you can always return to the original order of a range or table, even if it’s sorted 
accidentally, add a new column (with a descriptive heading like Original_Order) and fill 
it with numbers that indicate the current order—starting with 1 for the first row and 
increasing by 1 for each additional row. With this column in place, you can always re-
sort the table or range by this column to display its original state.

Excel sorts dates, times, and numbers exactly as you would expect, depending on the sort 
order you select—Newest To Oldest, Smallest To Largest, and so on. The rules for text are 
slightly more complicated. For A to Z (ascending) sorts, numbers come first, then most 
punctuation characters, and then letters in ascending (A–Z) order. The sort is not case-
sensitive, so capital letters and lowercase letters are considered the same for sorting pur-
poses. Apostrophes and hyphens are typically ignored except when two strings of text are 
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otherwise identical; in that case, the one that contains the additional punctuation follows 
the one without. The precise order for punctuation places the space character first, then 
uses the same numbering as the Unicode character set to determine the order of additional 
nonalphabetic characters.

You can also sort by a custom series, such as the January through December and Sunday 
through Monday series that are defined in Excel by default. For more details, see “Entering 
and sorting data with custom series” in Chapter 14.

Filtering data in a table
As a list gets longer and longer, it becomes more difficult to see patterns associated with 
subsets of that data. That’s when filtering the list becomes useful, hiding rows except those 
that match criteria you specify. If you’re analyzing data from a dozen schools, stores, or cus-
tomers, each with a unique identifier in a common column, you can filter the worksheet to 
show only the names you select from that column. You can filter on numbers and dates as 
well. For example, to create a filtered list of products that are out of stock (or nearly so), you 
can include only rows where the value in the QtyOnHand column is below 3.

If the number of choices in a column is limited, or if you know exactly which names or val-
ues you want to include, you have two options.

The first option uses a feature called slicers, whose capabilities have been expanded in Excel 
2013 to work with ordinary tables as well as PivotTables. A slicer is essentially a floating list, 
built on the fly, that lists all the unique items in a column. By clicking items in the slicer, you 
instantly filter the table to show matching rows.

To add a slicer to a worksheet, click to select a cell within a table and then click Slicer in the 
Filters group on the Insert tab. Select the name of the column you want to “slice,” and click 
OK. The result is a list like the one shown here, which scrolls if necessary so that you can see 
and click items to use as a filter.
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Ctrl+click to select or clear multiple items from the filter list. Click the Clear Filter button in 
the upper-right corner of the slicer (or press Alt+C) to clear your selections and display the 
lists sans filter.

When you click a slicer box, Excel displays a context-sensitive Slicer Tools Options tab on 
the ribbon, where you can adjust the name displayed in the slicer’s title bar, change the 
height and width of individual buttons, and display buttons in multiple columns. (Similar 
controls allow you to adjust the height of the slicer box itself, but it’s easier to drag the bor-
ders of the slicer to change its height or width.)

And you’re not limited to a single slicer. If you use two or more slicers together, they coop-
erate neatly. In Figure 13-7, for example, we’ve filtered the list using three company names. 
Doing so caused the Country Code slicer to display matching values at the top of the slicer, 
where we are free to click (or Ctrl+click) to filter the list further.

Figure 13-7  Using multiple slicers allows you to build a complex filter. Here, we’ve changed the 
button height in the Company slicer and arranged the second slicer into two columns.

The second option, which works with or without slicers, is to filter the contents of one or 
more columns directly. Click the arrow to the right of the column heading and pick from 
the list at the bottom of the menu, as shown in Figure 13-8.

The values in this list are drawn from the contents of the current column. Clear the Select 
All check box at the top of the list to clear all items, after which you can select a few specific 
items from the list. Click Select All again to reselect all items. When you have a mix of man-
ually selected and cleared check boxes, the Select All box is a solid square as in Figure 13-8.
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Figure 13-8  To create a completely custom filter, select items in the list at the bottom of this 
menu, which contains all values found in that column.

If the list of items is too long to be easily manageable, use the search box on the menu to 
restrict the list of items to those that match whatever you type. The text you enter doesn’t 
have to be a complete word or phrase, and the search results show any match regardless of 
whether it’s at the beginning, middle, or end of a cell’s contents. Thus, entering dat returns 
A. Datum Corporation and Consolidated Messenger.

CAUTION!
The option to filter by selecting from a list is limited to the first 10,000 items in a list. 
In the case of a particularly long list in which a single column has many unique values, 
you see a warning message beneath the list that reads Not All Items Showing. Try using 
the search box to reduce the number of unique items, or choose a different filtering 
method.
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For dates that range over a long period of time, Excel automatically collapses the choices 
in the filter list, allowing you to choose entire years or to expand the list to include months 
or even days within a year. Here, for example, we started with a list of stock prices that 
includes data from every trading day for 25 years. By typing Jan in the search box, we fil-
tered the list to show only the dates from January.

If our goal is just to compare data from the month of January for the past five years, we can 
click Select All Search Results to clear the current list, then manually include 2012, 2011, 
and so on. Or we can manually choose certain years. When the selection is complete, select 
Add Current Selection To Filter, and click OK.

In addition to item-by-item filtering, you can create a custom filter for any column to 
show or hide rows in the list according to the criteria you specify. The exact set of options 
depends on the data type. The menu option above the search box reads Text Filters, Num-
ber Filters, or Date Filters, depending on the contents of the current column.

Options on the Text Filters menu all lead to the Custom AutoFilter dialog box, where you 
can define one or two criteria for your filter. You can base criteria on the exact cell contents 
(Equals, Does Not Equal) or on what the cell begins with or contains. The following example 
finds all rows where the contents of the Vendor column begin with B, C, D, or E.
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For a column that contains numbers, most of the options on the Number Filters menu lead 
to the same Custom AutoFilter dialog box. The menu contains three additional choices that 
work only with numbers. The Above Average and Below Average options work as expected, 
instantly filtering the list to show only those items that are above or below the arithmetic 
mean. The other choice, Top Ten, is misleadingly named. It opens the Top 10 AutoFilter 
dialog box, with Top 10 Items selected by default. However, you can select any number 
between 1 and 500; you can choose to show the Top or Bottom entries that match that 
value; and you can change Items to Percent. In this example, we’ve filtered the list to show 
only those records with values in the bottom 20 percent.

The options on the Date Filters menu are probably the most extensive. You can quickly 
define a range of dates, choose relative dates (Yesterday, This Quarter), or create a custom 
filter. Figure 13-9 provides one example of the full range of options, where we’ve used 
check boxes to narrow the list to the three most recent years and then used the Date Filters 
menu to specify that we want only dates from Quarter 1 in those years.

If you choose the Custom Filter option, the dialog box resembles the one available for text 
and numbers, with the small but crucial difference that it includes calendar controls to use 
when you are picking dates.
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Figure 13-9  Use the Date Filters menu to choose from this extensive list of AutoFilter options 
when the current column contains mostly dates.

Using conditional formatting to highlight cells based on 
their content

Tables filled with data can be overwhelming and difficult to understand without lengthy 
explanations. Are there ways to highlight trends and patterns and identify anomalies while 
still maintaining a full view of the data in a table? Indeed there are.

You can help your audience (and yourself) make more sense of data by using conditional 
formatting to highlight values that meet criteria you define. We introduced this feature 
briefly at the beginning of this chapter, in the discussion of the Quick Analysis tool. In this 
section, we explain how to take full advantage of it.

The idea behind conditional formatting is simple: You want to be able to look at a table or 
a range of data and quickly see any values that demand your immediate attention or spot 
trends that might not be apparent from the raw data. Is a particular value greater than or 
less than a specific amount? Is it in the top (or bottom) of all values in the range? Does it 
contain a specific word or string of text or fall within a range of dates?
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After you define those conditions, Excel can apply automatic formatting that identifies 
matching values: displaying the bottom 20 percent of values in red, for example, with the 
top 20 percent in green; or using a color scale that moves from red to yellow to green as 
the values in the selection go from low to high; or adding data bars that provide a visual 
representation of the relative size of values in a cell.

The easiest way to get started is to use the Formatting section of the Quick Analysis tool.

Select a range of data—an entire table, a column or row containing totals, or a subset of 
data representing groups whose performance you want to examine more closely. Then 
press Ctrl+Q to open the Quick Analysis tool. The options available depend on whether 
your selection includes numbers or text. Figure 13-1, at the beginning of this chapter, 
shows the options available when you select numbers. Figure 13-10 shows what you see if 
your selection includes only text (in this case, the contents of the Company column).

Figure 13-10  The Formatting options in the Quick Analysis tool offer these choices when your 
selection includes only text.

If you click Duplicate Values, Excel applies a red background to all values in the selection 
that are repeated at least once. Click Unique Values to perform the inverse operation, 
applying similar formatting to any cell whose contents are not repeated elsewhere in the 
list.

The Text Contains and Equal To options require some explanation. The effect of clicking 
either button depends on the contents of the current cell within the selection. (You can 
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move the current cell within the selection using Tab and Shift+Tab.) If the current cell con-
tains “Contoso,” click Text Contains to apply a red background to any cell containing that 
word: Contoso, Contoso Inc., Contoso Pharmaceuticals, and so on. Click Equal To and Excel 
will highlight only cells that are a perfect match for the current cell.

The options in the Quick Analysis tool for a selection that contains numbers rather than 
text allow you to add data bars, icons, or colored shading to a selection of data, features we 
explore in the remainder of this section.

Any conditional formatting you apply using the Quick Analysis tool uses default settings. 
For greater control over the conditions and appearance of the formatting, you can create 
conditional formatting rules directly.

To get started, select a range of data and then click Conditional Formatting in the Styles 
group on the Home tab. That displays the Conditional Formatting menu:

Each of the five main choices on this menu provides access to a range of preset rules. The 
More Rules option at the bottom of each of the submenus allows you to create custom 
choices that vary from the preset configurations. The following list describes what you’ll 
find in each of the five main choices:

●● Highlight Cells Rules  Each of the seven preset options opens a dialog box that lets 
you construct a formula using a comparison operator (greater than, less than, equal 
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to, and so on) along with a value or cell reference to compare with each cell’s con-
tents. Excel fills in values using its internal algorithms; you can change those values or 
point to a cell reference. The list on the right allows you to choose the formatting to 
be applied to cells matching your specified conditions.

●● Top/Bottom Rules  The input dialog box that opens when you select any of the 
choices on this menu also allows you to create a rule on the fly. Don’t be misled by 
the number 10 in the Top 10% and similar options. You can change that value or per-
centage to a different number if you prefer.

●● Data Bars  This option adds a small bar (a longer bar equals a higher value) to each 
selected data cell, using a solid or gradient color. These bars show up as a live pre-
view in the selected data so you can see the effect before you make it final. In the 
example shown in Figure 13-11, we’ve already created a customized data bar; choos-
ing an option from the Solid Fill list changes the color without changing other set-
tings. Note the ScreenTip, which explains, tersely, what the thumbnail represents.
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Figure 13-11  Adding a data bar to a range (the Rainfall column, in this example) adds a 
colored bar to visually represent the data in the selection.

●● Color Scales  This option applies colored cell backgrounds to the selected range 
using two or three colors in a range that is defined by the data itself. The Green-
Yellow-Red option, for example, uses green for the lowest values, red for the highest, 
and yellow for everything in between. The actual number of shades used is much 
more than two or three, with more intense shades representing the extremes of 
higher and lower values.

●● Icon Sets  This is the most visually diverse (and potentially cringe-inducing) of all 
the preset conditional formatting options. You can choose from arrows, circles and 
other shapes, flags, and rating scales made up of stars and bars and immediately rec-
ognizable symbols like the ones shown here.
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You can combine multiple rules in the same selection, highlighting values in the top 20 per-
cent in bold green text on a light green background, with values in the bottom 20 percent 
displayed in bold red italics on a light red background, for example.

If none of the preset options match your needs, you can create custom rules from scratch. 
In some cases, you might start with a preset rule (from the Quick Analysis tool or from the 
Conditional Formatting menu) and then, after applying it to the selection, modify the rule.

Click More Rules at the bottom of any of the Conditional Formatting menu options to dis-
play the New Formatting Rule dialog box. The example shown in Figure 13-12 adjusts the 
default rules for data bars so that the largest bar in the selection doesn’t cover up the num-
ber it represents.

Figure 13-12  Click More Rules at the bottom of a conditional formatting option to build a rule 
from scratch. Changing the Minimum and Maximum values here adjusts the length of data bars 
to avoid covering the value.

If you’ve already defined rules and want to adjust them, click Conditional Formatting (in the 
Styles group on the Home tab) and then click Manage Rules. That opens the Conditional 
Formatting Rules Manager dialog box, shown in Figure 13-13. Select This Worksheet to see 
all rules for the current sheet.
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Figure 13-13  You can edit any existing rule from this dialog box. Use the Stop If True option if 
you want to apply conditional formats in a precise hierarchy.

To edit an existing rule, select its entry in the Conditional Formatting Rules Manager dialog 
box and click Edit Rule. The exact options you see here depend on the type of rule you 
originally created. For example, you can hide the underlying value and show only an icon 
or data bar.

TROUBLESHOOTING
Conditional formats don’t behave as expected
If the formats you see in a table aren’t displayed as you expected, you should check 
several possible causes. If you experimented with multiple rules, it’s possible that you 
left an old set of rules in place and added a new, conflicting rule that applies to the 
same data. To check for this possibility, open the Conditional Formatting Rules Man-
ager dialog box and choose This Worksheet from the Show Formatting Rules For list. 
If you see an old, unnecessary rule, select it and click Delete Rule. It’s also possible you 
have a conflict between multiple rules, with the rule at the top of the list applying one 
set of formatting that is then overruled by a later rule. If you want the first rule to take 
primacy, select the Stop If True check box for that rule. Then be sure that the Applies 
To range for each rule is correct. When you add, move, or copy cells or formatting, the 
conditional formats don’t always follow in the way you might expect. Finally, check the 
numbers used as triggers within each rule. Excel applies some default settings when 
you create the rule. If your data has changed since then, you might need to tweak the 
rules accordingly.
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If you experiment a little too much with conditional formatting rules and want to get a 
fresh start, click Clear Rules on the Conditional Formatting menu. You can erase the rules 
from a selection, an entire sheet, a table, or a PivotTable.

Using sparklines to visualize trends within a range
If you think of sparklines as tiny charts that fit in a single cell, you won’t be too far from the 
truth. This feature, introduced in Excel 2010, enables you to visualize a data series in a sin-
gle cell. The following example shows quarterly results over a period of several years, with a 
sparkline at the end of each row that shows the up and down gyrations over each year.

The easiest way to apply sparklines to a range of data is to select the range and then open 
the Quick Analysis tool, as shown here.

Sparklines come in three varieties: Line and Column work almost exactly like their full-size 
chart counterparts, while Win/Loss shows an up or down marker depending on whether 
the associated data is positive (win) or negative (loss).

To add a sparkline for a selection other than the full data range, click Line, Column, or 
Win/Loss from the Sparklines group on the Insert tab. If you made a selection first, the Data 
Range box is filled in with that range; you just need to select the cell where you want the 
sparkline to appear.
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To change an existing sparkline, use the Design tab under the Sparkline Tools heading (it’s 
only visible when you select one or more cells containing a sparkline). Figure 13-14 shows 
the commands available on this tab.

Figure 13-14  As with a full-size chart, you can use commands on this specialized tab to change 
the style of a sparkline, add data markers, and edit the source data.

Most of the options on the Design tab are self-explanatory. One that deserves special 
attention is the Axis command, which allows you to customize how each axis in the mini
chart is treated. Normally, each sparkline is treated as an independent series, with values 
charted using only the data in its source data range. If you want Excel to chart multiple 
sparklines using the same range of values, click Axis, and then change the selections under 
Vertical Axis Minimum Value Options and Vertical Axis Maximum Value Options to Same 
For All Sparklines.

Turning data into charts
The process of building a chart in Excel is literally a two-step operation. Step one: select 
some data. Step two: choose a chart type. Everything beyond that is a matter of refinement, 
making the resulting chart more visually appealing and understandable, with titles and 
labels and color gradients and other tweaks.

In this whirlwind tour of the charting features in Excel, we focus on the nuts and bolts of 
actually building a chart. If you’re looking for detailed explanations of the concepts behind 
turning information into graphics, we highly recommend starting with Edward Tufte’s semi-
nal work on the subject (see www.edwardtufte.com). And because space is limited in this 
chapter, we can only dive just below the surface in showing you the many options available 
when you create and customize Excel charts. For a much more complete picture, we recom-
mend Microsoft Excel 2013 Inside Out, by our colleagues Mark Dodge and Craig Stinson 
(Microsoft Press, 2013).

With that disclaimer out of the way, we ask you to look at the simple line chart shown in 
Figure 13-15, which illustrates the most common chart elements.

www.edwardtufte.com
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Vertical axis

Horizontal axis

Plot areaTitle

Figure 13-15  This simple line chart includes several basic elements—a chart title, a plot area 
(with gridlines), and two axes—horizontal and vertical.

With a little more data and a few more clicks, we could make this chart much more compli-
cated, although that would defeat its purpose. The following list describes the main chart 
elements available to you in Excel:

●● Data series and plot area  Each series of data appears within the plot area, repre-
sented as a line, column, bar, or pie slice, depending on the chart type. You can use a 
unique color in the plot area to make it stand out from the chart background. Three-
dimensional charts have a wall, a floor, and rotation options as well.

●● Axes and gridlines  Column, bar, and line charts typically plot data along two axes. 
Figure 13-15, for example, shows time along the horizontal axis and rainfall (mea-
sured in inches) along the vertical axis. A depth axis is available for 3-D charts. Grid-
lines help you compare the values in a data series to the values on an axis.

●● Titles  If you choose to use a chart title, you can overlay the title on the chart itself 
or allow the title to sit above the chart. In addition, you can add a title to any axis to 
help explain the data plotted along that axis. Figure 13-15, for example, might be 
easier to understand at a glance if the vertical axis had “Monthly rainfall (inches)” as 
a title.

●● Legend  This optional element functions as a key when a chart contains multiple 
data series; it typically provides labels next to the color or shape used for the corre-
sponding data series.

●● Labels  You can add labels to axes to indicate what each step along the axis repre-
sents. On the horizontal axis shown in Figure 13-15, we removed the labels for the 
12 data points (January through December) within each year and instead used labels 
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to identify entire years. You can also add data labels to a data series in the plot area 
itself to indicate the actual values represented by plot points.

All of the tools you need to create a chart are in the Charts section of the Insert tab, shown 
here.

There’s nothing subtle about the way this group of commands pushes a signature feature of 
Excel 2013. Click the oversize Recommended Charts button on the left and you get exactly 
what you would expect: one or more suggestions on how to turn the current selection or 
region into a chart. (If you know the exact type of chart you want to use, you can click its 
icon from the set of eight options in the middle of the command group.)

Figure 13-16 shows one set of recommendations. The choices you see on the dialog box’s 
Recommended Charts tab use your real data and display an accurate representation of 
what you’ll get if you click OK. The exact number and type of suggestions on this tab 
depend on the type of data you select and how it’s arranged.

Figure 13-16  The selections on the Recommended Charts tab represent live previews of the 
current data, so you can flip through the suggestions and choose the one that best tells your 
story.
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If none of the recommendations suits your fancy, click the All Charts tab to choose from the 
full range of chart types, as shown here.

Choose a chart type from the column on the left and then one of the subtypes from the 
thumbnails along the top of the preview pane on the right. The resulting thumbnails use 
your live data, and you can get a closer look at any chart by letting your mouse hover over 
the thumbnail until it zooms.

Choosing the right chart type
How do you know which type of chart is right for your data? Recommendations go a long 
way, and Excel’s algorithms can be spookily accurate. But, as mentioned earlier, building a 
chart involves equal parts art and science, and there’s nothing like your own eye (and per-
haps feedback from colleagues) to help you determine whether the chart you’ve chosen is 
the right one for the story you’re trying to tell.

In this section, we look at the main chart types with an eye to helping you choose the 
right one.
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Note
You must select a chart type and subtype to create a chart initially, but you can switch 
to a different subtype or even choose a completely different chart type later. Click to 
select any part of the chart, and then click the Change Chart Type command on the 
Design tab to open the Change Chart Type dialog box, which shows the same All Charts 
tab you see when creating a new chart.

Column charts

Column charts are tailor-made for side-by-side comparisons, especially over time. Available 
subtypes include clustered columns, stacked columns, and 100% stacked columns, with and 
without 3-D effects. Figure 13-17, for example, shows a clustered column chart that offers 
a simple comparison of revenues in four regions over four years. It’s easy to see at a glance 
that revenues in the North and East regions have been flat or down slightly over time, while 
the South and West regions have grown impressively. Note that the recommended chart 
includes a placeholder for a title, which we need to replace with a meaningful description.

Figure 13-17  Column charts make it possible to compare data points side by side. This clustered 
column chart shows trends over time for four regions.
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INSIDE OUT �  Swap the axes to tell a different story

Sometimes all you need is a slightly different angle to see a completely different pic-
ture. Clicking the Switch Row/Column button, in the Data group on the Design tab, is 
a particularly effective way of looking at column charts from a different perspective. 
The command name is misleading: what it really does is swap the data series associated 
with the horizontal and vertical axes. The column chart shown earlier in Figure 13-17, 
for example, looks at four regions over time, emphasizing the trend for each region. If 
you click Switch Row/Column, the data series that make up the clustered columns are 
swapped, and you get the revised chart shown here:

At first glance, the chart looks similar to the earlier arrangement. But the story it tells 
is different, emphasizing differences over time, with one region dominating in the first 
year, but with a much narrower gap between the leaders just three years later. Which 
arrangement you choose depends on which story you want to communicate.

The other main variation in this chart type is the stacked column chart, which combines 
data from different series into a single column that emphasizes the relationship of indi-
vidual items to the total. If your data series includes several similar totals and you want 
to emphasize a percentage change in one or more individual components, use a 100% 
stacked chart.

For column charts, most of the 3-D subtypes apply visual effects only. The exception is the 
3-D Column subtype, which uses the horizontal axis and the depth axis to compare series 
and categories equally, with values on the vertical axis.
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Line charts

Use a line chart when you want to plot data over time (or along ordered categories) to 
show trends on a continuous scale: revenues by quarter, economic growth by year or 
decade, rainfall or high and low temperature by month, and so on. The horizontal axis 
should be divided into equal units, with no gaps. Figure 13-18, for example, shows a 
month’s worth of daily high and low temperatures plotted on a line graph.

Figure 13-18  Because this line graph has 28 separate data points on each line, we’ve chosen not 
to use data markers.

Each of the 2-D subtypes in the Line Chart category includes options to show lines with or 
without data markers. If the number of data points on the category axis is relatively small, 
let Excel automatically add markers to show the exact location of each point. That makes it 
easier to find the value associated with each entry on the horizontal axis. You can custom-
ize the color and shape of each marker, as we explain later in this chapter.

INSIDE OUT �  Add data labels selectively

Adding data labels to every point in a series can sometimes lead to information over-
load. The alternative is to add data labels to specific data points. Click to select the data 
series, and you’ll see a selection marker over every point in the series. Click any indi-
vidual data point to select just that point. Now you can show or hide the label for that 
point alone. Use the options on the Data Labels menu, under Add Chart Element on the 
Design tab, to choose a position for the label, or drag it manually.
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Pie charts

If the data you want to plot is in a single row or column, it just might fit in a pie chart. Each 
pie chart consists of a single data series. Each data point is a slice proportional in size to the 
other items in the series, adding up to 100 percent. Pie charts work best when you have a 
small number of data points, six or seven at most, and no slice is too close to 0. (Negative 
numbers aren’t allowed in a pie chart.)

You can emphasize one or more slices of a pie chart by “exploding” it from the rest of the 
chart, as we’ve done here. Select a slice and drag it away from the pie. (This option is espe-
cially dramatic if you’ve chosen a 3-D chart type.) If you select the entire series—in other 
words, every slice of the pie—and drag out, you’ll end up with an exploded pie chart. This 
option is most relevant when you want to talk about each data point separately in order of 
size.

Two of the advanced pie chart subtypes are surprisingly useful when you want to tell a 
story within a story. It’s also a good way to create a readable chart when you have a dozen 
or more data points. The Pie Of Pie and Bar Of Pie subtypes let you combine two or more 
slices into a single slice called Other, with those data points plotted in a second pie or bar 
chart. Figure 13-19 shows the Bar Of Pie chart subtype.

The options for the second chart are well hidden. Right-click the bar portion of the chart 
and then choose Format Data Series. In the Format Data Series pane on the right, use the 
Split Series By options to define which pieces of the original pie are broken out into the 
second chart. Use the sliders under the Gap Width and Second Plot Size headings to adjust 
the distance between the two charts and change their size relative to each other.

Doughnut charts are similar to pie charts but can contain multiple data series, with one 
series inside the “doughnut hole” of the next. Excel’s Help system notes that dough-
nut charts are “not easy to read” and suggests stacked column or stacked bar charts as 
alternatives.
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Figure 13-19  You define which values go in the bar chart on the right by setting a condition—in 
this example, the three smallest values in the list.

Bar charts

A bar chart is, in its simplest form, a column chart turned on its side, with the values on the 
horizontal axis and categories on the vertical axis. Bar charts are ideal for differentiating 
winners and losers—or at least those who are in the lead for now. Bar charts work equally 
well for presenting results of speed tests and for pointing out who’s in front in a fundraising 
competition. In Figure 13-20, for example, we could have just as easily plotted this data as a 
column chart, but the long school names would have been awkward to position along the 
horizontal axis and look more natural and readable here.

Figure 13-20  Bar charts work especially well when the category names are long, as in this 
example. The horizontal arrangement makes the current leader easy to identify.
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Area charts

Area charts show the magnitude of change in a data set over time and thus offer a good 
way to show changes in the relative contributions of different parts of a group. In their 
plainest form, 2-D and 3-D area charts are like line charts, except that the value between 
the data point and the next lowest point on another series (or the lowest point on the axis) 
is filled in with color.

A stacked area chart like the one shown in Figure 13-21 adds all the values together so that 
the highest point on the chart for each point on the horizontal axis represents the total for 
that point.

Figure 13-21  Use a stacked area chart to pile each data series on top of the one before it and 
show its contribution to the total.

Scatter (X, Y) charts

Scatter charts (also known as X, Y charts) are fascinating, versatile, and often misunder-
stood. A scatter chart is made up of two numeric data series, plotted in pairs on the hori-
zontal and vertical axes (which are also known respectively as the x-axis and y-axis, thus 
explaining the origin of the name). You can use a scatter chart in place of a line chart when 
data points on the horizontal axis aren’t linear; the visual result is similar, but without the 
distortion caused by irregular spacing of data points. One common use of a scatter chart 
is to identify clusters of similar data in a nonlinear set. In Figure 13-22, for example, we’ve 
created this chart type by plotting survey data for 15 companies, with customer satisfaction 
ratings on the vertical axis and price on the horizontal axis.
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You’ll notice in this scatter chart that we deliberately hid the values on both axes. The num-
bers themselves can be on any scale you create. It’s the position of the data in this chart 
that matters most. The data point for Wingtip Toys represents the best value, while the one 
for Wide World Importers is the worst.

Figure 13-22  Each dot represents a pair of survey results for a company’s products. The dashed 
trendline shows that higher prices generally mean greater satisfaction, but the two data labels 
identify noteworthy exceptions.

Bubble charts resemble scatter (X, Y) charts with an extra dimension that turns plot points 
into bubbles of varying sizes. As in a scatter chart, the values in the x and y series plot the 
location of each data point. The third value determines the bubble size.

Other chart types

The last two tiny icons in the Charts group on the Insert tab cover a hodgepodge of chart 
types that are useful for specialized purposes. One icon covers Stock, Surface, and Radar 
charts; the other lets you create a Combo chart.

Analyzing trends in the markets for stocks, bonds, and other securities was once one of the 
most popular uses for Excel charts. It’s less important today, with the widespread availabil-
ity of online services that can create these charts for you. But if you have a set of data that 
includes historical stock prices, this chart type is made for you. The four available layout 
options enable you to plot the movement of stock prices on a daily basis, using a single line 
to indicate high, low, and closing prices. Opening prices and trading volume are optional 
data series.

Building a stock chart requires that you arrange your data in a specific order. If you try to 
create a stock chart using an incorrect arrangement of data, you’re greeted with a helpful 
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message like the one shown here. (The exact content of the message changes based on the 
chart subtype you’ve selected.)

Surface charts are made up of two data series containing numeric data and resemble a 
topographic map. If you can envision a rubber sheet stretched over a 3-D column chart, 
you have a pretty good idea of what a 3-D surface chart looks like.

Radar charts plot data in a circular arrangement, where one set of numeric values starts at 
the center of the chart and a second set of ordered values (typically time) is plotted around 
the outside of the circle.

Changing a chart’s layout or design
After you create a chart, you can change its fundamental organization, layout, and location 
at any time. You can also tweak the style and appearance of individual chart elements. In 
previous versions of Excel, these tasks required visits to myriad dialog boxes. In Excel 2013, 
selecting a chart exposes two custom tabs that appear under the Chart Tools heading.

On the left side of the Design tab is an Add Chart Element menu, which displays options 
that are specifically designed for the type of chart you’ve selected. You might want to add 
labels showing the exact numbers associated with each bar, for example. To do so, click 
Data Labels. As Figure 13-23 shows, allowing the mouse pointer to hover over an individual 
option previews the effect of that option on the live chart. Click to apply the change.

Other items on the Design tab allow you to quickly change the layout of a chart, keeping 
its basic organization but showing, hiding, and rearranging elements such as chart titles 
and axis titles. The Change Colors menu lets you choose from a selection of ready-made 
color palettes, some bold and others muted. You can also adjust colors and fonts automati-
cally using thumbnails in the Chart Styles group. All of these options allow you to point and 
preview their effects in the live chart. If you don’t like the effect, move the pointer away to 
preserve your existing chart choices.
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Figure 13-23  Let the mouse pointer hover over any item on the Add Chart Element menu to 
preview its effects on the graph. Here, you can see the data labels at the end of each bar.

For alternative access to the same controls, click anywhere within the chart to reveal three 
buttons at the right. Clicking any button reveals additional options, such as the Chart Ele-
ments menu shown here.
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Selecting a check box adds an element to the chart; clearing a check box removes it from 
the chart. Allow the mouse pointer to hover over the name of an element to preview its 
appearance. Click the arrow to the right of any item to see a submenu with additional 
choices. Note that this menu is identical in function, if not appearance, to the Add Chart 
Element menu on the Design tab.

Likewise, the choices available when you click the second button mirror the options you 
can choose from the Chart Styles group and the Change Colors menu, respectively, on the 
Design tab.

The third and final button has the same effect as the Select Data button on the Design tab, 
allowing you to adjust the values and names of data series that appear in the chart.

These options work well for most charts, but there are times when you might want to fine-
tune the appearance or position of a particular chart element. When that type of situation 
arises, you have four choices:

●● Click the Add Chart Element menu on the Design tab, select an element, and then 
click the More element type Options menu choice below the ready-made choices.

●● Click the Chart Elements button (the first one to the right of the chart, identified by 
a plus sign), click the arrow to the right of the element you want to adjust, and then 
click More Options at the bottom of the submenu.
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●● Click the Format tab and choose an element from the list at the top of the Current 
Selection group; then click Format Selection.

●● If the element is visible in the chart, double-click it.

Regardless of which method you select, the tools you need appear in task-specific panes on 
the right side of the worksheet.

INSIDE OUT � Use the arrow keys to cycle through individual 
chart elements

If you’re more comfortable with a keyboard than a mouse, you can use the arrow keys 
to cycle through all available elements in the current chart. Double-click anywhere 
inside the chart borders (but away from axes, titles, legends, and the like) to select the 
Chart Area, which is the first entry in the Chart Elements list in the Current Selection 
group on the Format tab. Now use the Up and Down Arrow keys to move through 
the list, to the plot area, individual data series, axes, and so on. Use the Left and Right 
Arrow keys to move through individual items in a series, a legend, or another element 
made up of multiple data points. If the legend is selected, press the Right Arrow key to 
select the first entry in the list, and keep pressing to move through the entire legend.

There are, quite literally, thousands of individual options available to you when you begin 
poking around at a granular level with individual chart elements. The pane containing 
formatting options is typically divided into tabs. The Format Legend pane, for example, 
includes the Legend Options tab (shown here) and a Text Options tab; both are in turn 
divided into three subgroups of settings.
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Many of the commands in the formatting panes lead to collapsible menus that present 
common formatting options. The Format Axis Title pane, for example, shows three options 
you’ll find repeated in the corresponding formatting panes for other elements. From left to 
right, these are Fill (shown in Figure 13-24), Effects, and Size & Properties.

Figure 13-24  Click one of the three small icons below Title Options to change the set of options 
shown in this formatting pane.

A surprising range of options is available if you dig deep enough. For example, a graph 
whose values are expressed in large numbers—thousands or millions—might benefit from 
having the values shown in a truncated form on the axis, so that 244,778,845 appears 
between the tick marks for 200 and 250. The Format Axis pane, shown next, lets you do 
exactly that, setting a value-based axis to show numbers in hundreds, thousands, millions, 
billions, trillions, or even a logarithmic scale.
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The process of building a chart doesn’t have to be linear. After you get a few basic design 
decisions out of the way, you can revisit and refine the chart’s layout, formatting, and style 
options as needed, in any order, trying out alternatives until you’re satisfied.

If the iterative process turns out a collection of settings you’re especially pleased with, or 
if you want to share your handiwork with other people, you can save the current settings 
as a chart template for reuse. Right-click the chart area, choose Save As Template from the 
shortcut menu, and give the template a descriptive name. To apply all those settings to a 
new chart with one pass, click Change Chart Type on the Design tab, choose the Templates 
category from the All Charts tab, and pick the thumbnail for your saved template.

One final option allows you to change the location of a chart. Click Move Chart (the right-
most command on the Design tab) to see the dialog box shown here. You can position the 
chart on its own sheet or as an object that floats on a worksheet—typically the same one 
containing your source data.
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INSIDE OUT �  Change a chart’s location to suit the task at hand

It’s perfectly acceptable to move a chart to make it easier to work with. As you change 
the data in a table, for example, you might want to see your changes reflected in real 
time in a linked chart. In that scenario, move the chart to the current worksheet and 
position the chart object alongside the data you’re entering or editing. When you’ve 
polished the chart to perfection, move it to its own chart sheet and give the sheet a 
descriptive name. That makes finding the chart easier so you can use it in a Word docu-
ment or a PowerPoint presentation later.

Linking worksheet data to chart elements
The elements that make up a chart are, in most cases, linked directly to data within a 
worksheet. Series names typically come from the label attached to the column or row that 
provides the data series values. Axis labels and legends are also derived from source data. 
If you change any of the data points in the source data, the corresponding chart element is 
updated immediately.

You can view and edit the source data for a chart by clicking anywhere in the chart and 
then clicking Select Data, in the Data group on the Design tab. Figure 13-25 shows this dia-
log box for a chart whose data source consists of four rows (each treated as a separate data 
series) and four columns (each treated as a separate category).

Figure 13-25  You can edit the source data for any series or rearrange the order of series and 
categories in this dialog box.
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In this example, the source data (as identified in the Chart Data Range box) is a single con-
tiguous range. If your chart consists of selected rows or columns from a larger range or 
table, you’ll see each range listed separately, with commas separating the multiple ranges.

The labels above the two main boxes in the Select Data Source dialog box do not change 
with the chart type, which can lead to some confusing results. For example, in a pie chart, 
the values in the Horizontal (Category) Axis Labels box define each slice of the pie and are 
used for the legend, while the values in the Legend Entries (Series) box contain the values 
that are plotted in the chart and are not in the legend.

When you open the Select Data Source dialog box, it positions itself so that the upper-left 
corner of the chart’s data range is visible.

To edit an individual data series, select it in the Legend Entries (Series) list and then click the 
Edit button. The Edit Series dialog box, shown here, shows you which cell is being picked up 
as the series name and which range defines the data series. In both cases, you can see the 
current values to the right of the Collapse Dialog button and the equal sign.

Note
If the series you select is part of a scatter (X, Y) chart, the Edit Series dialog box con-
tains separate boxes for Series X Values and Series Y Values.

The Add button opens the same Edit Series dialog box, with no data source selected. Click 
to fill in the Series Name and Series Values boxes with valid ranges and then click OK to 
add the new series to your chart. The Remove button completely removes the selected data 
series from the chart. Use the Move Up and Move Down arrows (to the right of the Remove 
button) to change the order of the selected data series in the list. (You cannot change the 
order of categories here—do that by using the Axis Options tab in the Format Axis task 
pane.)

With a chart that is embedded on the same sheet as the source data, you can edit chart 
data directly, using color-coded handles that surround the corresponding source data. If 
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you click to select the entire chart, selection handles appear around all values listed in the 
Chart Data Range box. If you click to select a data series in the chart, the handles appear 
around the source cells and ranges associated with that series. Figure 13-26, for example, 
shows the result when we select the fourth and final series in a clustered column chart.

Category axis labels

Data series values

Markers showing
selected series

Series name

Figure 13-26  The color-coded selection boxes show the series name and values and category 
axis labels.

The red box indicates the data series names, the blue box indicates the series values (points 
to be plotted in the chart), and the purple box identifies category axis labels.

If you use a table as the source data for your chart, adding a new row or column automati-
cally extends the corresponding series in the linked chart. If your data source is a simple 
range, you have to add new data manually. To do so, enter your data first, including the 
column or row heading, and then click the chart to expose the color-coded handles. Drag 
the corner of the range containing the series values so that it includes your new row or col-
umn, and then drag the series name or category axis label, as needed, to include the newly 
added cell.

If you find it easier to use the Clipboard, you can add a new row or column to your data 
source (or select an existing range that isn’t currently part of the chart), copy it to the 
Clipboard, and then click to select the chart and paste the Clipboard contents. Be sure to 
include the cell that includes the series name or category axis label, if appropriate.
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You can also use the sizing handles to reduce the number of series or data points. For 
example, if you have a column chart that includes 12 months’ worth of results but you want 
to show only the last three months, drag the corresponding selections in the data source to 
make them smaller, using just the data you want to include.

INSIDE OUT �  No more data limits

Previous versions of Excel imposed strict limits on the number of data points you could 
include per data series and per chart. Beginning with Excel 2010, those limits were 
completely removed. You can now include as many data points as your PC’s memory 
can accommodate. That’s good news for scientists and engineers who want to visualize 
very large sets of data. However, this change doesn’t repeal the most fundamental prin-
ciple of turning information into graphics: KISS (Keep It Simple, Stupid).
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accepting revisions,  680
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about,  20, 787, 823–825
database basics,  826–828
subscription edition,  9
templates supported,  824
troubleshooting,  830

Accessibility Checker,  314

Access Options dialog box,  6–7
Access web apps

about,  824, 828
adding data,  831–832
adding tables,  830
creating,  826, 829
creating views,  831
customizing views,  831
modifying,  826

Accounting format,  393
Account option (Backstage view)

about,  54
activating Office installation,  36–37
Add A Service menu,  187
Office Background option,  47
signing in to Office,  183
User Information heading,  187
viewing account details,  185–187

accounts. See Microsoft accounts
Account Settings dialog box

Address Books tab,  549
Data Files tab,  519
keeping local copies setting,  515
New option,  512

ACOSH worksheet function,  387
ACOS worksheet function,  387
action buttons,  692–695
actions

Quick Step,  552–554
rule-based,  557–560

Action Settings dialog box,  693–695
Activate dialog box,  403
activating Office

process overview,  36–38
subscription plans,  23–24
trial editions,  36–37
volume-license editions,  38

ActiveX controls,  172, 174
Add Account dialog box,  510, 512–513
Add A Digital Signature command,  316
Add A Service menu

Images & Videos submenu,  187
Sharing submenu,  187
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templates for,  640
triggering effects,  647–648

annotations
adding during slide shows,  659–660
online presentations and,  673
video clips and,  674

apostrophe ('),  396, 422
Apply Master Page dialog box,  801
Apply Styles task pane,  248
Appointment Recurrence dialog box,  537–538
appointments

about,  503
Copy To My Calendar command,  540
creating,  535–537
editing,  535–537
linking to OneNote,  761
managing data files,  519
OneNote notebooks and,  716
Outlook keyboard shortcuts,  501
recurring,  537–538
reminders for,  579
sharing details,  598
time zones and,  593–595
turning email messages into,  536
turning into meetings,  503

apps
adding to Office programs,  41–42
customizing Office,  40–42
managing,  42
synchronizing SkyDrive files,  190–191
viewing available,  41
Word supported,  346

Apps For Office dialog box,  41–42
Archive dialog box,  588
archiving Outlook data,  519, 587–590
area charts (Excel),  445
arguments in functions,  370
arithmetic operators,  371–372, 377
Arrange All command,  231, 402, 681
Arrange Windows dialog box,  402–403
Artistic Effects gallery,  133
ASCII character code

alternate currency symbols,  393, 475
CHAR function and,  469
keyboard shortcuts,  80, 83

ASIN worksheet function,  387
aspect ratio

graphics and pictures,  124, 130–131
presentations,  621, 655

Asset Tracking template,  824
asterisk (*),  371, 377
ATAN worksheet function,  387
at sign (@),  476
attachments to email

download options,  529

Add Chart Element menu,  447–449
Add Gallery To Quick Access Toolbar command,  63
add-ins

customizing Office,  40–42
disabling,  40
legacy,  40
removing,  40

Add-Ins ribbon tab,  60
addition operator,  371, 377
address books (contacts)

about,  546–549
Contacts folder,  541
customizing,  549
filtering contents,  547

Addressing dialog box,  548
Add To Favorites option,  571
Advanced Find dialog box,  586
Advanced Track Changes Options dialog box,  310
Advertisements tool (Publisher),  796
aligning

Excel worksheet orientation,  471–472
objects on drawing layer,  122–123
paragraph text,  95
pictures,  259
text in Word tables,  283
text with tabs,  221–223

All Accounts group,  527
All Caps format (fonts),  239
All Markup option (Review tab),  305
All Slides dialog box,  656–657, 683
ampersand (&),  374, 377, 469
AND operator,  565
AND worksheet function,  386
Animation gallery,  641–642
Animation Painter,  647
Animation pane (PowerPoint),  644–645
animations

about,  639–640
adding,  640–642
customizing effects,  649
delays in,  646
in Duarte’s Five Rules template,  617
duplicating with Animation Painter,  647
layering effects,  642–645
multiple,  639
overlaying text on videos,  648
in placeholders,  645
Presenter view and,  662
repeating,  649
sample presentations,  640
setting additional effect options,  648–649
setting order and timing,  645–646
sliding effect,  17
SmartArt object,  643
starting with bookmarks,  629
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opening in Read Mode,  218
removing,  566

audio clips
compressing files,  630
editing,  632
hiding audio icon,  698
incompatibility with viewers,  671
playing behind slides,  697
in presentations,  631–632
recording,  631, 776–779

Author field (documents),  160
AutoArchive tool,  585–588
Auto-Complete feature,  595–596
AutoCorrect dialog box

accessing,  82–83
AutoCorrect tab,  86, 223
AutoFormat As You Type tab,  223–224
defining entries,  86–87
Math AutoCorrect tab,  92

AutoCorrect feature
controlling calculated columns,  420
customizing,  55
defining entries,  86–87
entering characters,  82–83
keyboard shortcuts,  87
mathematical equations,  92
special characters,  80, 81, 223

AutoCorrect Options command,  346
Autodiscover service,  510, 514
AutoFill menu

Copy Cells option,  368
Fill Series option,  368
Fill Without Formatting option,  368
Flash Fill option,  368–370

AutoFilter feature,  426–428
Autofit feature,  792
AutoFormat process,  261
auto-hiding the ribbon,  58
AutoMark button,  297
Automatically Send After 1 Minute Delay option,  553
automating

documents with fields,  342–344
repetitive message-handling tasks,  17

AutoRecover feature,  180–181
AutoRun feature,  676
Autosave feature,  180, 182
AutoSort feature,  466
AutoSum tool,  372
AutoText feature,  225, 340–341
AVERAGEIFS worksheet function,  387
AVERAGEIF worksheet function,  387
AVERAGE worksheet function,  387
axes (charts)

about,  437
bar charts,  444

formatting,  451
line charts,  442
scatter charts,  445
swapping,  441

B
background color

highlighting text,  240
notebook pages,  726
setting,  216

background images,  727–728
Background Removal ribbon tab,  64
Background Removal tools,  60
backgrounds

Office Background option,  47
picture,  135–136
slide presentations,  637

backslash (\),  476
Backstage view

Account option,  36–37, 47, 54, 183, 185–187
Account Settings dialog box,  515
basic arrangement,  46
bypassing for file management,  157
Close option,  50
creating and editing presentations,  610
document properties,  48–49, 178
exiting Protected View,  174
Export option,  46, 53, 674–675
file management,  49–51
Info option,  48–49, 166, 174, 312–316, 630
managing account settings and program options,  54–56
Navigation pane,  46–47, 50–51
new features,  6–7
New option,  49–50
opening,  6–7, 46
Open option,  50, 185, 190
Options option,  54
Print option,  51–52, 478–479
Save As option,  50, 158, 190
Save option,  50
saving and sharing presentations,  621
Share option,  7–8, 52–53, 187–188, 621
SkyDrive folders,  190
Social Network Accounts option,  517

backup and recovery
concept overview,  180–182
OneNote notebooks,  753–755
Outlook data files and folders,  519–520

Banded Columns option (Design tab),  285, 416
Banded Rows option (Design tab),  285, 416
bar charts (Excel),  444
bar in tab position,  221
Bar Of Pie charts,  443
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British pound symbol,  393
browsers

Office Web App support,  191–192
opening files in,  162
publishing for viewing by,  167
SkyDrive usage,  189–190

building blocks (documents)
about,  339–340
AutoText feature,  225, 340–341
creating other types of,  341–342

Building Blocks Organizer,  339–340, 346
building blocks (publications),  795–796
bulleted lists

about,  261–262
customizing,  698
OneNote notebooks,  709–710
presentations,  604–605

Bullet Library,  709
Bullets And Numbering dialog box,  698
Bullets gallery,  698
Bullets tool,  261, 709
Business Card view (Outlook),  544–545
By Paragraph effect option,  645

C
Cached Exchange Mode,  514
calendars. See also appointments; meetings

adding meetings,  503
closing,  540
customizing views,  535
docking in To-Do Bar,  569–571
free Microsoft services,  184
Google,  516
holidays on,  539
keyboard shortcuts,  534
managing,  531–535
managing data files,  519
multiple,  538–540
navigating,  500
opening,  50
overlaying,  539–540
peeking,  16, 500
selecting noncontiguous dates,  535
setting reminders,  577, 579
shared,  538
sharing,  597–598
views supported,  532–534
zoom controls,  533

Calendars tool (Publisher),  796
Calendar view (Outlook)

about,  16, 532–534
arranging multiple calendars,  538–540
Date Navigator control,  532
docking peeks in,  570

baseline guides,  799
binary file formats,  162
Bing Image Search,  42
Bing Video Search,  329–330
bit.ly,  672
Blank Document template,  156
Blank Presentation template,  156
Blank slide layout,  613
Blank Workbook template,  156
Blogger blogging platform,  325
Blog Post tab

about,  325
Home Page button,  327
Insert Category button,  327
Manage Accounts button,  326, 328
Open Existing button,  328
Publish button,  327

Blog Post template,  328
blogs

Blog Post template,  328
creating posts,  325
editing HTML code,  329
managing accounts,  326
OneNote notebooks and,  774
publishing posts,  329
tools supporting,  327–328
troubleshooting,  327

.bmp file extension,  128, 623
boilerplate text,  85–87
Bold tool,  717
Bookmark dialog box,  290
bookmarks

adding to videos,  629, 648
as reference targets,  290

Boolean operators,  565
bootstrapper program

downloading,  28
Border Painter tool,  277, 284
borders

Excel tables,  414
Excel worksheets,  470–471
page layout options,  243
shape outlines,  141
text outlines,  148, 317
Word tables,  277, 284

Borders & Accents tool (Publisher),  796
Borders And Shading dialog box

accessing,  243
Page Border tab,  271

Borders menu,  471
border styles,  284
branding,  682
break characters,  225, 233. See also specific break 

characters
Breaks option (Page Layout tab),  270
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New Appointment command,  501, 535–536
New Meeting command,  501, 535–536
peeking,  500
sharing appointment details,  598

Caption dialog box,  291
caret (^),  233, 371, 377
catalog pages (Publisher),  802
Catalog Tools,  802–803
CD presentation packages,  675–677
cell formats (Excel)

accounting,  393
applying default to,  383
currency,  393
customizing,  390, 472–476
date and time,  393–394
date/time formats,  474–475
exponential,  395
fractions,  395
number,  391–392
number formats,  472, 474
overriding,  391
pasting into multiple worksheets,  398–399
percentages,  394
scientific,  395
special,  396
text,  396
text formats,  475–476

Cell Margins tool,  634
cell ranges (Excel)

about,  360
assigning names to,  362
contiguous range,  361
converting into tables,  411–421
formatting,  389–396
noncontiguous range,  361
print areas as,  482
referencing,  361
sorting,  421–423
visualizing trends within,  435–436

cells (Excel)
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applying formatting,  93
assigning names to,  362
conditional formatting,  428–435
copying and moving data,  365–370
copying from above,  397
formatting,  389–396
jumping to,  362
keyboard shortcuts,  365, 397
referencing,  354, 363, 375–377, 413, 420–421
selecting all,  361

cell styles (Excel),  390, 476–477
Cell Styles gallery,  476
cells (Word tables)

aligning text,  283

formulas in,  281–282
keyboard shortcuts,  279–280
merging,  287
rotating text,  284
splitting,  287

CELL worksheet function,  389
center-aligned tabs,  221
Change Account dialog box,  515
Change Chart Type option (Design tab),  440, 452
Change Colors menu,  447
Change Page Time dialog box,  726
change tracking. See tracking changes to documents
character codes

alternate currency symbols,  393
entering characters,  83
functions and,  469
keyboard shortcuts,  80, 83

character formatting,  93–94, 237–238, 717
character styles

about,  245
applying shading,  240
highlighting text and,  240

CHAR function,  469
Chart Elements menu,  448–449
Chart option (Insert tab),  116
charts (Excel)

changing appearance,  145
changing layouts or designs,  447–453
changing types,  440
chart elements,  437–438, 450
choosing types,  439–440
converting data into,  436–439
data point restrictions,  456
displaying data with,  144–146
labeling,  437–438, 442
linking data to chart elements,  453–456
moving,  453
Quick Analysis tool options,  409
saving as templates,  452
types of

area charts,  445
bar charts,  444
column charts,  440–441
combo charts,  446
line charts,  437, 442
pie charts,  443–444
radar charts,  446–447
scatter charts,  445–446, 454
stock charts,  446–447
surface charts,  446–447

Chart Tools,  145
Choose A File Or A Set Of Files To Insert dialog box,  716
Choose A SmartArt Graphic dialog box,  142
Choose Profile dialog box,  509
Choose Service dialog box,  512
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custom cell formats,  473
formatting with table styles,  414–415
presentation handout options,  665–666
Publisher color schemes,  801–802

color-coding
Office programs,  47–48
source data,  454–455
worksheet tabs,  357

color mapping,  666
column charts (Excel),  440–441
Columns dialog box,  273
columns (Excel)

adding to data sources,  455
adding to tables,  413
controlling calculated columns,  420
copying from hidden,  486
formatting options,  416
freezing,  404–405
header rows,  413
hiding,  401–402
locking into position,  404
in PivotTables,  459
preserving original sort order,  422
selecting,  361

Columns option (Page Layout tab),  272–273
columns (Publisher),  792–793
columns (Word documents)

changing layouts in sections,  271
column breaks,  225, 233, 273
creating multicolumn layouts,  272–273
formatting in documents,  270–273
selecting text by,  237

columns (Word tables)
adding and removing,  287
adjusting widths,  285–286
changing default number of,  276
controlling widths,  276
keyboard shortcuts,  279
removing,  287

COM Add-Ins dialog box,  40–41
Combine tool,  308
combo charts (Excel),  446
command groups

button launchers in,  59
customizing,  65–67
default,  65
icons representing commands,  67

commands
adding to Quick Access Toolbar,  70
in default groups,  65
dictating,  79
finding keyboard shortcuts,  73–74
icons representing,  67
rearranging,  67
rearranging on Quick Access Toolbar,  70

circular references,  418
Cleanup Tools menu,  585–586, 588
CLEAN worksheet function,  384
Clear All Formatting option (Home tab),  240
ClearType Font Collection,  597
clickable regions,  88
Click-to-Run program

installing Office 365,  201
Office On Demand and,  206–207
process overview,  28–32
product keys,  29–30
updating Office,  38–39
Windows Installer vs.,  30, 31

Clip Art,  137
Clipboard

copying current window to,  147
copying graphics and pictures,  142
copying to,  78, 97–98
displaying content,  99
keyboard shortcuts,  97
launching in Excel,  145
linking to specific paragraphs,  741
linking worksheet data to chart elements,  455
moving graphics and pictures,  142
multiple clippings,  101–103
restoring portions of documents,  182
text translations,  114
transforming data,  397–398

clippings
capturing in OneNote,  147
multiple,  101–103
window images,  146

Close Header And Footer option (Design tab),  245
Close option (Backstage view),  50
closing

calendars,  540
files,  50–51
OneNote,  754

cloud-based storage. See SkyDrive
clustered column charts (Excel),  440, 455
collapsing

detailed PivotTable data into subtotals,  465
filter list entries,  426
headings in documents,  269
notebook pages,  702
notebook section groups,  702
Outline view in documents,  227, 267
the ribbon,  58

collated printing,  480
colon (:),  361, 365, 375, 565
color

adjusting,  133
applying shape styles,  141
applying to theme elements,  150–151
background,  216, 240, 726
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keyboard shortcuts,  501
LinkedIn support,  517
linking to OneNote pages,  759–760
managing data files,  519
merging,  591
OneNote notebooks and,  716
organizing,  504–505, 541–544
searching for,  546
sharing,  597–598
viewing,  542, 544–545

Contacts template,  824
content controls

converting text in,  244
cover pages,  347

Content With Caption slide layout,  613
context-sensitive ribbon tabs,  58–59, 64
contiguous range (cells),  361
continuous section breaks,  271, 273
Control Panel

date and time formats,  394
managing fonts,  96, 696
managing Outlook profiles,  507–508
Region And Language dialog box,  112
specifying units of measure,  126
uninstalling Office,  43
virtual printers,  717
Windows Update,  39

Conversation-ID property,  576
Conversation view (Outlook),  17, 575–577
Convert button,  48
converting

data into charts,  436–456
date and time to serial values,  382, 394
documents,  214
Excel cell ranges into tables,  411–421
formulas to values,  470
handwriting-to-text,  715
OneNote notebook formats,  705
printouts and pictures to text,  782
scientific format to decimal equivalent,  395
text in content control,  244
text to tables,  277–278
text to WordArt,  148
Word outlines to PowerPoint presentations,  614

Convert Text To Table dialog box,  277
CONVERT worksheet function,  388–389
Copy command,  97
copying

current window to Clipboard,  147
data from hidden worksheet columns/rows,  486
data in Excel cells,  365–370
Excel cells from above,  397
graphics and pictures,  142
notebook pages,  722
Outlook items,  580

renaming within custom groups,  67
ScreenTips,  73

comments
adding to presentations,  677–679
inserting with Read Mode,  217
review,  298–303, 677–679
troubleshooting,  679

Compare Documents dialog box,  308–309
Compare tool,  308, 679
comparing presentations,  679–680
comparing versions

of documents,  182
of presentations,  679–680

comparison operators,  373–374, 377
Comparison slide layout,  613
compatibility

add-ins and apps,  41
add-ins under 64-bit editions,  27
DirectX,  27
file formats,  162–163, 165–166
video and audio files with viewers,  671
Word document versions,  48, 166, 213–214

Compatibility Mode,  48, 166, 213–214
compressing files,  630
CONCATENATE function,  469
concatenation operator,  374–375, 377, 469
concordance files,  297
conditional formatting,  428–435, 476
Conditional Formatting menu

Color Scales option,  432
Data Bars option,  431–432
Highlight Cells Rules option,  430–431
Icon Sets option,  432
Top/Bottom Rules option,  431

Conditional Formatting Rules Manager dialog box,  433–434
conditions, specifying for rules,  555–560
CONFIDENCE.NORM worksheet function,  387
CONFIDENCE.T worksheet function,  387
CONFIDENCE worksheet function,  387
confidential and personal information,  163–164, 174–175
Conflicts folder,  586
constants,  362, 370
contact cards,  542–543
Contacts folder,  541–542, 546, 598, 760
contacts (Outlook)

about,  504
address books,  541, 546–549
as data source for mail merge,  335
changing sort order,  545
creating from email,  504
docking in To-Do Bar,  569–571
duplicate,  584, 590–592
editing,  544–545
filtering,  504
follow-up flags,  577
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Customize Status Bar menu,  72
customizing

Access views,  831
address books,  549
animation effects,  649
AutoCorrect,  55
bulleted lists,  698
calendar views,  535
cell formats,  390, 472–476
cell styles,  476–477
color mapping,  666
command groups,  65–67
data series,  486
default templates,  170–171
filters,  426
handout masters,  689
keyboard shortcuts,  73–74
master views,  689
notebook pages,  725–728
notes masters,  689
number formats,  472
Office installations,  40–42
OneNote interface,  729–731
OneNote taskbar icon,  780–781
Open dialog box options,  161–162
Outlook Folder pane,  571–572
Outlook folder views,  573–575
Outlook interface,  569–577
PivotTable layouts,  462–466
PowerPoint slide master,  686–687
presentation design,  634–638
presentation slide layouts,  688–689
Quick Access Toolbar,  68–71, 185, 345–346
Recent list settings,  157
the ribbon,  6, 63–68, 185
Save As dialog box options,  160–161
search folders,  568
security settings,  176
shortcut to linked Outlook items,  762
slide masters,  686–687, 689
slide shows,  683–685
spelling checker options,  55, 108–111
status bar,  71–72, 346
tabs,  63–68
tags,  736–738
themes,  151, 682
workbbooks,  457–459
worksheet views,  399–406

Custom Lists dialog box,  487
Custom Office Templates folder,  171
Custom Search Folder dialog box,  568
Custom Shows dialog box,  684
Custom Web App template,  830
Cut command,  98
cutting to the Clipboard,  98

slides,  616
tags,  738–739
text,  78, 97–98
text formatting,  96–97
worksheets,  357

copyright symbol,  84
Copy To My Calendar command,  540
corrupted or damaged files,  162–163, 173, 174
COS worksheet function,  387
COUNTA worksheet function,  387
COUNTBLANK worksheet function,  387
COUNTIFS worksheet function,  387
COUNTIF worksheet function,  387
COUNT worksheet function,  387
Cover Page option (Insert tab),  347
cover pages (documents),  347–348
Create New Building Block dialog box,  341–342
Create New Folder dialog box,  522
Create New Style From Formatting dialog box

Automatically Update option,  255
Font Color option,  255
Font option,  255
New Documents Based On This Template option,  256–257
Style Based On option,  254
Style For Following Paragraph option,  254
Style Type option,  254

Create PivotTable dialog box,  461
Create Rule dialog box,  557
Create Summary Page button,  751
Create Table dialog box,  411–412
Creative Commons licensing,  138
criteria (Outlook searches),  563–568
cropping

pictures,  130–132, 136
screen clippings,  147
troubleshooting,  258

Cross-Reference dialog box,  292–294
cross-references

about,  289
captions for equations, figures, tables,  291–292
defining targets,  290–291
as hyperlinks to targets,  293
inserting,  292–294
updating automatically,  289–290

.csv file extension
about,  359
mail merge wizard and,  335
Outlook and,  582
troubleshooting,  278

Currency format,  391, 393
Custom AutoFilter dialog box,  426–427
Custom dialog box,  578
custom dictionaries,  109–110, 185
Custom Dictionaries dialog box,  110
Customize Quick Access Toolbar menu,  478
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converting to serial values,  382, 394
custom cell formats,  474–475
data series within Excel cells,  366–367
filtering options,  426
inserting into documents,  225–226
Outlook shortcuts and abbreviations,  537
in search queries,  566
time stamps for notebook pages,  708
today’s date entered into Excel cells,  365
troubleshooting in worksheets,  382
worksheet cell formats,  393–394
worksheet functions involving,  381–384

Date format,  391
Date Navigator control,  532
Date & Time option (Insert tab),  225
DATEVALUE worksheet function,  383
DAYS worksheet function,  383
Day view in calendars,  534, 535, 537
DAY worksheet function,  382
.dbf file extension,  360
DBMS (database management system),  823–825
deactivating installations,  201
decimal-aligned tabs,  221
decimal places,  393
decks of slides,  610
Decrease Decimal button (Home tab),  392
Define Custom Show dialog box,  684–685
Define Name command,  362
Define New Number Format dialog box,  262
delaying email messages,  524–525
delays in animations,  646
Delete button (Review tab),  300
Delete Cells dialog box,  287
Deleted Items folder,  521, 586, 592
Delete It action,  559
deleting. See removing
delivering presentations,  656–660
deprecated functions,  387
Design Checker pane,  804
Design ribbon tab

Add Chart Element menu,  447–449
applying themes to documents,  150
Banded Columns option,  285, 416
Banded Rows option,  285, 416
Change Chart Type option,  440, 452
Change Colors menu,  447
changing chart appearance,  145
Close Header And Footer option,  245
customizing PivotTables,  467–469
Equation Tools option,  90–91
Filter Button option,  416
First Column option,  416
Header Row option,  284, 416
Last Column option,  416
managing fonts,  96

D
damaged or corrupted files,  162–163, 173, 174
Dark Gray theme,  47
data

converting into charts,  436–456
displaying with charts,  144–146
entering in Excel cells,  365–370
filtering in worksheets,  423–428
linking to Excel chart elements,  453–456
mail merge and,  331–339
organizing in Excel tables,  411–421
sorting in worksheets,  421–423
transforming with Clipboard,  397–398
validating,  490–494
in Word tables,  279–282

data analysis (Excel)
formatting cells based on content,  428–435
Quick Analysis tool,  408–411
sorting and filtering worksheet data,  421–428
in tables,  411–421
turning data into charts,  436–456
visualizing trends within cell ranges,  435–436

database management system (DBMS),  823–825
databases

about,  823
data in,  831–832, 834–835
forms in,  827, 836–837
macros in,  828, 839
modules in,  828, 839
queries in,  827, 835–836
reports in,  828, 838
tables in,  826–827, 830, 833–834
views in,  831

Data Execution Prevention,  172
data in databases,  831–832, 834
data series

as chart elements,  437
customizing lists,  486–488
filling in Excel cells,  365–370
pie chart options,  443
visualizing with sparklines,  435

Datasheet view,  831–832
data sources

linking to chart elements,  453–456
mail merges,  334–336

data stores,  155
Data Validation dialog box

accessing,  490
Error Alert tab,  493–494
Input Message tab,  492–493
removing validation rules,  494
Settings tab,  490–492

data-validation rules,  490–494
date and time

comparing,  374
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converting,  214
cover pages,  347–348
creating,  49–50, 221–226
cross-references in,  289–294
definition,  155
distributing,  312–316
drawing layers in,  116–128
editing. See editing documents
embedding videos in,  331
encrypting,  175, 315–316
equations in,  89
exporting,  52–53
field codes,  292
file formats supported,  165, 215–216
formatting,  14, 236–245
formatting columns and sections,  270–273
grammar checking,  263–264
graphics and pictures in,  115, 124–125, 128–129, 257–260
headings in. See headings (documents)
highlighting changes,  304–311
hyperlinks in,  87–89
indexes in,  296–298
inserting Excel worksheets into,  282, 284
inserting fields in,  336–338, 343–344
inserting video clips into,  329–331
jumping to last edit location,  230
keyboard shortcuts,  229–230
linking to notes,  765–769
Lorem ipsum text,  349
macros in,  171–172
mail merge and,  331–339
making global changes to documents,  250–252
multicolumn layouts,  272–273
in multiple windows,  74–75
navigating,  13, 212–213, 226–232, 268–269
numbered lists,  261–262
Office Web App support,  192–194
organizing,  177–180
page sizes,  211
printing as booklets,  348
Protected View,  173
reading text aloud,  346–347
read-only mode,  161, 181
recovery features,  14
restoring draft versions,  14
Resume Reading position,  185
review comments in,  298–303
rolling back changes,  14
rotating graphics and pictures,  124–125
ruler display,  212
saving in other programs,  167
searching,  13, 212, 232–236
sharing,  52–53
SkyDrive support,  189–194
SmartArt in,  142–144

new features,  14
Switch Row/Column button,  441
Total Row option,  284, 416

Desktop Asset Tracking template,  824
Desktop Contacts template,  824
desktop databases,  832–839
Desktop Issue Tracking template,  824
Desktop Project Management template,  824
Desktop Task Management template,  824
Details view (File Explorer),  178
Developer ribbon tab

features, tools, commands available,  60
initial configuration,  65

.dic file extension,  110
dictation (speech recognition),  79
dictionaries,  109–110, 185
.dif file extension,  359
digital rights management (DRM),  697
digital signatures,  175, 316
DirectX Diagnostic Tool,  27
Disable Linked Styles option (Home tab),  325
disabling

add-ins,  40
editing in Protected View,  172
features in Compatibility Mode,  214
linked-note taking,  768
Live Preview,  54, 62
Mini toolbar,  54
text recognition,  782

Discard Editing Data setting,  137
Display As field (Outlook contacts),  545
Display For Review button (Review tab),  306–307
distributing documents,  312–316
distributing graphic objects evenly,  122–123
division operator,  371, 377, 386
.doc file extension,  215, 216, 623
docking Outlook items in To-Do Bar,  569–571
.docm file extension,  215, 623
Document Inspector,  163–164, 174–175, 313–314
document properties

Advanced Properties option,  179
editing,  179
metadata and,  178
Show Document Panel option,  179
viewing,  48–49, 178–179

documents
about,  211–212
Author field,  160
automating with fields,  342–344
building blocks,  225, 339–342
bulleted lists,  261–262
charts in,  144–146
Clipboard content,  99
comparing versions of,  182
compatibility with earlier versions,  48, 166, 213–214
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Duarte’s Five Rules template,  617, 641
Due Date field (Outlook),  577, 579
duplex printing,  480
duplicate contacts,  584, 590–592
duplicating animations,  647
dynamic content transitions,  651

E
EAS (Exchange ActiveSync),  498, 515–516
e-book readers,  217
editing

account settings,  187
appointments,  535–537
audio clips,  632
contacts,  544–545
documents. See editing documents
email signatures,  592–593
graphics and pictures. See editing graphics and pictures
handout header and footer,  667
hyperlinks,  87–89, 742
meetings,  535–537
notebook pages,  724
PivotTables,  467–469
presentation handouts in Word,  667–668
presentation text,  604, 615–617
templates,  256–257
text. See editing text
video,  628–631

editing blogs,  329
editing documents

changing case,  224
date and time,  225–226
via dictation,  79
document properties,  179, 225–226
hyphenation control,  224–225
jumping to last edit location,  230
line break control,  224–225
with Office Web App,  193
Outline view when,  266–269
searching and replacing,  236
setting tabs,  221–223
shared documents in real time,  194–196
special characters,  223–224
tracking changes,  304–311

editing graphics and pictures
adjusting colors,  133
applying artistic effects,  133
applying picture styles,  134
concept overview,  129–130
cropping pictures,  130–132, 136
removing picture background,  135–136
undoing edits,  136

spelling checker,  107–108, 263–264
styles in,  245–256
tables in. See tables (Word)
tables of contents in,  294–296
templates. See templates
themes in,  150
thumbnail images,  160, 227
tracking changes,  304–311
working with views,  216–221, 250, 266–269

Documents folder,  155, 171, 582
.docx file extension,  155, 163, 215, 329, 623
Dodge, Mark,  436
DOLLAR worksheet function,  385
Do Not Disturb option,  814
.dot file extension,  215
.dotm file extension,  215
.dotx file extension,  170, 215
doughnut charts (Excel),  443
downloading

bootstrapper program,  28
with Click-to-Run installer,  29–32
email attachments,  529
email headers only,  529
Fix It tool,  43
Microsoft Office Compatibility Pack,  165
Office.com templates,  170
online presentations,  671, 673
PowerPoint Viewer,  675
updates,  38–39
volume license editions,  26
Windows Installer,  28

.dqy file extension,  360
Draft view (documents),  219, 250
dragging

cropping handles,  131
data source selections in charts,  456
Outlook items into folders,  580
resizing Excel tables,  418
slides to reorder,  603

drawing layers
concept overview,  116–117
grouping objects,  127–128
keyboard shortcuts,  118
positioning objects,  119–124
resizing graphics and pictures,  124–128
rotating graphics and pictures,  124–128
selecting graphics and pictures,  117–119
selecting text boxes,  117
selecting WordArt,  117

drawing tables,  276–277
Drawing Tools ribbon tab,  60
Draw Table tool,  287
DRM (digital rights management),  697
Drop Cap dialog box,  323–324
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embedding video clips,  329, 331
em dash,  233
.emf file extension,  623
emphasis effects for slide animations,  641
encryption

Outlook connections,  510, 513
Word documents,  175, 315–316

Encrypt With Password command,  315
en dash,  233
End Mode workbook navigation,  364
endnotes,  290
End Time field (Outlook),  593
engineering worksheet functions,  388–389
Enterprise edition,  24
Enter Your Product Key dialog box,  37
entrance effects for slide animations,  640–641
EOMONTH worksheet function,  373, 384
.eps file extension,  128
equal sign (=),  373, 377, 565
Equation Options dialog box,  90
Equation Tools Design tab,  90–91
Eraser tool,  287
error messages

arithmetic operators,  372
data validation,  493
Excel functions,  385, 386
file validation tests,  174
locking tracking changes,  311
macros in templates,  170
Outlook configuration,  510
Outlook connection failures,  526

Euro symbol,  393
events in Outlook,  533, 537–538
EVEN worksheet function,  388
Excel

blank templates,  156
Clipboard pane,  145
data analysis. See data analysis (Excel)
data charts,  144–146
entering data and data series,  365–370
file formats,  165, 358–360
font options,  54–55
formatting cells and ranges,  389–396
formulas and functions,  370–389
manipulating data,  396–399
new features,  14–15
Quick Analysis tool,  15
removing prominent features from View tab,  399–401
Starter edition,  11
subscription edition,  9
surveys,  189
tweaks and tips,  485–494
workbooks and worksheets. See workbooks and worksheets 

(Excel)
Excel 97-2003 Template,  458

editing text
Backstage view options,  50–51
boilerplate,  85–87
checking spelling,  106–110
with Clipboard,  97–103
in graphics or pictures,  117
keyboard shortcuts,  84–85
Protected View restrictions,  172
redoing changes,  84–85
repeating changes,  84–85
with speech recognition,  79
undoing changes,  84–85

Edit Quick Step dialog box,  552–554
Edit Series dialog box,  454
Edit Wrap Points command,  259
Effect Options dialog box,  648–649
effects. See specific effects
Effects tool,  633
email

archiving Outlook data,  587–590
attachments to,  218, 529, 566
automatic Microsoft accounts,  185
automating repetitive tasks,  17
cleaning up Outlook mailbox,  585–586
Conversation view,  17, 575–577
creating contacts from,  504
creating messages,  502, 523
delaying,  524–525
deleting conversations,  16
follow-up flags,  577
font changes,  596–597
formatting,  525
free Microsoft services,  184
managing messages automatically with rules,  555–560
managing with rules,  17
meeting invitations and,  503
moving messages,  556
in OneNote notebooks,  716
Outlook accounts,  509–518
Outlook data files and folders,  518–523
Outlook keyboard shortcuts,  501
Outlook view,  16
reading,  502
receiving,  523–525, 526–529
redundant messages in a conversation,  576–577
replying to,  502, 524
scheduling send/receive intervals,  527–528
sending,  523–525, 544
sending messages to OneNote,  758–759
sending OneNote page via,  765
signatures in,  592–593
synchronizing messages,  526–529
themes for messages,  597
turning messages into appointments,  536

embedding fonts in presentations,  696
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file and folder management
backup and recovery options,  180–182
bypassing Backstage view,  157
closing files,  50–51
compressing files,  630
corrupted or damaged files,  162, 163, 173, 174
creating files,  49–50
creating files with Office on Demand,  205
editing files,  50–51
exporting files,  50, 167–169
file formats. See file formats
importing files,  50
opening files,  50–51, 157–158, 161–162
organizing and finding,  177–180
Outlook files,  518–520, 585–586
Outlook folders,  520–523, 526, 571–572, 573–575, 580
permanently delete,  587
Protected View,  172–174
saving files,  50–51, 158, 160–161
search folders,  567–568
security features,  171–177
sharing with Office Web App,  194
storing files. See storing files
synchronizing SkyDrive files,  190–191
templates in document creation,  170–171
temporary folders,  584
viewing recently opened files,  156

File As field (Outlook contacts),  545
File Attachment tool,  716
File Block feature,  173
File Explorer

Details view,  178
navigation buttons,  159
Outlook data files and,  520
synchronization utility,  208
template files,  170

file formats. See also specific formats
audio,  697
binary,  162
compatibility,  162–163, 165–166
evolution of,  162–163
Excel,  358–360
exporting files to alternative,  167–169
Office Open XML,  163–164
OneNote,  705, 774
OneNote notebooks,  705
Outlook,  518–520
PowerPoint,  622–623
Publisher,  789
setting default,  164–165
video,  623, 674
Word,  215–216

file properties,  48
File ribbon tab,  6

Excel Macro-Enabled Template,  458
Excel Options dialog box

Advanced tab,  400
General tab,  356, 457

Excel Template,  458
Exchange

about,  498
Autodiscover service,  510, 514
configuring email accounts,  514–515
Contacts folder,  541
Mailbox Cleanup tool,  586
multiple accounts per profile,  507
synchronizing Outlook accounts,  521

Exchange ActiveSync (EAS),  498, 515–516
Exchange Server,  515, 548, 576
exciting transitions,  651
exit effects for slide animations,  641
exiting Protected View,  173–174
expanding

Excel tables,  418
headings,  269
notebook pages,  702
notebook section groups,  702
Outline view in documents,  227, 267
picture displays,  139
PivotTable data,  465

Exponential format,  395
exponentiation operator,  371, 377
exporting

documents,  52–53
files,  50, 167–169
Outlook data,  580–583

Export option (Backstage view),  46, 53, 674–675
Export pane (OneNote),  774

F
Facebook site

Microsoft accounts and,  184
notification example,  556
Outlook connections to,  517

Fade transition,  673
Favorites list,  567
F.DIST worksheet function,  387
FDIST worksheet function,  387
field codes (Word documents),  292, 297, 343
Field dialog box,  344
fields (Outlook),  545, 574–575
fields (Word)

about,  342
automating documents with,  342–344
inserting in documents,  336–338, 343–344
keyboard shortcuts,  343
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customizing,  571–572
hiding,  572
Search Folders link,  567

folders. See file and folder management
Folder Size dialog box,  586
Folder tab,  500
follow-up flags for Outlook items,  577–580
Font Color button,  318
Font dialog box

accessing,  94
Advanced tab,  322–323
All Caps option,  239
changing Normal style,  257
Hidden option,  240
keyboard shortcuts,  322
listing installed fonts,  96
Preview box,  323
Small Caps option,  239
Text Effects option,  319

Font Embeddability property,  696
fonts

All Caps format,  239
applying to theme elements,  151
changing for email messages,  596–597
embedding in presentations,  696
formatting with table styles,  414–415
Hidden format,  240
hiding,  96
licensing restrictions,  696
ligatures,  320–323
managing,  95–96
Office Web App capabilities,  192
previewing,  61
Publisher font schemes,  801–802
setting default,  54–55
Small Caps format,  239
stylistic sets,  321–322
substituting,  239

Footer option (Insert tab),  244
footers. See headers and footers
footnotes,  290
Format As Table dialog box,  411
Format Axis pane,  451–452, 454
Format Axis Title pane,  451
Format Background pane,  637–638
Format Cells dialog box

about,  389–390
accessing,  390
Border tab,  471
currency formats,  393
date and time formats,  394
number formats,  385
Number tab,  463, 472
overriding cell formatting,  391
precision in numbers,  395

Fill Across Worksheets dialog box,  399
fill effects

applying to theme elements,  151
shapes,  141
text,  148, 318

filling
blanks with default values in functions,  389
data series with data,  365–370
OneNote notebooks,  706–717

Fill option (Home tab),  365–367
Filter Button option (Design tab),  416
Filter dialog box,  582–583
Filter Email menu,  568
filtering

address book contents,  547
customizing,  426
data in worksheets,  423–428
document searches,  159
Outlook contact list,  504
Outlook searches,  561
PivotTables,  467

financial worksheet functions,  380
Find And Replace dialog box

about,  104–106
accessing,  229
Find tab,  235, 396
including formatting in searches,  235
keyboard shortcuts,  105, 396–397
repeating searches,  235
Replace tab,  104–105, 236

Find command,  103–106, 235
FIND function,  469
finding and replacing

text,  103–106
text formatting,  103–106

finding and searching. See searches
Find Options dialog box

Find All Word Forms option,  234
Sounds Like option,  234

Find & Select menu,  485
Find Tags button,  749
FINV worksheet function,  387
First Column option (Design tab),  416
First Time Setup dialog box,  551
Five Rules template,  617, 641
FIXED worksheet function,  385
Fix It tool,  43
flags for follow-up in Outlook,  577–580
Flash files,  627
Flickr site,  184, 187
Fly In entrance effect,  642–643
Folder List view (Outlook),  586
Folder pane (Outlook)

about,  541
creating folders,  522
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ribbon tools,  59
sections,  270–273
text. See text formatting
Word tables,  283–285

Formatting Restrictions dialog box,  251
forms (Excel),  488–489
forms in databases,  827, 836–837
Formula dialog box

ABOVE range name,  282
BELOW range name,  282
LEFT range name,  282
Paste Function list,  281
RIGHT range name,  282

formulas (Excel)
about,  370–371
adding functions to,  377–389
adding to tables,  418–421
assigning names to,  362
AutoSum tool,  372
concatenating text,  374–375
constants in,  370
controlling order of operations,  377
converting to values,  470
creating,  371–373
Excel formats,  391
functions and. See functions
hidden worksheets and,  358
keyboard shortcuts,  372
operators in,  361, 370–375, 377. See operators in formulas
references in,  370, 375–377
substituting names for,  373
troubleshooting,  383
worksheet names and,  357

formulas (Word tables)
about,  281–282
inserting fields into,  282
keyboard shortcuts,  282
recalculating,  282

FORMULATEXT worksheet function,  386
forward slash (/),  371, 377
Fraction format,  395
Freeze Panes menu (View tab),  405
freezing worksheet rows and columns,  404–405
F.TEST worksheet function,  387
FTEST worksheet function,  387
Full Name field (Outlook),  591
Full Name field (Outlook contacts),  545
Full Page view (OneNote),  729
Full Screen Reading view,  217–218
Function Arguments dialog box,  378–379
functions

about,  370
adding to formulas,  377–379
arguments in,  370

setting format options,  392
special formats,  396
text formats,  396
troubleshooting,  417
viewing serial date value,  382

Format Legend pane
Legend Options tab,  450
Text Options tab,  450

Format Painter,  96–97, 142
Format Picture pane

cropping pictures,  131–132
positioning objects,  121–122
rotating objects,  126

Format Picture tools,  59
Format Shape pane

about,  120–121
specifying rotation angles,  126
viewing text effects,  149

Format tab
accessing Selection pane,  118
adding SmartArt to documents,  143
adjusting color,  133
applying picture styles,  134
applying shape styles,  141
changing chart appearance,  145
cropping pictures,  130–131
grouping objects,  127
removing picture backgrounds,  135
Rotate tool,  125

Format Text Effects pane,  319
Format Text tab (Outlook),  103
formatting. See also styles; themes

character,  93–94, 237–238, 717
chart axes,  451
columns,  270–273
conditional,  428–435, 476
date and time,  225
displaying formatting marks,  243
documents,  14, 236–245, 270–273
email messages,  525
Excel cells and cell ranges. See cell formats (Excel)
Excel tables,  414–417
Excel worksheets,  470–477
graphics and pictures,  142
including in searches,  235
inheritance,  81
multiple pictures simultaneously,  794
new features,  5
Office Web App capabilities,  192
paragraphs,  241–243, 283
PivotTables,  467–469
preventing changes to,  251
publication pages,  797–800
Quick Analysis tool options,  409, 429–430
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in charts,  144–146
converting to text,  782
copying,  142
creating captions for,  291–292
creating photo albums,  690–692
in documents,  115, 128–129, 257–260
in drawing layers,  117–119
drawing layers in documents,  116–128
editing. See editing graphics and pictures
formatting,  142
hot spots,  695
in-line with text,  257–258
inserting in Publisher,  794–795
keyboard shortcuts,  118, 124–125
moving,  142
multiple,  118–119
navigating to numbered items,  229
new features,  7
Office Web App capabilities,  192
in OneNote notebooks,  712–713
online pictures,  137–139
in Outline view,  266
as reference targets,  291
resizing,  124–128
rotating,  124–128
scanned images,  714–715
screenshots,  146–148
in shapes,  139–142
styles for,  134
swapping pictures,  794
in text boxes,  139–142
text effects with WordArt,  148–149
with text wrapping,  129, 258–259
themes for,  149–152

grayscale printing,  636, 665
greater than or equal to sign (>=),  373, 377
greater than sign (>),  373, 377, 565
Grid And Guides dialog box,  625
gridlines

Excel,  399, 437, 471, 484
notebook pages,  727
PowerPoint,  625
publication pages,  798–799
Word tables,  274–275, 285–286

Groove utility,  3
grouping

in graphics and pictures,  127–128
Outlook fields,  574–575
tags,  750
troubleshooting,  128

GUID (globally unique identifier),  742
guillemets,  338

built-in
date and time,  381–384
engineering,  388–389
financial,  380
information,  389
logical,  385–386
lookup,  386
math,  387–388
reference,  386
statistical,  386–387
text,  384–385
trigonometry,  387–388

deprecated,  387
filling blanks with default values,  389
manipulating text with,  469–470
nested,  370

G
galleries. See also specific galleries

adding shapes,  139–141
adding to Quick Access Toolbar,  63
adjusting colors,  133
animations,  641
applying artistic effects,  133
applying multiple attributes,  93
applying shape styles,  141
inserting symbols,  80
live previews and,  61–63
mathematical equations,  89, 91
placeholder types,  688
SmartArt-related,  143
table,  279
transitions,  650

General number format,  391
.gif file extension,  128, 623
globally unique identifier (GUID),  742
glow effects,  318
Glow gallery,  319
Gmail

about,  498
coordinating meetings between systems,  537
Microsoft accounts and,  185
Outlook and,  516
troubleshooting IMAP accounts,  522

Google Apps,  498, 516
Go To command,  229, 301
Go To dialog box,  485–486
Go To Special dialog box,  486
grammar checking,  263–264
graphics and pictures. See also SmartArt graphics

adding to presentations,  623–625
background images,  727–728
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worksheet rows and columns,  401–402
worksheets,  358

highlighting
changes in Word documents,  304–311
Excel cells based on content,  428–435
important notes in notebooks,  733–739
online presentations and,  673
searching for highlighted text,  235
text,  715
with Text Highlight Color tool,  240

HLOOKUP worksheet function,  386
holidays on calendars,  539
Home and Business edition,  11, 25
Home and Student edition,  10, 25
Home Premium edition

accessing account,  198–200
My Account page,  201
subscription plan,  10, 23

Home ribbon tab
about,  500
accessing Selection pane,  118
Bullets tool,  261
character formatting,  94
Clear All Formatting option,  240
copying formatting,  96
Decrease Decimal button,  392
Disable Linked Styles option,  325
displaying Clipboard pane,  145
features, tools, commands available,  60
Fill option,  365–367
finding and replacing text,  103
Find & Select menu,  485
Font Color button,  318
Format As Table option,  414
Increase Decimal button,  392
Line And Paragraph Spacing tool,  242
managing paragraph formatting,  241
Multilevel List tool,  262
New Note button,  506
Number Format list,  396
Numbering tool,  261
Orientation button,  471
Outlook views,  501
paragraph formatting,  94
Shading tool,  240
Sort & Filter option,  421
Styles gallery,  93, 245–248, 252, 254
Text Effects And Typography option,  318, 322
Text Highlight Color tool,  240

Honeycomb transition,  651
Hotmail. See Outlook.com (Hotmail)
Hotmail Connector (Outlook),  515
hot spots,  695
HOUR worksheet function,  382, 383
.htm file extension,  215, 359, 623

H
handout masters,  609, 689
Handout Master view (PowerPoint),  609
handouts (presentation)

editing header and footer,  667
editing in Word,  667–668
Handout Master view,  609
Notes Page view,  607–608
printing,  664–666

handwriting-to-text conversion,  715
Header And Footer dialog box,  635, 667
Header option (Insert tab),  244
header records,  335
Header Row option (Design tab),  284, 416
header rows (Excel)

automatically assigning,  413
detecting,  412
viewing when scrolling,  414

headers and footers
about,  243
PowerPoint presentations,  635–636
presentation handouts,  667
publication pages,  800
in sections,  270
Title property,  244
variable text in,  243–244
Word documents,  243–245

headers (Outlook messages),  529
headings (documents)

collapsing or expanding,  269
linked styles and,  324
navigating via,  226–227, 268–269
as reference targets,  290
run-in,  324

headings (Excel worksheets),  484
headings (PivotTable),  459–460
Headings tab (Navigation pane),  226–227, 232
heading styles,  266–267, 718
Hidden format (fonts),  240
Hide Page Title button,  726
hiding

audio icon,  698
docked views,  570
field codes,  297
Folder pane,  572
fonts,  96
formatting marks,  243
Inking tool markup,  305
PowerPoint panes,  605
presentation slides,  683–684
Quick Access Toolbar,  58, 69
the ribbon,  58
ribbon tabs,  65
text,  240, 269
values in Excel charts,  446
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indents
creating outlines with,  718
setting with ruler,  241
text with tabs,  223

Index dialog box,  297–298
indexes (documents)

about,  296
generating,  297–298
marking index entries,  296–297
multilevel,  297

{INDEX} field code,  298
Info option (Backstage view)

compatibility checker feature,  166
Compress Media option,  630
Inspect Document option,  174–175, 312–313
Protect Document button,  314–316
viewing document properties,  48–49

Information Rights Management (IRM),  175, 316
information worksheet functions,  389
INFO worksheet function,  389
inheritance

formatting,  81
sections and,  271

ink objects,  714–715
in-line graphics,  257–258
In-Reply-To property,  576
Insert A Comment command,  346
Insert Audio dialog box,  631
Insert Caption option (References tab),  291, 292
Insert Chart dialog box

about,  144
All Charts tab,  439
Recommended Charts tab,  438

Insert Endnote tool,  291
Insert Footnote tool,  290
Insert Function dialog box,  377–379
Insert Greeting Line dialog box,  337
Insert Hyperlink dialog box

Bookmark option,  89
Create New Document option,  88
E-Mail Address option,  88
Existing File Or Web Page option,  88
Place In This Document option,  88
ScreenTip option,  89
Target Frame option,  89
Text To Display option,  89

Insert Index option (References tab),  297
insertion point

copying text formatting,  96
definition,  77
entering Word table formula at,  281
inserting section breaks,  270
keyboard shortcuts,  78
moving,  78
paragraph styles and,  248

.html file extension,  215, 359, 623
HTML format

about,  215
editing blogs in,  329
embedding videos,  330
Open dialog box option,  162
Outlook email messages,  525
saving output to,  167, 359

hyperlinks
action buttons and,  692–695
adding to presentations,  692
adding to slide shows,  692
cross-references as,  293
editing,  742
in email signatures,  592
entering,  87–89
in Outlook notes,  506
removing,  742
to webpages or files,  740–741

hyphens,  224–225, 233, 422

I
iCalendar format,  597–598
icons

OneNote tags,  733
representing commands,  67
representing comments,  678

IFERROR worksheet function,  386
IFNA worksheet function,  386
IF worksheet function,  385
images. See graphics and pictures
IMAP Folders dialog box,  529
IMAP (Internet Message Access Protocol)

about,  498–499
connecting accounts to Outlook,  510–514, 516, 526–529
losing non-email data,  520
managing folders,  520, 522
troubleshooting,  522, 576

IM (instant-messaging) programs,  808–809, 812–815. See 
also Lync

Import And Export Wizard,  580–583
Important tags,  733
importing

files and settings,  50
Outlook data,  580–583
temporary folders for,  584

Inbox folder
about,  521–523
Conversation view,  575–576
downloading headers only,  529
managing with rules,  555–556
restrictions moving,  589

Increase Decimal button (Home tab),  392
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on multiple computers,  29
from physical media or installer file,  32–36
removing selected applications,  34
retaining previous versions,  33–34
selecting components,  33–36
system requirements,  26–27
uninstalling,  43
updating regularly,  38–39

instant-messaging (IM) programs,  808–809, 812–815. See 
also Lync

Internet Message Access Protocol (IMAP)
about,  498–499
connecting accounts to Outlook,  510–514, 516, 526–529
losing non-email data,  520
managing folders,  520, 522
troubleshooting,  522, 576

Internet service providers (ISPs),  511–513
intersection operator,  375
INT worksheet function,  388
invitations to meetings,  503, 536–537
Invite Attendees button,  503
.iqy file extension,  360
IRM (Information Rights Management),  175, 316
ISBLANK worksheet function,  389
ISERROR worksheet function,  389
ISNA worksheet function,  389
ISPs (Internet service providers),  511–513
Issue Tracking template,  824
Italic tool,  717

J
journal entries (Outlook),  506
.jpg file extension,  128, 623
jumping

between locations in OneNote,  741
to last edit location when opening documents,  230
to PowerPoint slides,  603
to specific presentation slides,  692
to worksheet cells,  362

Jump List (Word),  328

K
keyboard shortcuts

address books,  546
applying styles,  249, 267
Apply Styles task pane,  248
break characters,  225
calendars,  534
character codes,  80, 83
Clipboard-related,  97
column breaks,  273
commands,  73–74

positioning,  77
Search Contacts box,  546
text boxes,  117

Insert Merge Field dialog box,  336–337
Insert New Equation command,  90
Insert New Pictures dialog box,  691
Insert Page dialog box,  797
Insert Pictures dialog box,  128, 137–138, 698
Insert ribbon tab

adding SmartArt to documents,  142
adding text boxes,  139–141
capturing screen clippings,  147
Chart option,  116
Cover Page option,  347
Date & Time option,  225
displaying data graphically with charts,  144
entering hyperlinks,  88
entering symbols,  80
features, tools, commands available,  60, 115
finding online pictures,  137
Footer option,  244
Header option,  244
inserting pictures,  128
inserting screenshots,  146
inserting shapes,  139
Insert option,  475
Online Pictures option,  115, 187
Pictures option,  115, 794
Screenshot option,  116
Shapes option,  116
SmartArt option,  116
Symbol option,  223
Table option,  275–277, 279, 282, 411
Text Box option,  116
WordArt option,  116, 284

Insert Space command,  723–724
Insert Symbol command,  80
Insert Table dialog box

accessing,  275, 632–633
AutoFit Behavior option,  276
Remember Dimensions For New Tables option,  276

Insert Video dialog box
accessing,  329, 626–627
Bing Video Search option,  329–330
From A Video Embed Code option,  330
SkyDrive support,  330

Inspect Document button,  174–175, 313–314
Inspect Document command,  164
inspecting

document properties,  48
personal and confidential information,  163–164, 174–175

installing Office. See also Setup program; upgrading Office
from Click-to-Run installer,  28–32, 201
customizing installation,  33–34, 40–42
identifying installed Office editions,  12
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window management,  232
Word table data,  279–280
workbooks and worksheets,  357, 363–364
zoom controls,  719

Key Management Service (KMS),  38
keywords,  565–566, 744, 748
KMS (Key Management Service),  38

L
labels

chart elements and,  453–456
Excel charts,  437–438, 442
mailing,  331–332

languages
assigning to dictionaries,  110
setting options,  112–113
translating text to other,  113–114

laser pointer
online presentations and,  673
turning mouse into,  660
video clips and,  674

Lasso Select tool,  715
Last Column option (Design tab),  416
launchers (ribbon command groups),  59
Layout dialog box

accessing,  126
Position tab,  120, 260

Layout Guides dialog box,  797–799
layouts. See also page layout

changing for Excel charts,  447–453
changing for Word tables,  285–289
creating for PivotTables,  460–462
customizing for PivotTables,  462–466
multicolumn,  272–273
placeholders in,  624
presentation handouts,  609
presentation slides,  611–613, 688–689
Publisher layout guides,  798–800

leader characters,  222
left-aligned tabs,  221, 222
LEFT function,  469
legacy add-ins,  40
legends in charts,  437
LEN function,  470
less than or equal to sign (<=),  373, 377
less than sign (<),  373, 377, 565
licensing agreements

Creative Commons,  138
new features,  4
perpetual licenses,  22–23
volume license editions,  11

Light Screen effect,  7–8
Line And Paragraph Spacing tool,  242

comments,  299
copying cells,  397
copying current window to Clipboard,  147
copying graphics formatting,  142
copying text,  98
customizing,  73–74
deleting text,  79
displaying AutoCorrect menu,  87
document views,  220
editing text,  84–85
Excel cells,  365
Excel tables,  411
field codes,  292, 297
fields,  343
Find And Replace dialog box,  105, 396–397
finding and replacing text,  103–105
Font dialog box,  322
formatting marks,  243
formatting paragraphs,  242
formatting text,  93, 95, 97, 238
formulas,  282, 372
Go To command,  301
heading styles,  718
indenting,  718
indexes,  298
jumping to last edit location,  230
legacy,  74
marking index entries,  296
menu selections,  73
moving insertion point,  78
moving text,  98
navigating around documents,  229–230
notebook pages,  722, 724
number formats,  391–392
OneNote,  506, 717, 729
opening files,  157
outlines,  268
Outlook,  501, 506, 527, 534, 546
pasting text,  97, 100
printing,  478
Publisher,  796
resizing graphics and pictures,  124
ribbon,  58
rotating graphics and pictures,  125
saving files,  157
screen clippings,  713
searching within documents,  232
selecting graphics and pictures,  118
selecting text,  237
slide shows,  656, 683
SmartArt,  143
Styles pane,  248, 325
symbols and special characters,  82
thesaurus,  111
undoing changes,  84, 136
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M
macros

in databases,  828, 839
definition,  171
enabled in templates,  170
Outlook message-handling,  17
Protected View restrictions,  174
security considerations,  171–172

Mailbox Cleanup dialog box,  585–586
Mail Editor (Outlook),  56
Mailings ribbon tab

Check For Errors option,  338
Envelopes or Labels option,  331–332
Finish & Merge tool,  338–339
hiding,  65
inserting merge fields,  338
mail merge process steps,  334
Start Mail Merge option,  332

mail merge
about,  331–332
connecting data files to documents,  334–336
inserting data fields into documents,  336–338
mail merge wizard,  332–334
performing,  338–339
previewing output,  338
Publisher support,  804

Mail Merge Recipients dialog box,  335–336
Mail Setup dialog box,  507
Mail view (Outlook)

about,  502
accessing,  16
default,  520–521
docking peeks in,  570–571
Folder pane,  571–572
New Email command,  501

MAK (Multiple Activation Key),  38
malware,  172
Manage Quick Steps dialog box,  17, 554
Manage Styles dialog box,  251, 253
margins

changing for sections,  271
Excel worksheets,  480
notebook pages,  728
presentation slides,  611
publication pages,  797–799
Word documents,  243

Mark As Final command,  315
Mark Index Entry dialog box,  296
master pages (Publisher),  800–801
master slide templates,  608
master views (PowerPoint),  608–609, 689
mathematical equations

adding to OneNote notebooks,  715
AutoCorrect feature,  92
creating captions for,  291–292

line breaks,  224–225, 233
line charts (Excel),  437, 442
Line Color menu,  471
line numbers,  262
Line Numbers option (Page Layout tab),  262
line spacing,  242–243, 258
Line With Text positioning style,  120, 129
Link command (OneNote),  89, 740–741
LinkedIn site

Microsoft accounts and,  184, 187
Outlook and,  517, 542

Linked Notes feature,  765–769
linked styles,  324–325
linked text boxes,  793
linking. See also hyperlinks

appointments to OneNote,  761–762
Contacts folder to OneNote,  760
data to Excel chart elements,  453–456
meetings to OneNote,  761–762
notes to documents and webpages,  765–769
Outlook contacts to OneNote pages,  759–760
Outlook tasks to OneNote,  762–765

lists
bulleted,  261–262, 604–605, 698, 709–710
numbered,  261–262, 709–710
in OneNote notebooks,  709–710
tables and,  411

List view (Access),  831
List view (Outlook),  573–574
Live.com domain,  498, 515
Live Preview

disabling,  54, 62
documents with themes applied,  150
galleries and,  61–63
paste options,  99–101
PowerPoint presentations,  637
previewing styles,  246
previewing themes,  250
text effects,  148

locking worksheet rows and columns,  404
logical worksheet functions,  385–386
lookup worksheet functions,  386
looping presentations,  654–655
=lorem() command,  349
Lorem ipsum text,  349
LOWER worksheet function,  384
Lync

about,  20, 787, 807–810
configuring options,  810–812
displaying menu full time,  811
instant messaging and presence,  812–815
online presentations and,  674
screen sharing and whiteboarding,  817–821
Skype support,  807
subscription edition,  9
telephony and videoconferencing,  816–817
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Midsize Business edition,  24
Mini toolbar,  54, 92–93, 709
Mini Translator,  113–114
minus sign (–),  371, 377, 565
MINUTE worksheet function,  382
MIN worksheet function,  387
mixed range references,  375–377
Modify PivotTable Style dialog box,  469
Modify Style dialog box,  249, 285
Modify Table Style dialog box,  416–417
modules in databases,  828, 839
Month view in calendars,  532, 537
MONTH worksheet function,  382
motion path slide effects,  641
mouse

removing text,  78
rotating graphics and pictures,  124–125
selecting text,  237
turning into laser pointer,  660

mouse click actions,  694
mouse over actions,  694
mouse pointer

definition,  77
positioning objects,  119

Move Chart dialog box,  452
Move Or Copy dialog box

Before Sheet list,  357
Create A Copy option,  357
To Book list,  357

Move Or Copy Section dialog box,  720–721
moving

command groups between tabs,  65
data in Excel cells,  365–370
email messages,  556
Excel charts,  453
graphics and pictures,  142
insertion point,  78
notebook sections,  705
page breaks,  482
Quick Access Toolbar,  69
stacked objects,  123
text without using Clipboard,  98
worksheets,  357

.mp3 file extension,  697

.mp4 file extension,  623, 674
MSN Mail,  498, 515
.mhtl file extension,  623
multicolumn layouts,  272–273
multilevel indexes,  297
Multilevel List tool,  262
multiple accounts per profile,  16, 585
Multiple Activation Key (MAK),  38
multiple animations assigned to objects,  639
multiple calendars,  538–540
multiple clippings,  101–103

entering,  89–92
in OneNote notebooks,  705
as reference targets,  291

math worksheet functions,  387–388
MAX worksheet function,  387
.mdb file extension,  360, 832
.mde file extension,  360
measurement units,  126
Me control,  183
MEDIAN worksheet function,  387
meetings

about,  503
coordinating between systems,  536–537
Copy To My Calendar command,  540
creating,  535–537
editing,  535–537
invitation management,  503, 536–537
linking to OneNote,  761
Lync web meetings,  809
OneNote notebooks and,  716
Outlook keyboard shortcuts,  501
reminders for,  579
scheduling,  503
time zones and,  593–595
turning appointments into,  503

menu selection via keyboard shortcuts,  73
Merge Cells tool,  287
{MERGEFIELD} field code,  338
Merge Into Another Section command,  720
Merge To Printer dialog box,  339
merging

documents and data with mail merge,  331–339
notebook sections,  720
Outlook contacts,  591
presentations,  679–680
Publisher data,  802–804
Word table cells,  287

messages. See also email; error messages; warning messages
metadata,  178
.mht file extension,  215, 359, 623, 774
.mhtl file extension,  215, 359
Microsoft accounts

automatic,  185
editing profile settings,  187
free services provided,  184, 189
online presentation feature,  670
reentering credentials,  186
sharing notebooks,  770
SkyDrive support,  190, 191

Microsoft Office Compatibility Pack,  165
Microsoft OneNote Section format,  704
Microsoft OneNote Table Of Contents format,  704
Microsoft Outlook Address Book dialog box,  549
Microsoft products. See specific products
MID function,  469
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New... command,  345
New Comment option (Review tab),  299
New Email command,  501
new features

Backstage view,  6–7
Excel,  14–15
formatting options,  5
graphics,  7
OneNote,  19–20
Outlook,  15–17
photographs and pictures,  7
PowerPoint,  18
Quick Access Toolbar,  5
Quick Analysis tool,  15
the ribbon,  5–6
upgrade options,  4
video clips,  18
Word,  13–14

New Formatting Rule dialog box,  433
New Meeting command,  501, 535–536
New Name dialog box,  373
New Note button,  506
New option (Backstage view),  49–50
New option (OneNote),  50
New Search Folder dialog box,  567–568
New Style dialog box,  791
New Table Style dialog box,  416
New Window command,  230
Next button (Review tab),  300
NirSoft PstPassword utility,  583
nonbreaking hyphens,  225, 233
nonbreaking spaces,  225, 233
noncontiguous dates in calendars,  535
noncontiguous range (cells),  361
Normal style,  257
Normal view (OneNote),  729
Normal view (PowerPoint),  602–604, 606
Notebook Properties dialog box,  703–704
Notebook Recycle Bin,  705, 724–725, 779
notebooks (OneNote)

about,  701–703
attaching files,  716
backup and recovery,  753–755
common tasks and activities,  703
converting formats,  705
creating,  703
filling with items,  706–717
formatting text,  717–719
highlighting important notes with tags,  733–739
moving between,  720
new features,  20
Notebook Recycle Bin,  705, 724–725, 779
opening,  50–51, 703, 720
pages. See pages (notebook)
password protection,  773

multiple computers, installing Office on,  29
multiple fields, grouping by,  574
multiple graphics and pictures,  118–119
multiple monitors for Presenter view,  655, 661
multiple windows

for documents,  230–232
managing,  74–75
Outlook,  573
synchronous scrolling,  75, 231, 309, 403

multiple worksheets,  354, 398–399
multiplication operator,  371, 377

N
Name field (Outlook contacts),  545
names

substituting for formulas,  373
worksheet cells and cell  ranges,  362–363

narration
recording,  653–654
video clips and,  674

navigating
Backstage view,  46–47, 50–51
calendars,  500
documents,  13, 212–213, 226–232, 268–269
File Explorer,  159
Go To command,  229
with Go To dialog box,  485–486
via headings in documents,  226–227, 268–269
notebook pages,  722–723, 724
to numbered items,  229
Office 365,  203
OneNote,  719–725
Outlook,  499–500
presentation slides,  694
in Presenter view,  662–663
slide shows,  656–659
workbooks and worksheets,  360, 364
via worksheet tabs,  356

Navigation pane
Access,  825, 833
Backstage view,  46–47, 50–51
Headings tab,  226–227, 232
jumping to PowerPoint slides,  603
Pages tab,  227–229
reviewing comments,  300–301
Search Document box,  13, 232
Word,  13, 212–213, 218, 268–269
Word tweaks and tips,  345

NA worksheet function,  389
negation operator,  371
nested functions,  370
New Address List dialog box,  335
New Appointment command,  501, 535–536
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Office. See also specific editions
32-bit and 64-bit editions,  27, 38
activating,  23–24, 36–38
determining installed edition,  12, 38
disconnecting from the web,  185
installing. See installing Office
licensing,  4, 11, 22–23
Me control,  183
new features,  4–8
Office 365 working together,  197–198
retail editions,  10–11, 25
signing in,  183–188
SkyDrive support,  190
subscription editions,  4, 9–10, 22–24
synchronizing settings,  184–185
uninstalling,  43
upgrading,  4, 21–26
volume-license editions,  11, 26

Office 365 subscriptions. See also specific editions
activating trial editions,  36–37
configuring email accounts,  514–515
Contacts folder,  541
Get Started page,  202
installing,  28
managing accounts,  199–204
new features,  4
Office on Demand feature,  205–207
Office support,  197–198
Outlook and,  497
reduced functionality mode,  38
signing in,  183–188
SkyDrive Pro support,  207–208
subscription plans,  4, 9–10, 22–24, 198, 202–204
uninstalling,  43

Office Background option (Backstage view),  47
Office Clipboard,  101–103
Office.com site

My Office page,  199–200
Office 365 plans,  198
template availability,  170

Office on Demand feature,  205–207
Office Open XML (OOXML) file format,  163–164. See 

also Open XML format
Office Presentation Service,  670
Office programs. See specific programs
Office Roaming Service,  184–185
Office Store,  41
Office Web App

about,  191–193
accessing,  8–9
editing documents,  193–194
rolling back changes,  193

offline, working
after Office installation,  30
Outlook and,  498, 518–520, 521, 527–528

printing,  717
saving,  704–705
searching,  702
searching by,  744–748
sections and section groups,  702, 705, 720–722
sharing,  769–773
synchronizing,  769–773

note containers,  706–707
not equal to sign (<>),  373, 377
notes

linking to documents and webpages,  765–769
OneNote-based,  506, 733–739, 749–751
Outlook-based,  506
PowerPoint-based,  607–608, 609, 663–664
printing,  773–776
publishing,  773–776
sharing,  773–776
troubleshooting,  765

notes masters,  609, 689
Notes Master view (PowerPoint),  609
Notes Page view (PowerPoint),  603, 607–608
notifications,  556–557, 812
NOT operator,  565
NOT worksheet function,  386
NOW worksheet function,  383
NPER worksheet function,  381
numbered items,  290
numbered lists,  261–262, 709–710
number formats,  391–392, 472, 474
number forms (typography effects),  320–321
Numbering Library,  709–710
Numbering tool,  261, 709
numbers

comparing,  374
data series in Excel cells,  367–368
displaying as text,  385, 475–476
Excel formats,  391
extending as data series,  366
filtering options,  426
precision in,  395
random,  489–490
serial,  382, 394
totaling,  409–410, 418–421

number spacing,  321

O
OCR (optical character recognition),  782
ODBC (Open Database Connectivity),  335, 803
ODD worksheet function,  388
ODF (OpenDocument format),  162, 165
.odp file extension,  622
.ods file extension,  360
.odt file extension,  216
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online presentations,  670–673, 817, 820–821
online templates,  171
OOXML (Office Open XML) file format,  163–164. See 

also Open XML format
Open command,  345
Open Database Connectivity (ODBC),  335, 803
Open dialog box

about,  158–159
custom options,  161–162
keyboard shortcut,  157
Open And Repair option,  162
Open As Copy option,  161
Open In Browser option,  162
Open In Protected View option,  162
Open Read-Only option,  161

OpenDocument format (ODF),  162, 165
Open & Export tab (Outlook),  50
opening

Backstage view,  6–7, 46
calendars,  50
copies of files,  157, 161–162
damaged files,  163
documents in Protected View,  173
documents in read-only mode,  161
files,  50–51, 157, 158, 161–162
OneNote notebooks,  50–51
Start screen,  156
windows,  230

OpenOffice.org program,  162, 165
Open option (Backstage view)

about,  50–51
Recent Documents list,  185
SkyDrive folders,  190

Open Task In Outlook command,  764
OpenType fonts,  322
Open XML format

advantages,  163–164
setting defaults,  164–165
viewing structure and content,  164

Open XML Paper Specification (OpenXPS),  167
OpenXPS (Open XML Paper Specification),  167
operators in formulas

about,  370
arithmetic,  371–372, 377
comparison,  373–374, 377
concatenation,  374–375, 377, 469
controlling order of,  377
intersection,  375
range,  361, 375

operators in queries,  565
optical character recognition (OCR),  782
Optimize Media tool,  671
Options dialog box

accessing,  161
Add-Ins tab,  40

.one file extension,  704
OneNote

about,  701
capturing screen clippings,  147
checking spelling,  107
closing,  754
customizing interface,  729–731
customizing taskbar icon,  780–781
file formats,  705, 774
finding and replacing text,  103
font options,  55
inserting symbols and special characters,  80
jumping between locations in,  741
keyboard shortcuts,  506, 717, 729
Link command,  89
linking appointments and meetings to,  761
linking Contacts folder to,  760
linking tasks to,  762–765
navigating,  719–725
new features,  19–20
New option,  50
Notebook Recycle Bin,  705, 724–725, 779
notebooks. See notebooks (OneNote)
notes,  506
opening notebooks,  50–51
Open option,  50
Outlook and,  758–765
pinning to taskbar,  720
printing options,  51
restoring previous versions,  755
Save & Backup tab,  56
Search Results pane,  746–747
sending email messages to,  758–759
smart search strategies,  743–751
subscription edition,  9
troubleshooting,  712
tweaks and tips,  779–784

OneNote_DeletedPages file,  724
Onenotem.exe,  780
OneNote Options dialog box

changing default recording format,  778
disabling linked-note taking,  768
disabling text recognition,  782
email message options,  765
screen component settings,  730
Send To interaction settings,  752–753
showing rule lines,  727

OneNote Package format,  774
OneNote_RecycleBin folder,  724
OneNote Web App,  705, 773
.onetoc2 file extension,  704
online documents,  208
online forms (Excel),  488–489
online pictures,  137–139
Online Pictures option (Insert tab),  115, 187
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checking spelling,  107
common views,  532–534, 544–545
connecting to social networks,  516–518
contacts. See contacts (Outlook)
Conversation view,  16–17, 575–577
customizing,  569–577
data files and folders,  518–523
docking items in To-Do Bar,  569–571
encrypted connections,  510, 513
file formats,  518–520
finding and replacing text,  103
Folder pane,  522
follow-up flags and reminders,  577–580
free services provided,  184
importing and exporting data,  580–583
inserting symbols and special characters,  80–81
keyboard shortcuts,  501, 506, 527, 534, 546
mail. See email
meetings in. See meetings
multiple accounts per profile,  16
navigating,  499–500
new features,  15–17
notes and journal entries,  506
Office 365 subscriptions,  497
OneNote and,  758–765
Open & Export tab,  50
Options tab,  150–151
password protection,  512, 583
peeking in,  16–17, 500–501, 570–571
positioning objects,  120
printing options,  51
profile configuration,  506–509, 519, 585
searches,  561–568
Search tab,  561–562
sending items to OneNote notebooks,  716
Send/Receive tab,  526, 529
social networking connections,  17, 499, 516–518, 543
subscription edition,  9
tasks. See tasks (Outlook)
three-pane interface,  500
tweaks and tips,  590–598
viewing account details,  185

Outlook.com (Hotmail)
about,  498
address books,  548
Contacts folder,  541
setting up accounts,  515–516
synchronizing folders,  521

Outlook Files folder,  519
Outlook Options dialog box

changing default fonts for email,  596
clearing Auto-Complete list,  596
contacts sort order,  545
default search scope,  562
docked viewing arrangements,  569–570

Advanced tab,  56, 126, 239
CD presentation package,  676
changing default file formats,  165
Customize Ribbon tab,  63–64, 73
Discard Editing Data setting,  137
General tab,  48, 54, 62, 157, 160
Office Background field,  54–55
Office Theme field,  47–48
Proofing tab,  55–56, 109
Save tab,  56
settings for PDF files,  169
Trust Center tab,  176, 185
User Name field,  54–55

Options option (Backstage view),  54
.oqy file extension,  360
orientation

changing for sections,  271
Excel worksheets,  471
of graphics and pictures,  124–126
presentation handouts,  689
presentation slides,  619–621
printing worksheets,  480
publication pages,  797–798

OR operator,  565
OR worksheet function,  386
.ost file extension,  518–520, 521
outlines (borders)

shape,  141
text,  148, 317

outlines (OneNote),  708
outlines (Word)

creating presentations from,  613–615
keyboard shortcuts,  268
organizing documents with,  266–269
table of contents input types and,  295

Outline view (PowerPoint),  604–605, 616
Outline view (Word)

about,  219
displaying styles in,  250
expanding or collapsing,  227, 267
organizing documents with,  266–269

Outlining tab (Word)
arrows on,  267
Collapse tool,  267
Expand tool,  267
Outline Level box,  267
Show Level option,  267
Show Text Formatting option,  266

Outlook
about,  497–501
account setup,  509–518
account types supported,  498–499
appointments. See appointments
archiving data,  519
calendars. See calendars
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pages (notebook)
copying,  722
creating,  722
customizing,  725–728
custom tempates,  782–783
deleting,  722
editing,  724
expanding and collapsing,  702
keyboard shortcuts,  722, 724
linking to Outlook contacts,  759–760
navigating,  722–723, 724
pasting,  722
rearranging,  722
recently modified,  748–749
renaming,  722
searching on,  744
selecting,  722
sending via email,  765
time stamps for,  708
wiki links in,  743

pages (publication)
about,  796
adding,  796–797
applying themes,  801–802
deleting,  796–797
formatting,  797–800
headers and footers,  800
master pages,  800–801

Pages tab (Navigation pane),  227–229
Page Title style,  718, 725–726
Page Versions feature,  779–780
paper size

changing for sections,  271
Excel worksheets,  480
notebook pages,  728
publication pages,  796
Word documents,  211

Paper Size pane (OneNote),  728
paragraph breaks,  233
Paragraph dialog box

changing Normal style,  257
Collapsed By Default option,  269
Indents And Spacing tab,  241, 267
Line And Page Breaks tab,  242
setting tabs,  222

paragraphs
aligning text,  95
beginning with drop cap,  323–324
formatting,  94–95, 241–243, 283
linked styles,  324
managing fonts,  95–96
in Outline view,  266
paragraph mark,  234, 243, 279

holidays on calendars,  539
work week settings,  533

overlaying
multiple calendars,  539–540
on-screen grid,  625
text on videos with animations,  648

P
Package For CD dialog box,  675–677
Page Break Preview mode (Excel),  400, 482
page breaks

adding manually,  483
adjusting,  482–483
keyboard shortcuts,  225
moving,  482
removing,  483
search string characters for,  233
tables spanning,  288

Page Color tool,  216, 726
page layout

adjusting for review comments,  303
creating multicolumn layouts,  272–273
sections inheriting settings,  271
Word options,  243

Page Layout mode (Excel),  400
Page Layout ribbon tab

Breaks option,  270, 483
Clear Print Area option,  482
Columns option,  272–273
Gridlines option,  484
Headings option,  484
Line Numbers option,  262
managing paragraph formatting,  241
Print Area option,  481
Print Titles option,  484
setting page layout options,  243
Wrap Text option,  258–259

Page Layout view (Excel),  478
Page Navigation pane,  797
page numbers (Word documents),  243–245
Page Parts tool (Publisher),  795
page separator symbol,  219
Page Setup dialog box

Book Fold option,  348
header and footer settings,  244
line numbers,  262
page layout options,  243
publication pages,  798
scaling option,  479
section options,  271

page size
presentation slides,  619–621
publication pages,  796–798
Word documents,  211
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Pictures library,  147
Pictures option (Insert tab),  115, 794
Picture Tools tab

aligning and evenly distributing objects,  122–123
Quick Styles gallery,  61
Remove Background option,  60

Picture With Caption slide layout,  613
pie charts (Excel),  443–444
Pie Of Pie charts,  443
pinning

buttons to Quick Access Toolbar,  421
files to Recent list,  157
most used Outlook folders in Folder pane,  571–572
OneNote to taskbar,  720

PivotTables
about,  15, 459
applying styles,  468
creating,  459–462
customizing layouts,  462–466
data sources and,  459–460
editing,  467–469
Fields pane,  463
filtering,  467
formatting,  467–469
headings in,  459–460
layouts,  460
rows and columns in,  459
slicers and,  423
sorting data,  464–466
troubleshooting,  466

PivotTable Styles gallery,  468
PivotTable Styles list,  469
placeholders

animations in,  645
gallery types,  688
in layouts,  624
Lorem ipsum text,  349
presentation slides,  611–613

Plain Text format for email messages,  525
planning presentations,  652–655
playing back

audio and video recording,  777
video,  627–628

plot areas in charts,  437
plus sign (+),  371, 377
PMT worksheet function,  380–381
.png file extension,  128, 623
POP (Post Office Protocol)

about,  499
connecting accounts to Outlook,  510–514, 526–529
managing folders,  520–521
troubleshooting,  576

Position gallery,  258–259

paragraph styles
about,  245
applying shading,  240
applying without selecting text,  248
highlighting text and,  240
tab stops,  222

passwords
encryption,  175, 315–316
OneNote notebooks,  773
Outlook,  512, 583

Paste command,  97, 102, 398
Paste Special dialog box,  397–398, 470
pasting text

keyboard shortcuts,  97
Live Preview,  99–101
into multiple worksheets,  398–399
Paste Options,  101–102

.pbb file extension,  796

.pdf file extension
about,  215, 360, 623
advantages of,  168
OneNote notebooks,  774
Open XPS and,  167
PowerPoint presentations,  621

peeking in Outlook,  16–17, 500–501, 570–571
People view (Outlook). See also contacts (Outlook)

about,  504
Add To Favorites option,  571
customizing address books,  549
LinkedIn folder,  517
panes displayed,  541
peeking,  16–17, 500–501
social network connections,  518

Percentage format,  391, 394
percent operator,  371
percent sign (%),  371, 377
Permanently Delete It action,  559
permissions

ActiveX controls,  172
macros in documents,  172
Office Web App,  194
securing documents,  175
SharePoint,  682
share settings,  187–188

perpetual licenses,  4, 24–25, 36–38
personal and confidential information,  163–164, 174–175
Personal Folders file,  519
personalizing. See customizing
phone numbers,  396
Photo Album feature,  690–692
photographs. See graphics and pictures
picture editing. See editing graphics and pictures
Picture Options dialog box,  326–327
pictures. See graphics and pictures
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.ppsx file extension,  622

.ppt file extension,  622

.pptm file extension,  622

.pptx file extension,  163, 170, 622
PR-Conversation-Topic property,  576
precision in numbers,  395
presentations

about,  601–602
adding comments,  677–679
adding graphics,  623–625
adding hyperlinks,  692
animation samples,  640
animations in,  639–649
audio clips in,  631–632
collaborating on,  677–680
comparing,  679–680
compressing files,  630
creating,  610–611
creating CD package,  675–677
creating from Word outlines,  613–615
customizing design,  634–638
delivering,  656–660
delivering online,  670–673
editing text,  604, 615–617
embedding fonts in,  696
expert,  686–689
formatting text,  635
guidelines for,  617
handouts for,  607–608
looping,  654–655
merging,  679–680
online,  670–673, 817, 820–821
planning,  652–655
Presenter view,  660–663
rehearsing,  652–655
saving,  621–623
saving as video clips,  622, 674–675
self-guided,  694
setting options,  654–655
sharing,  621–623, 669–677
slides. See slides (presentation)
tables in,  632–634
themes and,  687
turning mouse into laser pointer,  660
video clips in,  626–631
zooming in,  660

Presenter view (PowerPoint),  654–655, 660–663, 673
Present Online dialog box,  670–672
previewing. See also Live Preview

fonts,  61
mail merge output,  338
paste options,  99–101
preview chart,  409
printing options,  51
styles,  246

positioning objects. See also aligning; moving
aligning and evenly distributing,  122–123
changing Z-order,  123–124
docked OneNote window,  766–767
on drawing layers,  119–124
positioning tables,  288
precision placement,  124
resetting window position,  231
snapping pictures into alignment,  259

Post Office Protocol (POP)
about,  499
connecting accounts to Outlook,  510–514, 526–529
managing folders,  520–521
troubleshooting,  576

Post To Blog button,  325
.pot file extension,  622
.potm file extension,  622
.potx file extension,  170, 622
PowerPoint

appropriate views,  603–610
blank templates,  156
embedding video clips,  329–330
file formats,  165
file formats supported,  622–623
finding and replacing text,  103–104
Handout Master view,  609
hiding panes,  605
managing themes,  150–151
master views,  608–609, 689
new features,  18
Normal view,  602–604, 606
Notes Master view,  609
Notes Page view,  603, 607–608
Outline view,  604–605, 616
positioning objects,  121–122
presentations. See presentations
Presenter view,  654–655, 660–663, 673
Reading view,  606–607
selecting theme fonts,  96
Share tab,  7–8
Slide Master view,  608, 686–687
Slide pane,  605
Slide Show tab,  652
Slide Show view,  610, 656–660
Slide Sorter view,  605–606
subscription edition,  9
tables in,  632–634
Transitions tab,  650
tweaks and tips,  690–698

PowerPoint Options dialog box,  696
PowerPoint Viewer,  621, 675
PowerPoint Web App,  673
.ppam file extension,  622
.pps file extension,  622
.ppsm file extension,  622
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Protected View
exiting,  173–174
functionality and restrictions,  172–174
opening files in,  162

.pst file extension
archiving files,  587
Contacts folder and,  541
managing,  518–520
password protection,  583
transferring data,  582

PstPassword utility,  583
.pub file extension,  789
publications (Publisher)

creating,  790–796
headers and footers,  800
inserting text,  790–796
printing,  804–805

Publisher
about,  20, 787
applying themes,  801–802
creating publications,  790–796
export options,  53
inserting graphics and pictures,  794–795
keyboard shortcuts,  796
mail merge support,  804
merging data,  802–804
printing publications,  804–805
saving frequently entered text,  793
subscription edition,  9
Word vs.,  788
working with pages,  796–801

publishing
blog posts,  329
for browser viewing,  167
notes,  773–776

pushpin icon,  157, 730

Q
queries

building with keywords,  565
in databases,  827, 832, 835–836

Quick Access Toolbar
about,  5
adding cell styles,  390
adding commands,  69, 70
adding galleries,  63
adding shortcuts,  478
applying styles from,  345
customizing,  68–71, 185, 345–346
hiding,  58, 69
moving,  69
pinning buttons to,  421
predefined list of commands,  69
rearranging commands,  70

themes,  250
transitions,  651

Previous button (Review tab),  300
previous versions

restoring for OneNote,  755
retaining,  33–34

primary data files,  519
print areas in Excel,  481–482
printing

from Backstage view,  51
booklets,  348
collapsed text and,  269
collated option,  480
duplexing option,  480
Excel worksheets,  478–484
from Backstage view,  478–479
grayscale,  636, 665–666
keyboard shortcuts,  478
from mail merge,  331–332
margin options,  480
notes,  773–776
orientation option,  480
paper size option,  480
PowerPoint notes,  664
presentation handouts,  664–666
presentation slides,  636
Protected View restrictions,  173
publications,  804–805
review comments,  302–303
scaling option,  479, 480

Print Layout view (documents),  212, 216–217, 219, 269
printouts (OneNote),  717, 782
Print Preview And Print button,  478
privacy

Document Inspector,  163–164
Office 365 accounts,  199
removing threats to,  174–175

.prn file extension,  359
Product Information section (Office programs),  38–39
product keys

Click-to-Run installer,  29–30
retail editions,  24, 36–38
subscription-based plans,  23

Professional edition,  11, 25
Professional Plus edition,  26, 28
profile manager,  508–509
profiles

Microsoft account settings,  187
Outlook,  506–509, 519, 585

Project Management template,  824
properties. See document properties
Properties dialog box,  524–525
PROPER worksheet function,  384–385
ProPlus edition,  24
Protect Document button,  314–316
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Recommended PivotTables dialog box,  460
recording

audio,  631, 776–779
narration,  653–654
video,  776–779

Recording toolbar,  652–653
Record Slide Show dialog box,  653
Record Sound dialog box,  631
recovery (file management). See backup and recovery; 

restoring settings and data
Recurrence command,  537
Recurrence Pattern field (Outlook view),  574
recurring events in Outlook,  537–538
Redo button,  85
redoing changes,  84–85
reduced functionality mode,  38
redundant messages in a conversations,  576–577
references

about,  370
absolute,  363, 375–377
cell ranges in worksheets,  361
cells in worksheets,  354
mixed,  375–377
relative,  375–377
structured,  413, 420–421

References field,  576
References ribbon tab

Insert Caption option,  291, 292
Insert Index option,  297
Table Of Contents option,  294–296

reference worksheet functions,  386
Reflection gallery,  319
reflections,  317–320
refreshing search results in OneNote,  751
region options

date and time formats,  394
setting,  112–113
units of measure,  126

regions (Excel),  361, 421
Register A Blog Account dialog box,  326
rehearsing presentations,  652–655
Reject button (Review tab),  307
rejecting revisions,  680
relative cell references,  375–377
Remember For Later tags,  733
reminders in Outlook,  577–580
Remove Attachment command,  566
Remove Split option (View tab),  231
removing

add-ins,  40
attachments to email,  566
authorized devices,  201
bookmarks in videos,  629
command groups from tabs,  65
commands in default groups,  65

resetting customizations,  71
Templates button,  256

Quick Analysis tool
about,  15, 408–409
chart options,  409
formatting options,  409, 428–435
sparklines option,  411, 435–436
table options,  410
totals options,  409–410

Quick Notes,  751–752, 781–782
Quick Parts gallery,  341
Quick Print command,  345, 478
Quick Steps

about,  17, 550
configuring,  550–555
organizing,  555
troubleshooting,  551

Quick Styles gallery,  61, 134
Quick Tables,  279
quotation marks ("),  385, 475, 745

R
radar charts (Excel),  446–447
RANDBETWEEN worksheet function,  489–490
=rand() command,  349
=rand.old() command,  349
random numbers,  489–490
RAND worksheet function,  489
range operator,  361, 375
ranges of cells (Excel). See cell ranges (Excel)
RATE worksheet function,  381
reading document text aloud,  346–347
reading email,  502
Reading pane (Outlook),  502, 541, 572
Reading view (PowerPoint),  606–607
Read Mode (documents)

about,  217–218
collapsing headings,  269

read-only mode,  161, 181
rearranging

command groups,  65
commands,  67
notebook pages,  722
notebook sections,  720
slide order,  603, 605
stacked objects,  123–124

receiving email,  523–525, 526–529
Recent Documents list,  185
Recent Edits menu,  748–749
Recent list

customizing settings,  157–158
Open A Copy option,  157
Remove From List option,  157
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restoring data and settings
AutoRecover feature,  181
new features,  14
Office Web App,  194
recovering unsaved files,  182

Restrict Access command,  316
Restrict Editing command,  251, 311, 316
Results tab (Navigation pane),  228
Resume Reading position (Word),  185
retail editions

installing,  28
listed,  10–11, 25
product keys,  24, 36–38
upgrade limitations,  25

Reuse Slides pane,  681
reusing slides and themes,  681–682
Reveal Formatting task pane,  252–253
review comments

about,  298
adjusting appearance,  303
adjusting page layout,  303
contacting commenter,  301–302
inserting,  299
keyboard shortcuts,  299
marking as completed,  302
presentations,  677–679
printing,  302–303
replying to,  301
resizing area,  303
reviewing,  300–302

Review ribbon tab
Accept button,  307
All Markup option,  305
checking spelling,  107
Combine tool,  308
Compare tool,  308
Delete button,  300
Display For Review button,  306–307
features, tools, commands available,  60
New Comment option,  299
Next button,  300
Previous button,  300
Reject button,  307
setting language and regional options,  112
Show Comments option,  300
Start Inking tool,  305
thesaurus,  111
translating text to other languages,  113

revisions, accepting or rejecting,  680
Revisions pane,  301, 307–308
rewinding animations,  649
the ribbon. See also specific tabs

auto-hiding,  58
collapsing,  58
common layout,  45

email conversations,  17
folders,  587
follow-up reminders in Outlook,  580
hyperlinks,  742
items from Recent list,  157
notebook pages,  722
page breaks,  483
personal and confidential information,  163–164, 174–175
picture background,  135–136
publication pages,  796–797
rules,  434
selected applications from installation,  34
styles from Styles gallery,  254
table columns,  287
table rows,  287
tab stops,  222
tags,  734–735
text,  78–79
uninstalling Office,  43
Word tables,  289

Rename dialog box,  67
renaming

command groups,  67
commands within custom groups,  67
notebook pages,  722
tabs,  67
worksheets,  357

reordering. See rearranging
repairing corrupted files,  162
Repeat command,  85
repeating

animations,  649
changes while editing text,  84–85
searches,  235, 397

Replace command,  104–105, 236
replacing. See finding and replacing
Reply action,  553
replying to email,  502, 524–525
Report Filters list,  467
Report Layout command

about,  467
Compact Form option,  468
Outline Form option,  468
Tabular Form option,  468

reports in databases,  828, 838
Request Control button,  818
Reset Window Position command,  231
resizing

Excel tables,  418
graphics and pictures,  124–128
review comments area,  303
table columns,  285–286
table rows,  285, 286
windows,  58, 401



	 scaling printed worksheets	 875

setting tabs,  221–222
troubleshooting,  400

rules
about,  550
conditional formatting in Excel,  429
creating,  556–557
data validation,  490–494
deleting,  434
email,  17
managing messages automatically,  555–560

Rules And Alerts dialog box,  556, 560
Rules Wizard,  557–559
run-in headings,  324

S
Save As dialog box

about,  158–159
custom options,  160–161
Excel formats,  358
General Options command,  161
keyboard shortcut,  157
Open File After Publishing option,  169
Optimize For option,  169
Options option,  169
overriding default formats,  165
Save Options command,  161
Tools menu,  160–161
Web Options command,  161

Save As option (Backstage view)
about,  50
displaying file locations,  158
SkyDrive folders,  190

Save & Backup tab (OneNote),  56
Save option (Backstage view),  50
saving

chart templates,  452
custom page templates,  782–783
custom themes,  151
documents in other programs,  167
documents with SkyDrive,  189–190
files,  50–51, 158, 160–161
frequently entered text in Publisher,  793
OneNote notebooks,  704–705
output to HTML format,  167
in PDF format,  168
presentations,  621–623, 674–675
presentation slides,  681–682
Protected View restrictions,  173
ribbon customizations,  67
screenshots,  148
templates,  256–257
themes,  682

scaling printed worksheets,  479, 481

customizing,  6, 63–68, 185
Design tab,  14
File tab,  6
finding keyboard shortcuts,  73–74
galleries and live previews,  61–63
new features,  5–6
positioning Quick Access Toolbar,  69
resetting changes,  67
resizing windows,  58
saving customizations,  67
using effectively,  57–60

Rich Text format for email messages,  525
right-aligned tabs,  221
RIGHT function,  469
Roamingoffice.exe (Click-to-Run program),  206–207
rolling back changes

document recovery feature,  14
Office Web App,  193

ROMAN worksheet function,  388
Rotate tool,  125
rotating

graphics and pictures,  124–128
text in Word tables,  284

ROUNDDOWN worksheet function,  388
ROUNDUP worksheet function,  388
ROUND worksheet function,  388
rows (Excel)

adding to data sources,  455
adding to tables,  413
copying from hidden,  486
data series within,  366
formatting options,  416
freezing,  404–405
hiding,  401–402
locking into position,  404
in PivotTables,  459
selecting,  361

rows (Word tables)
adding and removing,  287
adjusting heights,  285–286
changing default number of,  276
keyboard shortcuts,  279
removing,  287

.rqy file extension,  360
RSS feeds,  17, 581
.rtf file extension,  215, 623
rule lines,  727
Ruler Guides command,  799
rulers

about,  212–213
adjusting page margins,  243
Excel restrictions,  400
publication pages,  799
resizing table rows and columns,  286
setting indents,  241
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Section Header slide layout,  612
sections (notebooks)

creating,  720
linking to other pages or notebooks,  741
merging,  720
moving,  705
pointing to alternate location,  751
rearranging,  720
restoring,  754
searching by,  744–748
wiki links in,  743

sections (PowerPoint),  618–619
sections (Word)

about,  270
formatting in documents,  270–273
inheritance and,  271
search string characters for,  233
section breaks,  233, 270–273
section mark,  271

security
cloud-based services and,  185
customizing settings,  176
for file management,  171–177
fine-tuning settings,  175–177
Microsoft accounts,  186
personal and confidential information,  163–164, 174–175

Select All command,  717
Select Data Source dialog box,  453–454
Selection pane,  118–119, 124, 624
Select Location In OneNote dialog box,  707, 711, 713
Select Names dialog box,  547
semicolon (;),  365
sending email,  523–525, 544
Send/Receive Groups dialog box,  526–528
Send/Receive Settings dialog box,  529
Send/Receive tab (Outlook),  526, 529
Send To Microsoft Word dialog box,  667–668
Send To OneNote tool,  506, 780–781
Sent Items folder,  521
separator character,  277–278
{SEQ} field code,  292
serial numbers,  382, 394
Series dialog box,  366–367
Set As Default button,  14
Set Quick Click dialog box,  580
Setup program

Customize button,  33
File Location tab,  36
Installation Options tab,  34
Installed On First Use option,  35
Install Now button,  33
Not Available option,  35
Run All From My Computer option,  35, 36
Run From My Computer option,  35
running,  32–33

scanned images,  714–715
scatter charts (Excel),  445–446, 454
Schedule View (calendars),  533
scheduling

meetings,  503
send/receive intervals for emails,  527–528

Scheduling Assistant,  503
Scientific format,  395
scientific notation,  391, 395
Scientific number format,  391
screen clippings,  707, 713, 752, 781
screen sharing,  809, 817–821
Screenshot option (Insert tab),  116
screenshots, capturing and inserting,  146–148
Screenshots folder,  147
ScreenTips,  73, 113
scroll bars and scrolling

notebook pages,  724
synchronous scrolling in multiple windows,  75, 231, 309, 

403
searches

across multiple folders and drives,  178
adding criteria to,  563–568
building queries with keywords,  565–566
changing scope,  562–563
contacts,  546
document,  13, 212, 232–236
filtering,  159
highlighted text,  235
including formatting in,  235
keywords and,  748
new features,  13
on notebook pages,  744
by notebook sections,  744–748
by OneNote notebooks,  744–748
OneNote notebooks,  702
OneNote strategies,  743–751
Outlook,  561–568
for recently modified pages,  748
repeating,  235, 397
search folders,  567–568
special character,  232–234
tagged notes,  749–751
wildcards in,  234

Search Folder Criteria dialog box,  568
SEARCH function,  469–470
Search Results pane (OneNote),  746–749
Search tab (Outlook),  561–562
SECOND worksheet function,  382
section groups

collapsing,  702
creating,  721–722
expanding,  702
linking to other pages or notebooks,  741
moving sections to,  722
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signatures, email,  592–593
signing in

to Office accounts,  183–188
to Office.com site,  198

Sign In To Office dialog box,  184
Simple Mail Transfer Protocol (SMTP),  499, 511–513
SIN worksheet function,  387
SkyDrive

adding accounts,  186, 191
background information,  189
browsers using,  189–190
changing nature of,  189
creating online forms,  488
Office programs using,  190
Office Web App feature,  8–9, 191–194
OneNote notebooks,  705
Outlook support,  498
recently accessed files and folders,  200
saving documents,  189–190
sharing documents,  189–194
sharing notebooks,  769
sharing presentations,  621
storage capacity,  184, 189
synchronizing files,  190–191
video support,  330

SkyDrive Pro,  3, 207–208
SkyDrive Pro dialog box,  208
Skype

Lync and,  807
online presentations and,  674
Outlook support,  498

slicers feature,  423–424
Slide Library,  682
slide masters

about,  608
customizing,  686–687, 689
modifying,  687
multiple themes in presentations,  687

Slide Master view (PowerPoint),  608, 686–687
Slide pane (PowerPoint),  605
slide shows

about,  610
adding annotations,  659–660
adding hyperlinks,  692
customizing,  683–685
keyboard shortcuts,  656, 683
navigating,  656–659
online presentations and,  673
Presenter view,  654–655, 660–663
presenting portion of,  655, 683
on tablet computers,  658–659
turning mouse into laser pointer,  660
zooming in,  660

Slide Show view (PowerPoint),  610, 656–660
Slide Size dialog box,  619–621, 655

Upgrade option,  33
Upgrade tab,  34
User Information tab,  36

Set Up Show dialog box,  654–655, 659, 685
shading

applying in styles,  240
applying to Word tables,  284
formatting with table styles,  414–415

Shading tool,  240
Shadow gallery,  319
shadows,  317–320
Shape Effects tool,  141
Shape Fill tool,  141
Shape Outline tool,  141
shapes

applying styles,  141
cropping,  132
inserting,  139–142
modifying,  140–141
tools supporting,  141
wrapping text around,  259–260

Shapes gallery,  139
Shapes option (Insert tab),  116
Shape Styles gallery,  141
shared calendars,  538
Shared Notebook Synchronization dialog box,  771–772
Share option (Backstage view)

about,  7–8, 52–53
connecting to social networks,  187–188
sharing presentations,  621

Share pane (OneNote),  770
SharePoint

as blogging platform,  325
Outlook connections,  517
permissions,  682
reentering credentials,  186
sharing notebooks,  769
synchronizing team site libraries,  208

Share tab (PowerPoint),  7–8
sharing

documents,  52–53
documents with compatible formats,  214
documents with SkyDrive,  189–194
files with Office Web App,  194
notes,  773–776
OneNote notebooks,  769–773
Outlook calendars,  597–598
Outlook contacts,  597–598
permissions,  187–188
presentations,  621–623, 669–677

shortcuts. See keyboard shortcuts
Show All command,  345
Show Comments option (Review tab),  300
shrinking Excel tables,  418
Signatures And Stationery dialog box,  592–593, 596
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sorting
data series using custom lists,  487
Excel cell ranges,  421–423
Excel regions,  421–423
Excel tables,  421–423
Excel worksheet data,  421–423
Outlook contacts,  545
PivotTable data,  464–466
preserving original column sort order,  422
Word table data,  280–281

spacing
line,  242–243, 258
number,  321

sparklines
about,  407, 435–436
Quick Analysis tool option,  411

Speak command,  346–347
special characters

alternate currency symbols,  393
entering with AutoCorrect,  82–83, 223
entering with character codes,  83
entering with Insert Symbol,  80–82
guillemets,  338
keyboard shortcuts,  83
listing of entry methods,  80
mathematical equations,  91
searching for,  232–234
text format codes,  475–476

speech recognition,  79
spelling checker

about,  263–264
Add To Dictionary option,  107
adjusting settings,  55
correcting documents,  107–108
correcting single word,  106–107
custom dictionaries,  109–110
customizing,  55, 108–109
Ignore All option,  107
location of,  45

Split Cells tool,  287
Split command,  231
splitting current window

Excel worksheets,  403–404
Word documents,  231

splitting Word table cells,  287
SQL (Structured Query Language),  827
stacked area charts (Excel),  445
stacked column charts (Excel),  441
stacked objects, rearranging,  123–124
Standard edition,  11, 26, 28
Start Date field (Outlook),  579
Start Enforcing Protection dialog box,  311
Starter edition,  11, 30
Start Inking tool,  305
Start screen,  156

Slide Sorter view (PowerPoint),  605–606
slides (presentation)

about,  601, 610–611
adding,  610–611
copying,  616
custom layouts,  688–689
displaying hidden,  683
hidden titles,  685
hiding,  683–684
layouts for,  611–613
margins and,  611
navigating,  694
page orientation and size,  619–621
placeholders,  611–613
playing music behind,  697
printing,  636
reordering,  603, 605
reusing,  681–682
saving,  681–682
slide sections,  618–619
transitions between,  650–651, 662

sliding effect,  17
.slk file extension,  359
Small Business Premium edition

management dashboard,  204
subscription plan,  10, 24, 198

Small Caps format (fonts),  239
SmartArt graphics

adding to documents,  142–144
animating objects,  643
creating bulleted lists,  262
embedding pictures into objects,  134
entering text into graphic,  143
keyboard shortcuts,  143
types of templates in,  116

SmartArt option (Insert tab),  116
smart guides (PowerPoint),  625
SMTP Message-ID property,  576
SMTP (Simple Mail Transfer Protocol),  499, 511–513
snapping

objects to grid,  625
pictures in alignment,  259

Snooze button,  580
snurl.com,  672
Social Connector add-in (Outlook),  516, 548
Social Network Accounts dialog box,  517
social networks

connecting to social networks,  187–188
Microsoft account connections to,  184
Outlook connections to,  17, 499, 516–518, 543

Social Security numbers,  396
Sort dialog box,  280, 422, 466, 487
Sort & Filter option (Home tab),  421
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Style Sets gallery,  250
Styles gallery

accessing,  93
adding styles to,  254
applying styles,  245, 246–247
changing all occurrences of styles,  252
drawbacks,  248
removing styles from,  254

Styles pane,  248–249, 325
stylistic sets,  321–322
subscription plans. See Office 365 subscriptions
substituting fonts,  239
subtle transitions,  651
SUBTOTAL worksheet function,  419
subtraction operator,  371, 377
=SUM formula,  372
surface charts (Excel),  446–447
surveys (Excel),  189, 488–489
swapping pictures,  794
switching

Outlook profiles,  509
PowerPoint views,  603
views,  220
windows,  74–75, 231

Switch Row/Column button (Design tab),  441
Switch Windows command,  231, 345
Symbol dialog box

about,  80
alternate currency symbol,  393
Special Characters tab,  81, 223, 225

Symbol option (Insert tab),  223, 475
symbols. See special characters
synchronizing

email messages,  526–529
Office settings,  184–185
OneNote notebooks,  769–773
online documents with local storage,  208
Outlook files and folders,  519, 521–522
SkyDrive files,  190–191

synchronous scrolling (windows),  75, 231, 309, 403
Sync Issues folder,  586
Sync Status icon,  771
system requirements,  26–27

T
tab groups. See command groups
Table Of Contents option (References tab),  294–296
Table option (Insert tab)

about,  275
Convert Text To Table option,  277
Draw Table option,  276
Excel Spreadsheet option,  282
Quick Gallery option,  279
turning ranges into tables,  411

Start Time field (Outlook),  593
statistical worksheet functions,  386–387
status bar

customizing,  71–72, 346
Office Web App,  193
viewing controls,  72
zoom controls,  71–72, 217, 719

Step-By-Step Mail Merge Wizard,  332–334
Stinson, Craig,  436
stock charts (Excel),  446–447
storing files

Autosave location for,  182
cloud-based. See SkyDrive
Outlook-specific,  518–520
theme files,  151
where and how,  156–162

storing Outlook profiles,  508
storing themes,  682
structured cell references,  413, 420–421
Structured Query Language (SQL),  827
Style Inspector,  253
styles

about,  245
adding to Styles gallery,  254
applying,  245, 246–250
applying from Quick Access Toolbar,  345
applying to Word tables,  284–285
border,  284
cell,  476–477
changing all instances,  252
character. See character styles
creating,  254–256
creating in Publisher,  791
definition,  93
document,  245–256
Excel cell,  390
heading,  718
keyboard shortcuts,  249, 267
linked,  324–325
paragraph. See paragraph styles
picture,  134
PivotTables,  468
predefined,  245
previewing,  246
removing from Styles gallery,  254
shape,  141
table,  411, 414–417
table of contents input type,  295
templates and,  246
themes and,  246
tools for,  252–254
updating to match current selection,  255
WordArt,  148
wrapping text,  129

style sets,  250
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removing columns,  287
removing rows,  287
rotating text,  284
selecting columns,  237
selecting data,  280
sorting data,  280–281
spanning page breaks,  288
splitting cells,  287
table of contents input types and,  295
uses for,  274

tablet computers,  658–659
Table Tools Design tab,  413, 414
tabs (character)

about,  221
indenting text with,  223
removing,  222
search string characters for,  233
setting with ruler,  221
setting with Tabs dialog box,  222
usage considerations,  223

Tabs dialog box
about,  222
Alignment section,  222
Leader section,  222
Tab Stop Position box,  222

tabs (ribbon)
about,  57
context-sensitive,  58–59, 64
customizing,  63–68
default,  60
hiding,  65

tabs (worksheets)
color-coding,  357
finding without scrolling,  403
navigating via,  356
viewing hidden tabs,  356

tags
about,  733–734
applying,  734–735
attaching to notebook text,  733
copying,  738–739
customizing,  736–738
finding tagged items,  749–751
grouping,  750
removing,  734–735

Tags Summary pane,  749–751
TANH worksheet function,  387
TAN worksheet function,  387
Task dialog box,  764
Task Management template,  824
tasks (Outlook)

about,  505
accessing,  16
docking in To-Do Bar,  569–571
keyboard shortcuts,  501

Table Properties dialog box
Column tab,  286
Row tab,  286
Table tab,  288

tables (Excel)
about,  411
adding formulas,  418–421
adding totals,  418–421
converting cell ranges into,  411–421
default names,  413
expanding,  418
filtering data in,  423–428
formatting with table styles,  414–417
inserting into Word documents,  282
keyboard shortcuts,  411
lists and,  411
Quick Analysis tool options,  410
shrinking,  418
slicers and,  423–424
sorting data in,  421–423

tables in databases,  826–827, 830, 833–834
tables of contents (documents),  294–296
tables (OneNote),  710–711
tables (PowerPoint)

about,  632
inserting,  632–633
modifying,  633–634
troubleshooting,  633

table styles,  284–285, 411, 414–417
Table Styles gallery,  285, 413–414
tables (Word)

adding borders,  284
adding columns,  287
adding rows,  287
adding shading,  284
adding to Quick Tables gallery,  279
adjusting column widths,  285–286
adjusting row heights,  285–286
aligning text,  283
applying styles,  284–285
changing layouts,  285–289
converting text to,  277–278
creating,  274–279
creating captions for,  291–292
default number of columns and rows,  276
deleting,  289
drawing,  276–277
erasing lines,  277
formatting,  283–285
formulas in,  281–282
keyboard shortcuts,  279–280
merging cells,  287
navigating,  279–280
positioning,  288
as reference targets,  291
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dictating,  79
displaying numbers as,  385, 475–476
editing. See editing text
editing for presentations,  604
editing in presentations,  615–617
Excel formats,  391
filtering options,  426
finding and replacing,  103–106
formatting. See text formatting
handwriting-to-text conversion,  715
hiding,  240, 269
highlighting,  235, 240, 304–311, 715
indenting,  718
indenting with tabs,  223
inserting into Publisher publications,  790–796
keyboard shortcuts,  79, 237
Lorem ipsum,  349
manipulating with functions,  469–470
moving,  98
in OneNote notebooks,  708
overlaying on videos with animations,  648
pasting,  97, 99–102, 398–399
PowerPoint guidelines,  617
reading aloud,  346–347
rotating,  284
saving frequently entered in Publisher,  793
selecting,  78–79, 237
translating to other languages,  113–114
variable,  243

text boxes
inserting,  139–142
linked,  793
selecting for drawing layers,  117
with multiple columns,  792–793

Text Box option (Insert tab),  116
text effects

applying,  148–149, 317–320
applying to theme elements,  151
drop cap,  323–324
ligatures,  320–323
WordArt,  116, 148–149

Text Effects And Typography option (Home tab),  318, 322
Text Effects tool,  148
Text Fill tool,  148
Text format (cells),  396
text formatting

applying,  92–97, 317–325
beginning paragraphs with drop cap,  323–324
characters,  93–94
copying,  96–97
drop cap,  323–324
finding and replacing,  103–106
fonts,  95–96
keyboard shortcuts,  93, 95, 97, 238

linking to OneNote,  762–765
message-handling,  17
OneNote notebooks and,  716
troubleshooting,  765

Tasks view (Outlook)
about,  16, 505
peeking,  500
To Do list,  577

Team Email Quick Step,  552
telephony, Lync-based,  809, 816–817
templates

about,  246
Access supported,  824
animations,  640
applying restrictions to,  251
applying to existing documents,  256
blank,  156
blog,  328
bypassing available,  55
chart,  452
customizing,  170–171
default workbook,  458–459, 472
definition,  170
editing,  256–257
Excel,  359
linked styles,  325
macro-enabled,  170
master slide,  608
notebook pages,  782–783
Office.com,  170
online,  171
organizing,  171
Quick Tables,  279
saving,  256–257
selecting,  49–50
SmartArt,  116
styles and,  246

Templates And Add-Ins dialog box,  256
Templates pane (OneNote),  782–783
temporary folders,  584
Temporary Internet Files folder,  173
text

aligning in Word tables,  283
aligning with tabs,  221–223
boilerplate,  85–87
comparing,  374
concatenating,  374–375
converting in content control,  244
converting printouts and pictures to,  782
converting to tables,  277–278
converting to WordArt,  148
copying,  78, 97–98
data series within Excel cells,  368
deleting,  78–79
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time zone coordination,  593–595
timing

elapsed time in Presenter view,  663
presentation rehearsals,  652
rehearsing slide shows,  655
setting for animations,  645–646
video clips and,  674

Title And Content slide layout,  612
Title Only slide layout,  613
Title property,  244
titles

chart axes,  451
Excel charts,  437
presentation slides,  605, 612, 685
Word document,  244
worksheet print option,  484

Title Slide layout,  612
TODAY worksheet function,  383
To-Do Bar,  569–571
To-Do list (Task view),  577
To Do tags,  733
To Manager Quick Step,  552
Tools ribbon tab,  60
Top 10 AutoFilter dialog box,  427
Total Row option (Design tab),  284, 416
totals (numbers)

adding to Excel tables,  418–421
Quick Analysis tool options,  409–410

Touch/Mouse Mode toggle,  729
touch screens

entering text,  77–78, 715
Read Mode markup options,  218
target sizes,  156

Track Changes Options dialog box,  303, 310
tracking changes to documents

about,  304–305
changing view options,  306–307
locking in tracking,  310
reviewing tracked changes,  307–309
setting options for,  310–311

Transform gallery,  149
transitions

between slides,  650–651, 662
online presentations and,  673
videos and,  674

Transitions gallery,  650–651
translating text to other languages,  113–114
Transparency slider,  637
trend lines (sparklines),  407, 435–436
trial editions, activating,  36–37
trigonometry worksheet functions,  387–388
TRIM worksheet function,  384
troubleshooting

Access databases,  830
blogs,  327

ligatures,  320–323
OneNote notebooks,  717–719
paragraphs,  94–95
presentations,  635
presentation slides,  605
reflections,  317–320
shadows,  317–320
suppressing in Outline view,  266

Text Highlight Color tool,  240, 719
Text Outline tool,  148
text recognition,  782
TEXT worksheet function,  374, 385
text worksheet functions,  384–385
text wrapping

around graphics and pictures,  129, 258–259
around shapes,  259–260
in Web Layout view,  218–219

themes
about,  245
applying shape styles,  141
applying to current document,  150
applying to presentations,  636–637
applying to publication pages,  801–802
changing,  47–48
components in,  150–151
customizing,  682
definition,  149
email messages,  597
fonts and,  96
making global changes to documents,  250–252
presentations and,  687
reusing,  682
saving,  682
selecting,  149–152
storing,  151
styles and,  246

Themes gallery
accessing,  62
applying themes,  150–151
PowerPoint presentations,  636
previewing themes,  250
Save Current Theme option,  62, 682

thesaurus,  111
.thmx file extension,  622, 682
thumbnail images

displaying,  49
for documents,  160, 227
video clips,  329

.tif file extension,  623
tiling windows,  403
Time format,  391
time stamps

for multimedia recordings,  777
for notebook pages,  708

TIMEVALUE worksheet function,  383
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Value Field Settings dialog box,  463
VALUE worksheet function,  385
variable text,  243
VBA (Visual Basic for Applications),  27, 828, 839
vCard format,  597–598
video clips

bookmarks in,  629, 648
compressing files,  630
creating,  674–675
incompatibility with viewers,  671
inserting in documents,  329–331
new features,  18
overlaying text with animations,  648
in presentations,  626–631
recording,  776–779
saving presentations as,  622, 674–675
transitions and,  674

videoconferencing,  809, 816–817
Video Tools

Add Bookmark option,  629
choosing video source,  626
Playback tab,  628–629
Remove Bookmark option,  629

viewing
account details,  185–186
appropriate document views,  216–221
changing views in status bar,  72
docked Outlook items,  569–570
document properties,  48–49, 178–179
documents with Office Web App,  192–193
Excel header rows when scrolling,  414
expanding views,  139
hidden tabs in worksheets,  356
keyboard shortcuts associated with ribbon items,  73
Open XML structure and content,  164
Outlook calendars,  532–535, 539–540
Outlook contacts,  542, 544–545
Outlook folders,  520–521
Outlook options,  501
program output in browsers,  167
recently open files list,  156
selecting with keyboard controls,  220
side-by-side windows,  231, 573
split-screen view of documents,  231
style names in document views,  250
switching between views,  220–221
text effects,  149
words in custom dictionaries,  110
zoom controls for,  220

View ribbon tab
about,  500
features, tools, commands available,  60
Freeze Panes menu,  405
managing multiple windows,  75
Remove Split option,  231

comments,  679
conditional formatting,  434
conversation view,  576
cropped graphics,  258
dates in worksheets,  382
formulas,  383
Function Arguments dialog box,  379
grouped objects,  128
IMAP accounts,  522
line spacing,  243
Microsoft Office Compatibility Pack,  165
notes,  765
OneNote,  712
Outlook tasks,  765
picture edits,  137
PivotTables,  466
PowerPoint tables,  633
Quick Steps,  551
rulers,  400
table styles,  417
webpages,  712
worksheets,  494

Trust Center dialog box,  176–177
Tufte, Edward,  436
Twitter site,  184, 187
Two Content slide layout,  602, 612
T worksheet function,  385
.txt file extension,  215, 359, 623

U
unchecked items in OneNote,  750
underscore (_),  476
Undo button,  84
undoing changes

editing pictures,  136
editing text,  84–85

Ungroup command,  128
Unicode character code,  80
uninstalling Office,  43
units of measure,  126
Unread Mail search folder,  556
updates. See also upgrading Office

checking for,  38–39
downloading,  38–39

upgrading Office,  4, 21–26. See also installing Office
UPPER worksheet function,  384
URL-shortening service,  672
User Account Control dialog box,  31

V
validating data,  490–494
#VALUE! error,  372, 385
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removing prominent features from Excel interface,  399–401
zoom controls,  400–401
Zoom option,  220

View Side By Side command,  231, 403
views in databases,  831
Vimeo site,  330
Visual Basic for Applications (VBA),  27, 828, 839
VLOOKUP worksheet function,  386
VL (Volume Licensing) programs,  26
volume license editions

activation process,  38
downloading,  26
installing,  32–36
listed,  11, 26

W
Warning dialog box,  494
warning messages,  176, 494
watermark effect,  637
watermarks,  243
the web

disconnecting Office from,  185
installing Office from,  28–32

Web Apps
Access web apps,  824, 826, 828–832
OneNote Web App,  705, 773
PowerPoint Web App,  673

web browsers. See browsers
web clippings,  707, 711–712
Web Layout view (documents),  218–219
web meetings,  809
webpages

hyperlinks and,  87–89
hyperlinks to,  740–741
linking to notes,  765–769
printouts of,  717
screen clippings,  713
troubleshooting,  712
web clippings,  711–712

WEEKDAY worksheet function,  382
Week view in calendars,  534, 535, 537
whiteboarding,  809, 817–821
white space,  233
wiki links,  743
wildcards in searches,  234
window management

arranging windows,  231, 402–403
clipping images,  146
copying current window to Clipboard,  147
keyboard shortcuts,  232
multiple,  573
multiple windows,  74–75, 230–232
opening new windows,  230

positioning docked OneNote,  766–767
resetting window position,  231
resizing windows,  58, 401
slide controls,  71–72
splitting current window,  231, 403–404
switching windows,  74–75, 231
synchronous scrolling,  75, 231, 309, 403
tiling windows,  403
viewing side by side,  231, 403, 573
zoom controls,  220

Windows Default Programs feature,  55
Windows Explorer,  520
Windows Installer

Click-to-Run vs.,  30, 31
downloading,  28

Windows Live ID,  184, 670
Windows Live Mail,  498, 515
Windows Media Audio Voice 9,  778
Windows Search,  561
Windows Store app,  783–784
Windows Update,  39
wizards. See specific wizards
.wmf file extension,  128, 623
.wmv file extension,  623, 627, 674
Word

blank templates,  156
blogging with. See blogs
bulding blocks,  339–342
Compatibility Mode,  48, 166, 213–214
data charts,  144–146
documents. See documents
editing presentation handouts in,  667–668
file formats,  165, 215–216
formatting text. See text formatting
Jump List,  328
mass mailings. See mail merge
Navigation pane,  13, 212–213, 218, 268–269
new features,  13–14
OneNote notebooks and,  774
Publisher vs.,  788
Resume Reading position,  185
search capability,  13, 212, 232–236
tweaks and tips,  344–350

WordArt
converting text to,  148
selecting for drawing layers,  117
text effects,  116, 148–149, 319

WordArt option (Insert tab),  116, 284
WordArt Styles dialog box,  149
WordPress blogging platform,  325
workbooks and worksheets (Excel)

about,  353–360
adding slicers,  423–424
arranging windows,  402–403
changing default number of worksheets,  356
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X
{XE} field code,  297
.xla file extension,  360
.xlam file extension,  359
.xlm file extension,  360
.xlsb file extension,  358
.xls file extension,  359
.xlsm file extension,  358
.xlsx file extension,  163, 354, 358
.xltm file extension,  359
.xltx file extension,  359
.xlw file extension,  360
.xml file extension,  215, 359, 622
XOR worksheet function,  386
.xps file extension,  167, 216, 360, 623
XY charts (Excel),  445–446, 454

Y
Yahoo service,  185
YEAR worksheet function,  382
YouTube site,  184, 329–330, 627

Z
ZIP archive format,  163
ZIP Codes,  396
Zoom command,  660
zoom controls

calendars,  533
Excel worksheets,  400–401
Office Web App,  193
online presentations and,  673
Slide Sorter view,  606
status bar,  71–72, 217, 719
for views,  220–221

Zoom dialog box,  220
Zoom To Selection command,  401
Z-order of stacked objects,  123–124

charts. See charts (Excel)
copying from hidden columns/rows,  486
copying worksheets,  357
creating workbooks,  458
creating worksheets,  357
customizing views,  399–406
customizing workbooks,  457–459
default workbook template,  458–459, 472
End Mode,  364
entering data and data series,  365–370
filtering data,  423–428
formatting,  470–477
formatting cells and ranges,  389–396
formulas and functions,  370–389
hiding rows and columns,  401–402
hiding worksheets,  358
inserting into Word documents,  282, 284
keyboard shortcuts,  357, 363–364
linking data to chart elements,  453–456
manipulating data,  396–399
moving worksheets,  357
multiple worksheets,  354, 398–399
navigating,  360–364
printing worksheets,  478–484
referencing cell ranges,  361
referencing cells,  354
regions in,  361
renaming worksheets,  357
rotating text,  284
selecting entire worksheets,  361
sorting data,  421–423
splitting, freezing, locking panes,  403–406
tables. See tables (Excel)
troubleshooting worksheets,  494
usage examples,  354–355
zoom controls,  400–401

WORKDAY.INTL worksheet function,  384
WORKDAY worksheet function,  384
Work Offline command,  527
Work Week view in calendars,  533
.wpd file extension,  216, 623
.wps file extension,  216, 623
wrapping text

around graphics and pictures,  129, 258–259
around shapes,  259–260
in Web Layout view,  218–219

Wrap Text option (Page Layout tab),  258–259
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